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General
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Program Manager
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Changing default directories
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Fonts
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Applications
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Word for Windows 2.0: using a watermark 93-12-20
Word for Windows: using date formats from [Intl] section in WIN.INI 93-12-11
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WordPerfect for Windows 5.2: using smart quotes 92-07-15
WordPerfect for Windows 5.2: using bullets 92-07-15



Gang screens ("Easter Eggs")

Windows 3.0
Windows 3.1
Ami Pro 2.0
Borland (all Windows products) 93-05-10
Corel Draw! 3.0
Excel 3.0
Norton Desktop for Windows 2.0
PageMaker for Windows 4.0 92-12-30
Procomm Plus for Windows 1.0 92-12-05
Word for Windows 1.x
Word for Windows 2.0



Applications

Windows 2.x Applications
Troubleshooting 93-12-05
Available Windows 3.x applications 94-02-22



Troubleshooting

Access: version 1.1 upgrade 93-07-15
AllType: converted TrueType fonts not in same family 92-09-15
Ami Pro 3.0: can't read Word 2.0 or WordPerfect 5.2 files 93-08-12
Ami Pro: mixed landscape/portrait document eats system resources 93-04-30
Ami Pro: table of contents
Ami Pro 2.0: divide by zero error
Ami Pro 3.0: equation handling problems 93-04-30
Ami Pro 3.0: overlapped screen text
Ami Pro 2.0: printing with incorrect fonts 93-04-30
Ami Pro 3.0: slow printing
Ami Pro 3.0: unable to load Word or WordPerfect files 93-10-12
Corel Draw! 3.0: can't rotate bitmaps 92-12-30
Corel Draw! 4.0: can't install from CD-ROM 93-07-15
Excel 4.0: out of memory loading a workbook 93-12-05
FrameMaker: scrambled dot-matrix output 92-09-14
KA9Q: dropped packets 92-09-14
Norton Desktop for Windows: can't format in the background
Norton Desktop for Windows: crashes from selecting files 92-12-16
Mathematica 2.0 for Windows: problems with Windows 3.1, other problems
Mathematica 2.1 for Windows: crashing problems 93-07-15
NCSA Telnet [in DOS session]: crashes in a window 92-12-30
PageMaker 4.0: font selection box won't scroll 92-09-21
PageMaker 4.0: text color changes to almost invisible 92-09-26
PageMaker 4.0: WordPerfect and Word for Windows import
Paradox for Windows: dialog boxes can't be killed 93-04-30
Pathway Access 1.x: terminal font
PC Tools 7.1: restore problems
Procomm Plus for Windows: Pasted text has extra CR/LFs 93-04-25
Procomm Plus for Windows: Zmodem transfer startup
Quattro Pro for Windows 1.0: Accessing drive D: 93-10-11
Quattro Pro for Windows 1.0: Cut and paste to other applications 93-04-25
Quattro Pro for Windows: High resource requirements 92-12-16
Quattro Pro for Windows: Numeric format alignment 93-04-25
Quattro Pro for Windows: OLE and DDE problems 92-12-21
Quattro Pro for Windows: Saving over foreign formats 92-12-30
Quicken for Windows: conflicts with communications software
Ventura Publisher 3.0: divide by zero errors 92-09-19
WinFax Pro 2.0 92-09-19
Word for Windows: accessing fonts
Word for Windows 2.0: can't install additional components
Word for Windows 2.0: can't print envelopes 93-08-06
Word for Windows 2.0: equation editor fonts
Word for Windows 2.0: equations have too much white space 92-09-27
Word for Windows 2.0: file too big to save 92-11-09
Word for Windows 2.0: headers and graphics
Word for Windows 2.0: mixed landscape/portrait document eats system resources 93-04-
30
Word for Windows 2.0b: printing from Print Preview
WordPerfect for Windows: mixed landscape/portrait document eats resources 93-04-30
WordPerfect for Windows 1.0: floppy access
WordPerfect for Windows 1.0: button bar won't display
WordPerfect for Windows 1.0: crashes with 256-color display driver 92-09-21
WordPerfect for Windows 5.2: incorrect table of contents 93-04-30



WordPerfect for Windows 1.0: mixing landscape and portrait pages
WordPerfect for Windows 1.0: printing with TrueType



Available Windows 3.x applications

Mainstream productivity applications 94-02-22
Information management 94-02-22
Graphics and illustration 94-02-12
Personal information and finance management 94-02-12
Communications and networking 94-02-15
Fonts 93-01-02
Utilities and fonts 93-04-12
Technical and engineering 94-02-12
Home, entertainment and multimedia 94-02-12



Mainstream productivity applications

Desktop publishing 93-07-15
Integrated sofware 92-10-03
Spreadsheets 93-09-30
Word processing 94-02-22
Word processing utilities 93-10-17



Information management

Databases, non-programmable 93-09-20
Databases, programmable 94-02-22
Form processing and management 93-09-20
Project management 93-09-20



Graphics and illustration

Databases, image
Charting (flow and organizational) 93-01-02
Drawing and illustration 93-01-02
Graphics conversion 93-04-12
Image viewers 94-02-12
Painting and image editing 94-02-12
Presentation and business graphics 93-04-12
Technical and Scientific Plotting 94-02-12



Personal information and finance management

Financial Management
Personal Information Managers 94-02-12



Communications and networking

Networking and groupware 94-02-15
Communications and terminal emulation 94-03-15



Networking and groupware

Groupware 92-09-20
Internet news and mail readers/utilities 94-02-15
Internet access utilities 94-02-12
TCP/IP Networking 92-12-01
X Window servers 93-08-06



Communications and terminal emulation

Communications (ASCII)
Communications (IBM mainframe) 92-12-01
Facsimile 94-03-15
Remote Access 92-12-01



Fonts

Font packages 93-01-02
Font managers 92-12-01
Font utilities 93-01-02



Utilities and fonts

Disk and file utilities 93-04-12
Program launchers and desktops 94-02-22
Other utilities 94-02-15



Disk and file utilities

Archiving utilies 93-04-12
Backup software 93-04-12



Program launchers and desktops

Program Manager type 92-11-30
File Manager type 94-02-15
Integrated desktops 94-02-22
Icon docks/tool bars 93-10-17
Commandline utilities 94-02-22
Other program launchers 93-08-13



Other utilities

Benchmarking utilities 92-04-10
Clock utilities 93-04-12
Desktop enhancers 92-11-30
Miscellaneous 94-02-15
Task schedulers 93-04-12
Task managers 93-07-15



Technical and engineering

CAD software 93-03-31
Engineering 93-03-31
Mathematical 93-04-30
Simulation and modeling 94-01-12
Statistics 94-02-12



Home, entertainment and multimedia

Multimedia 94-02-12
Entertainment 94-02-12
Home 93-10-17



Multimedia

CD audio players 94-02-12
Multimedia authoring 93-01-02
Multimedia playback 93-05-10
Sound editors 93-09-15
Video Editors 93-01-02



Entertainment

Games and entertainment 94-02-12



Home

Cooking 93-10-17
Fitness and Sports 93-09-15



Technical Support Contacts

Microsoft 94-03-15
Wolfram Research 93-07-15
WordPerfect 93-07-15



Microsoft

Telephone 93-03-01
Internet 93-08-05
Compuserve 94-03-15
Microsoft Download Service 93-07-15



Wolfram Research

Internet 93-07-15



WordPerfect

Telephone 93-07-15
Bulletin Board Service 93-07-15
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Microsoft Windows



Windows 1.0
Microsoft first began development of the Interface Manager (subsequently renamed 
Microsoft Windows) in September 1981.    Although the first prototypes used Multiplan 
and Word-like menus at the bottom of the screen, the interface was changed in 1982 to 
use pull-down menus and dialogs, as used on the Xerox Star.    

Microsoft finally announced Windows in November 1983, with pressure from just-released
VisiOn and impending TopView.    This was after the release of the Apple Lisa (but prior to 
the Macintosh), and before Digital Research announced GEM, another competing 
graphical environment.    Windows promised an easy-to-use graphical interface, device-
independent graphics and multitasking support.    The development was delayed several 
times, however, and the first version hit the store shelves (after 55 programmer-years of 
development!) in November 1985.    The selection of applications was sparse, however, 
and Windows sales were modest,

The following were the major features of Windows 1.0:
· Graphical user interface with drop-down menus, tiled windows and mouse support
· Device-independent screen and printer graphics
· Co-operative multitasking of Windows applications



Windows 2.0
Windows 2.0, introduced in the fall of 1987, provided significant useability improvements
to Windows.    With the addition of icons and overlapping windows, Windows became a 
viable environment for development of major applications (such as Excel, Word for 
Windows, Corel Draw!, Ami, PageMaker and Micrografx Designer), and the sales were 
spurred by the runtime (Single Application Environment) versions supplied by the 
independent software vendors.    When Windows/386 (see next section) was released, 
Microsoft renamed Windows to Windows/286 for consistency.

The following are the major changes from earlier versions of Windows:
· Overlapping windows
· PIF files for DOS applications



Windows/386
In late 1987 Microsoft released Windows/386.    While it was functionally equivalent to its 
sibling, Windows/286, in running Windows applications, it provided the capability to run 
multiple DOS applications simultaneously in the extended memory.

The following are the major changes from earlier versions of Windows:
· Multiple DOS virtual machines with pre-emptive multitasking



Windows 3.0
Microsoft Windows 3.0, released in May, 1990, was a complete overhaul of the Windows 
environment.    With the capability to address memory beyond 640K and a much more 
powerful user interface, independent software vendors started developing Windows 
applications with vigor.    The powerful new applications helped Microsoft sell more than 
10 million copies of Windows, making it the best-selling graphical user interface in the 
history of computing.

The following are the major changes from earlier versions of Windows:
· Standard (286) mode, with large memory support
· 386 Enhanced mode, with large memory and multiple pre-emptive DOS session 

support
· No runtime versions available
· Program Manager and File Manager added
· Network support
· Support for more than 16 colors
· API support for combo boxes, hierarchical menus and private .ini files



Windows 3.1 92-09-21
Microsoft Windows 3.1, released in April, 1992 provides significant improvements to 
Windows 3.0.    In its first two months on the market, it sold over 3 million copies, 
including upgrades from Windows 3.0.    It is currently continuing to sell at a rate of over 
1 million copies per month.

The following are the major changes from Windows 3.0:
· No Real (8086) mode support
· TrueType scalable font support
· Multimedia capability
· Object Linking and Embedding (OLE)
· Application reboot capability
· "Mouse Trails" for easier mouse use with LCD display devices
· Better inter-application protection and better error diagnostics
· API multimedia and networking support
· Source-level API compatability with Windows NT



Windows 3.11 94-03-01
Windows 3.11, available now, adds no new features but corrects some existing, mostly 
network-related problems.    It is replacing Windows 3.1 at the retail and OEM levels, and 
the upgrade is available free from ftp.microsoft.com.



Windows for Workgroups 3.1 93-04-22
The Windows for Workgroups package, released in November, 1992,    is the first 
integrated Windows and networking package offered by Microsoft.    It provides peer-to-
peer file and printer sharing capabilities (on a level comparable to LANtastic or Netware 
Lite) highly integrated into the Windows environment.    The simple-to-use-and-install 
networking allows the user to specify which files on the user's machine should be made 
accessible to others.    The files can then be accessed from other machines running either
Windows or DOS.    

Windows for Workgroups also includes two additional applications: Microsoft Mail, a 
network mail package, and Schedule+, a workgroup scheduler.



Windows for Workgroups 3.11 94-03-01
Windows for Workgroups 3.11, available now, adds 32-bit file access, fax capabilites and 
higher performance to Windows for Workgroups 3.1.



Windows NT 3.1 94-03-01
Microsoft Windows NT is Microsoft's platform of choice for high-end systems.    It is 
intended for use in network servers, workstations and software development machines; 
it will not replace Windows for DOS.    While Windows NT's user interface is very similar to
that of Windows 3.1, it is based on an entirely new operating system kernel.

The following are the major changes from Windows 3.1:
· Based on a new microkernel design
· Portable architecture for Intel x86/Pentium, MIPS R4000/R4400 and DEC Alpha 

processors.    Support for PowerPC and SPARC architectures is under development.
· 32-bit addressing for access to up to 4 GB of memory
· Fully protected applications with virtualized hardware access
· Installable APIs for Win32, Win16, MS-DOS, POSIX and OS/2
· Installable file systems, including FAT, HPFS and NTFS
· Built-in networking (LAN Manager and TCP/IP) with remote procedure calls (RPCs)
· Symmetric multiprocessor support
· Security designed in from start, to be initially C2 certified, with a B-level kernel design
· API support for asynchronous message queues, advanced interprocess 

communication, registration databases, Bezier curves and graphics transformations.

The following is the minimum platform for use with the client edition of Windows NT:
· 33 MHz 386 processor
· 12 MB memory
· 100 MB hard disk
· VGA graphics
The Advanced Server Edition requires 16 MB of memory.

Win32 in itself is not a version of Windows, but the name of application programming 
interface for Windows NT and Chicago.



Win32s for Windows 3.1 94-03-15
Win32s is a set of libraries for Windows 3.1, which enable users to run most Windows NT 
32-bit applications on Windows 3.1, without the extensive hardware requirements of 
Windows NT.    The Win32s interface has effectively replaced the older Windows-32 
programming interface used by 32-bit Windows applications such as previous versions of 
Mathematica.



Windows 4.0 ("Chicago" and Win32c) 94-03-15
This unannounced product is rumored to be released in late 1994.    It will be a 32-bit 
system providing full pre-emptive multitasking, advanced filesystems, threading, 
networking and more.    It will include MS-DOS 7.0, but will take over from DOS 
completely after starting.    It will not include Windows NT's security, multiprocessor 
support, server capabilities or multiple API modules.    It will include a completely revised 
user interface, along the lines of "Cairo", but not taken as far as that product.

See the section entitled Chicago Q&A for more information about Chicago.



Windows NT 3.5 ("Daytona") 94-03-15
"Daytona" is Microsoft's codename for an upcoming release of Windows NT, which will 
provide OLE 2.0, improved performance and reduced memory requirements.    Availability
is expected in mid-1994



Windows NT 4.0 ("Cairo") 94-03-15
"Cairo" is Microsoft's project for object-oriented Windows, and a successor to the 
Daytona release of Windows NT.    Firm details are not available, but most rumors place 
expected availability sometime in 1995.    Developers are encouraged to work with OLE 
2.0 in order to start moving in the correct direction towards future "Cairo" compatability.



Windows for Pen Computing 3.1
Microsoft developed Windows for Pen Computing for use on pen-based systems.    In most
aspects, it is basically equivalent to Windows 3.1 with extensions for pen support.    
These extensions include the use of a pen as a pointing device as well as handwriting 
recognition and conversion.    Pen Windows first shipped in April, 1992.



Multimedia Windows
The term Multimedia Windows describes a package with Windows 3.0 and the Multimedia
Extensions.    These extensions are included in Windows 3.1, and thus Multimedia 
Windows is no longer sold as a separate product.



Modular Windows
Modular Windows is the operating system for Tandy Corp.'s Video Information System 
(VIS) multimedia player.    It is essentially similar to Windows' core, but without any 
desktop accessories, TrueType fonts or a number of other features.



Win-OS/2
Win-OS/2 is the Windows component of IBM's OS/2 2.0.    It is based partially on Windows 
3.0 and partially on 3.1.    While it runs a majority of the commercial Windows 
applications, it is not covered by this document.



Chicago Q&A
The following questions and answers are from a document distributed by Microsoft in 
December, 1993.

Microsoft is continually enhancing its Windows operating system product line to deliver 
easy    to use yet powerful products that exploit the latest advances in microcomputer 
hardware    technology.    There is a great deal of interest in and speculation about the 
Chicago project,    the technology development effort which will deliver the next major 
release of Windows for    the mainstream desktop and portable PC.    The purpose of this 
document is to answer the    most common questions that customers have voiced about 
Chicago. 



What is Chicago? 94-03-18
What is Chicago and how does it compare to the Microsoft* Windows* 3.1, Windows*    for
Workgroups and Windows NT* operating systems?    

Microsoft has a family of operating system products designed to fully utilize the range of 
PC    hardware available in the market today, while providing a consistent user interface 
for end    users and a programming environment for developers.    Windows 3.x and 
Windows for    Workgroups 3.x on MS-DOS* are designed for mainstream portable and 
desktop PC    platforms.    Windows NT is designed for the high-end business and technical
workstation    platforms and Windows NT Advanced Server is designed as a server 
platform.    

Chicago is the code name for a development project that will produce the successor to    
Windows 3.x and Windows for Workgroups 3.x.    The Chicago project encompasses a    
variety of important new technologies that will make personal computers running 
Windows    easy to use, and that will provide a more powerful multitasking system and a 
great platform    for communications.    Decisions about how those technologies will be 
packaged will be made    later in the development cycle and will be based on customer 
and business needs.



What is Cairo? 94-03-18
What is Cairo?    How does Chicago compare to Cairo?

Cairo is the code name for a development project that will produce the successor to 
Windows    NT.    Chicago and Cairo will produce complementary products that will 
continue to provide a    consistent user interface and programming environment across 
the entire range of PC hardware    platforms. 



Why does Microsoft have multiple Windows products? 94-03-18
 Why does Microsoft have multiple Windows operating system products?    Wouldnt it be   
simpler to just have one product?    Does that mean ISVs have to decide between 
different    operating system products when writing applications?    

There are two distinct design points for operating systems platforms.    One is centered 
on the    mainstream system, and the other is centered on the high-end system.    It is not 
possible to    have one operating system implementation that fully exploits the broad 
range of hardware    available today.    At the low end (currently represented by products 
such as the HP Omnibook    and entry-level desktop machines), the primary design goal is
to keep the operating system    small and fast and to keep usage of machine resources to
a minimum.    At the high end (for    example, a dual-processor technical workstation), the 
product would need to fully support    multiprocessing and advanced 3-D graphics as well 
as be capable of running technical    applications that use maximum machine and system
resources.          

Over time, low-end machines will become more powerful, and over time, some of todays  
high-end features will migrate to the low end.    In addition, some technical innovations 
will    appear on the mainstream Windows system first, largely because of the timing of 
product    releases, and because some features are focused on end users and ease of use.
The Win32    API assures developers that, whichever system they target today, their 
applications will be    able to run in the future as the platform evolves.      

Thus, while Chicago and Cairo may    leapfrog one another with some features, depending
on release cycles    e.g., Chicago will    sport the next major advance in the user interface, 
with Cairo inheriting it in its release a few    months later    the general principle over time 
is that the high-end product will be a    superset of the functionality offered in the 
mainstream product.    Any deviations from this    principle are temporary, due to 
variations in the product release schedules.    For ISVs and for development purposes, 
however, Microsoft has just one Windows platform,    defined by the Windows-based 32-
bit API, Win32.    By following a few simple guidelines,    ISVs can write a single application
(executable) that runs on the Windows operating system    product family.    If they wish, 
ISVs can target specific operating system products because    the functionality they 
provide is important to their particular application, but that is not a    requirement.        
This situation is very much like the Intel microprocessor product line.    At any point in 
time,    the Intel product line offers multiple products targeted toward different PC 
products, ranging    from the 80386SL for low-end portable products to the Pentium 
microprocessor for high-end    workstations and application servers.    What defines those 
products is the Intel instruction set,    which enables applications to run on all Intel chips, 
even though the underlying implementation    at the transistor level may be very 
different across the Intel product line.    There are also some    instructions offered on the 
Pentium chip that are not on the 80386SL, but ISVs would have to    go out of their way to
make their products run on only Pentium.    And over time, Pentium will    become more 
mainstream, just as the 80486 has become the mainstream microprocessor    today, and 
technologies developed at the low end, such as System Management Mode, will be    
implemented on the high end as well.



When will Chicago and Cairo ship? 94-03-18
When will Chicago ship?    When will Cairo ship?    

Chicago is scheduled to ship in the second half of 1994.    Cairo is scheduled to be 
released    in the first half of 1995. 



What is Daytona? 94-03-18
What is Daytona?    When will it ship?

Daytona is an interim release of Windows NT that is scheduled to ship this spring.



How will Chicago make the projected ship date? 94-03-18
Major new releases of operating system products have in the past been significantly 
delayed.      How will you make your projected shipment date for Chicago?    

Chicago will be released when customers tell us it is ready.    The way to make shipment   
dates is to hit your intermediate milestones.    To date, Chicago has been making its    
milestones with the release of the first Preliminary Developers Kit (PDK) in August and 
the    second PDK in December.    Feedback from beta releases beginning in March will tell 
us more    precisely when in the second half of 1994 Chicago will ship.



What if Chicago ships before Cairo? 94-03-18
If Chicago ships before Cairo, how will users of Windows NT obtain the new functionality 
in    Chicago?    

Any new functionality offered in Chicago will be made available to customers of Windows 
NT through the release of the Cairo product. 



What are Chicagos key benefits? 94-03-18
What are the key benefits and features of Chicago?    What features will Chicago not 
have?

    For customers, Chicago will present a major step forward in functionality on 
mainstream desktop    platforms by providing a system that is easy to use, offers 
responsive multitasking performance,    and provides a great platform for 
communications.    Ease of use will be delivered through the    Plug and Play architecture 
and an improved, intuitive user interface.    Chicago will be a complete,    integrated 
protect-mode operating system that does not require or use a separate version of MS- 
DOS, implements the Win32* API, and provides pre-emptive multitasking and multiple 
threads    of execution for 32-bit applications.    The communications capabilities of 
Windows will be    enhanced with integrated, high-performance networking, built-in 
messaging, and features such    as Remote Network Access and File Synchronization 
designed for mobile and remote computer    users.    Chicago will also be a hassle-free 
upgrade for the current installed base of Windows-based users.      Chicago will be 
compatible with most current applications and drivers for MS-DOS and Windows,    and 
will provide an easy transition to the new user interface features.    The applications    
performance of Chicago will meet or exceed the performance of Windows 3.1 on 80386    
systems with 4MB of RAM running the same applications.    For systems with more 
memory,    performance will be significantly improved over Windows 3.1.    The setup 
program will enable    customers to uninstall Chicago, assuring customers a way to 
remove it if they are in any way    unhappy with it, and will provide tools for system 
administrators to customize the configuration    of Chicago.    Chicago will not be 
processor independent, nor will it support symmetric multiprocessing    systems, provide 
C2-level security, or provide full Unicode support.    These features cannot be    delivered 
on the mainstream platform in the near future while still meeting the performance and    
resource targets necessary to create a compelling upgrade for the huge installed base of 
users    of the Windows operating system.    If these features are important to a customer,
Windows NT    is the product to deploy. 



What different Chicago packages will be available? 94-03-18
What different packages will you have for Chicago?    

Decisions about packaging the different technologies being developed as part of the 
Chicago    project will be made later in the development cycle and will be based on 
customer and    business needs.    One option is to provide a base Chicago package with 
some add-on    packages that deliver functionality required by specific market segments.  
This is much like    the situation today in which the user of Windows 3.1 can upgrade to 
Windows for    Workgroups by acquiring the add-on package that adds the 32-bit file 
system and 32-bit    networking enhancements to Windows.



What will Chicago be called? 94-03-18
Since the term Chicago is a code name, what will you call the product(s) that you will    
eventually release?

Decisions about names will be made after we decide on a packaging plan.



What will happen to MS-DOS? 94-03-18
What will happen to the MS-DOS product line?    

Microsoft will continue to enhance MS-DOS as long as customers require it.    Future 
versions    will be derived from the protected-mode technology developed in the Chicago 
project.      Current    MS-DOSbased applications and drivers will continue to be compatible
with new versions of    MS-DOS. 



How will Chicago perform on 4 MB? 94-03-18
Your performance goals on 4MB platforms sound very ambitious, considering all the    
functionality youre adding to Chicago.    How will you achieve those goals?

Chicago will implement new working set management technologies that will optimize the
use    of memory on low-configuration systems.    The networking, disk and paging caches 
will be    fully integrated.    Protect-mode device drivers will be dynamically loadable, to 
ensure that    only the drivers that are immediately needed are consuming memory.    
More components of    the base operating system will be pageable.    Great attention will 
be paid to effective page    tuning, including hand-tuning source code.



Will Chicago run current applications? 94-03-18
Will Chicago run my current Windows-based applications?    How about MS-DOSbased    
applications?

Chicago will run most of the current applications for Windows and MS-DOS, as well as 
new    applications written to the Win32 API.    Some classes of applications will need to be
revised    to be compatible with Chicago, such as shell-replacement utilities and file-
management    utilities.    Chicagos new shell provides a complete set of services that is 
tightly integrated    with the operating system components.    Shell programs will need to 
do more than simply    replace components such as Program Manager or File Manager.    
And file-management utility    vendors will want to revise their applications to take 
advantage of the Long File Name    feature that Chicago offers.    Microsoft is working 
closely with shell-replacement and file- utility vendors to enable them to revise their 
products to add value to and be compatible    with Chicago. 



Will I need to get new device drivers? 94-03-18
Will I have to get new device drivers to use my current devices with Chicago?

Chicago supports current real-mode device drivers as well as new 32-bit protected mode 
device drivers.    As a result, customers will be able to use their current devices either 
with    their current device drivers, or with new device drivers made available with 
Chicago.      Performance and functionality can be improved if the user installs the new 
Chicago drivers.      Microsoft is making it easier for device manufacturers to deliver new 
drivers for common    devices by defining a more layered, modular device driver 
architecture.    For displays, printers    and modems, Microsoft will deliver universal 
drivers.    These drivers will implement common    device functionality and expose an 
interface for device manufacturers to create minidrivers    that implement the features 
specific to their devices.    This approach was very successful    with printers for Windows 
3.1, resulting in rapid availability of fast, high-quality drivers for a    wide range of 
printers.



Will my current applications work well on Chicago? 94-03-18
Will my current applications perform as well on Chicago as they do on Windows 3.1 
today?    

For Chicago to be a compelling upgrade, Windows-based users must experience a level 
of    performance after installing Chicago that meets or exceeds the performance they 
currently    experience running an identical set of tasks on Windows 3.1.    Because a large
portion of the    installed base of users of Windows today have 4MB systems, Chicago 
must meet its    performance goals on 4MB systems.    On systems with more than 4MB of 
RAM, Chicago will    offer significantly improved performance.    Understand, however, that
there are user and application scenarios today that already use    more than 4MB.    Users 
who already require more than 4MB will continue to require more    than 4MB with 
Chicago    and if they are using more than 4MB, they should see improved    performance. 
But they wont get away with using less memory in the future than they do    today.    Its 
an important distinction to maintain. 



When will Chicagos new UI be ready? 94-03-18
You say Chicago will have a different user interface than Windows and Windows NT.    
When    will that user interface be reflected in the beta versions of Chicago?

The new user interface will be delivered with the first beta of Chicago, scheduled for 
March    1994.



Will the new user interface mean a lot of retraining? 94-03-18
Wont a new user interface mean a lot of retraining for current Windows-based users?    
Will    the advantages of the new user interface be worth the retraining costs?

The user interface being developed for Chicago will offer dramatic gains in ease of 
learning    and ease of use for the broad range of people using PCs today.    Instead of 
mastering    different kinds of tools to work with different resources on their computers, 
users of    Chicago will be able to browse for and access all resources in a consistent 
fashion with a    single tool.    This will be much easier than learning separate applications 
such as Program    Manager, File Manager, Print Manager, Control Panel, etc. as users of 
Windows must do    today.    A system toolbar that is always accessible will make it much 
easier to start and    switch between full-screen tasks.    The implementation of OLE 2.0, 
with its focus on the    users document rather than on the tool used to create it, and the 
direct manipulation of    data through drag and drop in the user interface, will make 
working with documents easier    and more intuitive. 

Current users of Windows will be immediately productive with Chicago and be able to 
learn    the new features of the user interface as they work.    Chicagos smart setup 
technology will    use the current system settings to present an initial configuration that is
familiar for the    current Windows-based user.    And for corporate customers and 
individuals who may not    want to make any user interface changes initially, Chicago will 
enable them to continue    running their current Program Manager and File Manager 
configurations.



What is Plug and Play? 94-03-18
What is Plug and Play?    What benefits does Plug and Play provide?

Plug and Play is a technology jointly developed by PC product vendors that will 
dramatically    improve the integration of PC hardware and software.    It allows a PC to 
adapt itself    dynamically to its environment; devices can be plugged into or unplugged 
from a machine,    without the user having to do anything special    the machine just 
works.    Plug and Play is    a general framework that advances that state of the PC 
architecture by defining how the    software communicates with any device connected to 
the PC.      Plug and Play technology enables installation and configuration of add-on 
devices without    user intervention.    Plug and Play will make it possible for a consumer 
to turn a standard    desktop system into a great multimedia machine by just plugging in 
a Plug and Play sound    card and CD-ROM, turning on the system, and playing a    video 
clip.    Plug and Play can enable new system designs that can be dynamically 
reconfigured.    For    example, imagine a docking station that enables you to remove the 
portable system while it    is still running so that you can take it to a meeting, and the 
system automatically    reconfigures to work with a lower-resolution display and adjusts 
for the absence of the    network card and large disk drive.    Or imagine an IR-enabled 
subnotebook that automatically    recognizes, installs and configures an IR-enabled 
printer when you walk into the room, so    your applications are ready to print to that 
printer.    Plug and Play can also save development and support costs for the product 
manufacturer.      Today, as many as 50 percent of support calls received by operating 
system and device    manufacturers are related to installation and configuration of 
devices.    With Plug and Play,    device driver development is simplified because device 
manufacturers can write one driver    that works across multiple bus types using the 
Universal Driver Model specified by the Plug    and Play architecture.    Today, device 
manufacturers have to include bus-specific code in    each of their drivers.    With Plug and
Play, specific bus configuration data is contained in    bus drivers.    Also, operating 
system preinstallation and configuration are simplified for    OEMs because Plug and Play 
devices will automatically install and configure during setup. 



What hardware changes does Plug and Play require? 94-03-18
What changes to current hardware and software are required to make Plug and Play a    
reality?    How will vendors figure out how to develop new devices with Plug and Play    
capability?

First, Plug and Play is compatible with existing systems, so nothing breaks because of    
Plug and Play.    Plug and Play devices can be brought out over time    in fact, this is 
already    occurring    and will work with existing systems.        To deliver all of the above 
benefits requires changes to devices and drivers, the BIOS, and    the operating system.    
Three fundamental capabilities are required for a system to provide    Plug and Play 
functionality:

· A unique identifier for every device on the system
· A procedure for the BIOS and operating system to install and configure that 

device
· A mechanism for the system and applications to recognize that a configuration    

change has occurred while the system is running    

All the changes to devices and drivers, the BIOS and the operating system are defined by
a    series of specifications for Plug and Play architecture.    The Plug and Play architecture 
is an    open, flexible and cost-effective framework for designing Plug and Play products.    
The Plug and Play architecture was jointly developed by a working group of leading 
vendors,    who reviewed design proposals with hundreds of companies in the industry at 
conferences    and through online forums.    Plug and Play can be implemented by any 
operating system    vendor and any hardware manufacturer.    In addition to Microsoft, IBM
has announced    support for Plug and Play in OS/2.    The Plug and Play architecture is 
flexible, because it provides a framework that works on    multiple types of bus 
architectures (ISA, SCSI, PCMCIA, VL, PCI, etc.), and it is extensible    to future bus 
designs.    The Plug and Play architecture is also cost-effective, because it requires little 
or no    incremental cost for vendors to implement in their products.



Wont it take a long time for Plug and Play? 94-03-18
Wont it take a long time for these changes to be reflected in products?    Acceptance of 
the Plug and Play architecture is widespread, as seen by the rapid progress    the industry
is making in delivering Plug and Play specifications and products.    Specifications have 
already been released for ISA, SCSI and PCMCIA devices, and the Plug and    Play BIOS.    
Additional specifications are in process, including PCI, ECP, VL, EISA, Micro    Channel, and
Access.    The first Plug and Play devices were demonstrated at COMDEX/Fall    1993, 
representing a wide range of companies and products.    Intel has released development   
kits that enable device and system vendors to deliver improved configuration capabilities
for ISA    and PCI systems running with Windows 3.1 in a manner that will provide 
compatibility with    future Windows operating systems.    Fully Plug and Play-capable 
systems (including all Plug and    Play devices and a Plug and Play BIOS) will be available 
in the first half of 1994.    These    systems will be able to offer complete Plug and Play 
functionality when combined with Chicago. 



Is the Chicago API different from the Windows NT API? 94-03-18
Ive heard that Chicago implements a 32-bit API.    Is that API different from the 32-bit API  
implemented on Windows NT?

There is only one 32-bit Windows API, called Win32, with ISVs able to use the API set to    
provide different levels of functionality for Windows 3.1, Chicago and Windows NT.      
Chicago implements a large subset of the functionality of the Win32 API offered on    
Windows NT, and extends the Win32 API in some areas.    These extensions will be 
delivered    on Windows NT as soon as possible after the release of Chicago.



Will vendors need separate Chicago and NT versions? 94-03-18
If there are different implementations of the Win32 API available on different products in 
the    Microsoft operating system product line, does that mean ISVs will have to have 
separate    versions of their applications for Windows and Windows NT?

No.    By following some simple guidelines, ISVs can develop a single executable file that 
runs    on Windows 3.x, Chicago and Windows NT.    At the recent Professional Developers   
Conference, we provided in-depth technical sessions on the proper way to design    
applications to do so, supplied tools in the SDK to help make such development easier, 
and    showed several applications that ran across the entire Windows family.



When will Chicago applications be available? 94-03-18
When will applications be available that exploit Chicago?    Wont that take a long time?    

ISVs who are developing 32-bit applications for Windows 3.1 and Windows NT using the    
Win32 API and the guidelines we have provided will have applications that are able to 
run on    Chicago immediately.    There are already more than 250 Win32 applications 
available today,    and more coming quickly.    Other ISVs will wait until Chicago ships to 
provide their 32-bit    applications; usually those applications start coming on-line about 
90 days after the    operating system ships.    Chicago also will support todays 16-bit 
applications, so users can    move to Chicago immediately and upgrade their applications 
as they become available.    Chicago represents a major market opportunity for ISVs.    
Chicago will ship on almost all OEM    systems soon after it is released, and it will be 
acquired as an upgrade by a substantial portion    of the Windows installed base (the 
installed base will probably number more than 50 million by    mid-1995).    Customers 
who purchase new systems and upgrade their operating systems are    the most active 
purchasers of new software applications.    As a result, ISVs have a very    significant 
business incentive to release versions of their applications that exploit Chicago.



Is Chicago completely 32-bit? 94-03-18
Ive heard Chicago described as a 32-bit operating system, yet Ive also heard that 
portions of    Chicago are implemented with 16-bit code.    Are both these statements 
correct?

Chicago will provide a 32-bit platform for applications by implementing the Win32 API on 
a    complete, protect-mode operating system.    Chicago will also run well on mainstream  
Windows platforms (which for a large portion of the Windows installed base is a 4MB    
80386 system), and Chicago will be compatible with applications and drivers for MS-DOS 
and Windows.    These requirements must be met if Chicago is to meet customer needs 
and    provide the volume to make ISVs successful. 

These requirements have driven all the design decisions for Chicago.    The resulting 
design    deploys 32-bit code wherever it improves performance without sacrificing 
application    compatibility.    The design retains existing 16-bit code where it is required to
maintain    compatibility or where size is a critical issue but has minimal impact on 
performance.    All of the    I/O subsystems and device drivers in Chicago, such as 
networking and file systems, are fully    32-bit as are all the memory management and 
scheduling components (the kernel and virtual    memory manager).    Many functions 
provided by the Graphics Device Interface (GDI) have been    moved to 32-bit code, 
including the spooler and printing subsystem, the rasterizer, and the    drawing 
operations performed by the graphics DIBengine.    Much of the window management    
code (user) remains 16-bit to retain application compatibility.



How do the 16-bit components fit in? 94-03-18
If portions of Chicago still remain 16-bit, what happens when a 32-bit application makes 
a    function call that is implemented by the 16-bit Chicago component?    Doesnt this slow
down    32-bit applications on Chicago relative to 16-bit applications?

When Win32-based applications call a 32-bit API that is implemented by a 16-bit 
component    of the system, the function call is translated to its 16-bit equivalent for 
processing by the    system.    This translation process is referred to as    thunking.    
Although there is some    overhead associated with a thunking operation, the Chicago 
thunk layer is very efficient.      That overhead will be more than offset by the improved 
efficiency of the linear memory    addressing scheme used by Win32-based applications.   
The overall impact of some    thunking code is quite modest vs. all the other work the 
application and operating system    have to do.        For end users, perceptions of 
application performance are based on a combination of the    efficiency of the application 
when executing its own code and the efficiency of the operating    system code when the 
application has called an operating system service.    On Chicago    systems with 
adequate memory, end users will experience gains in system efficiency when    running 
16-bit applications, and they will experience gains in both system and application    
efficiency when running 32-bit applications.



Will existing networking software work with Chicago? 94-03-18
Will I need new networking software to connect Chicago to my network server?

Customers will require Chicago to connect to their network servers when Chicago is    
installed, and to offer high-performance, reliable networking functionality.    To meet this    
requirement, Chicago will continue to run existing real-mode networking components.      
However, we expect customers to want to upgrade to the new 32-bit networking    
components provided by Chicago.    Chicago will enhance the open, flexible, high- 
performance 32-bit networking architecture offered today with Windows for Workgroups   
3.11 that enables customers to mix and match networking components.    Chicago will    
support NDIS 2.0, NDIS 3.0 and ODI drivers, and will provide 32-bit NetBEUI, IPX/SPX and 
TCP/IP protocols.    Redirectors for SMB and NCP-based networks will be included.    In    
addition, Chicagos new multiple-provider interface will make it possible for the user to 
view,    browse and connect to multiple networks in a consistent fashion. 



What about Netware with Chicago? 94-03-18
What about NetWare?    Are you working with Novell on NetWare support?

Customers will require high-performance, reliable NetWare support the day Chicago is 
released.      To meet that requirement, Microsoft is developing a 32-bit NCP Redirector 
that is seamlessly    integrated with the Chicago user interface, and is encouraging Novell
to do the same.    Microsoft    will offer Novell access to information and assistance to 
write a Chicago redirector.    Novell    engineers attended the Win32 Professional 
Developers Conference and have been provided    access to the Preliminary Developers 
Kit for Chicago.        With this approach, customers should be able to choose from multiple
sources for reliable,    high-performance NetWare connectivity software when Chicago is 
released.



Will there be Chicago server version? 94-03-18
Will there be a Chicago server?

No, not in the sense of a server product such as Windows NT Advanced Server.    Chicago  
will continue to improve upon the peer server capabilities offered in Windows for    
Workgroups by offering additional features for remote installation, control and    
administration.    These features will make Chicago an even better product for an easy-to-
use    file and print-sharing LAN that is ideally suited as a small-business, small-
department or    remote office network.    Similarly, Windows NT offers peer services as 
well for the high-end    desktop.    But for most    server applications, and in the sense that 
most people ask about a    server product, Windows NT Advanced Server is the Microsoft 
server product.



What about Chicagos portability? 94-03-18
I keep hearing rumors that you are working on a portable version of Chicago.    Is this 
true?    

No, we are not working on a portable version of Chicago.    Windows NT is our portable    
operating system, and its already available on high-end Intel, MIPS, Alpha and Clipper    
machines; it will be available on the PowerPC by mid-1994 and on other high-end    
platforms over time.    There is no reason to make Chicago portable.    Chicago is 
optimized for    Intel processors, and much of its internal code is Intel assembler, which 
puts Chicago at the    heart of todays low-end and mainstream line.      Portability is 
important for the new    generation of high-powered Intel and RISC machines, on which 
Windows NT runs and for    which Windows NT has been optimized.    As these new high-
end machines become more    mainstream, which will happen over time, Windows NT will 
already offer the power,    security, and reliability that users will demand to exploit these 
new machines.



What about systems management? 94-03-18
What will Chicago do to make the client operating system more manageable?

A primary goal for the Chicago project is to make Windows less expensive to deploy in a   
corporation.    Chicago will include some specific features and enabling technologies that 
will    make it easier for system administrators to install, configure, monitor, maintain and 
troubleshoot their Windows-based desktops.    Chicago can be set up from a network 
server and at the desktop can be configured at the    desktop to run locally or across the 
network.    In each case, the administrator can establish a    specific configuration for the 
installation, selecting from a flexible array of setup    configuration options.    Chicago 
desktops require only a floppy drive to start up, and paging    of components to a swapfile
on the network can be disabled to minimize network traffic.      

Once Chicago is installed, administrators will be able to centrally configure desktop 
settings    such as file and printer sharing, network access, and passwords.    They can 
remotely monitor    Chicago desktops with peer services running to determine what 
resources are shared, what    connections have been made, and what files are being 
used.    Chicago enhances the security    provided by Windows for Workgroups to include 
user-level security.    To enable users to access    their personal groups, applications, and 
data from any system on the network, Chicago will    provide user profiles.    Chicago will 
also provide the infrastructure for the delivery of enhanced desktop    management 
services by third parties. A backup agent will be included with Chicago to    enable 
administrators to back up desktop data to a network server. To integrate the desktop    
into SNMP-based enterprise management systems, Chicago will also include a Systems    
Network Management Protocol (SNMP) agent and a Management Information Base (MIB) 
for    a number of system resources. The system registry and Plug and Play architecture 
provide a    rich store of data about the software and hardware configuration on the 
desktop, and this    information can be accessed by system management software using 
a DCE-compliant    Remote Procedure Call (RPC) mechanism.



Will there be mobility features? 94-03-18
What improvements will Chicago offer for people who use a mobile or remote computer?

Chicago will provide great support for mobile form-factor devices and will make it easy 
for    end users to access the resources of their desktop systems when they are away 
from their    offices.    The implementation of Plug and Play in Chicago will support 
insertion and removal    of devices such as PCMCIA cards while the operating system is 
running.    It will also support    automatic reconfiguration of dockable computers when 
they are inserted or removed from    the docking station, without rebooting the system.    
An enhanced version of Advanced    Power Management will further extend battery life.    
The services provided by Windows for    Pen Computing will be enhanced and 
incorporated into Chicago, including basic inking and    rendering support.    A special 
focus will be on remote connectivity.    Any Chicago-based machine will be able to    serve 
as a Remote Access dial-up server or a remote client for Windows NT Advanced    Server, 
Novell NetWare servers or Chicago peer servers.    The same technology will be used    for 
serial cable and infrared connections between PCs. The Remote Access architecture will    
be integrated with the Chicago networking architecture by using the same network 
protocols    and advanced security features.    Remote Access will support wireless devices
and allow    application developers to make their applications slow-link aware to improve 
the user    experience when working on a remote system via modem rather than on a 
high-bandwidth    network.    Furthermore, Chicago will provide a simple form of file 
synchronization and APIs    for applications to access the file synchronization services to 
merge changes when both the    source document and copy have been modified.      
Remote e-mail and Microsoft at Work fax capability will be included, as in Windows for    
Workgroups 3.11 today.



How will file synchronization work? 94-03-18
Will the file synchronization feature in Chicago provide document management 
capabilities?    

Chicagos file synchronization services are optimized for the needs of the mobile 
computer    user who wants to take copies of documents to a remote location and have 
them be    automatically synchronized with the source documents.    It is not intended as a
replacement    for sophisticated document management systems. 

Chicagos file synchronization allows customers to identify files that they want to stay up 
to    date, to change those files, and to have the files automatically updated when the 
source file    is available to the system.    The update is performed by replacing the source
file with the    modified copy at the discretion of the user.    If an application writes a 
merge-handler, then    specific data within the modified and source copies of a file can be
merged, to create a new    updated copy.



Will there be separate NT and Chicago SDKs? 94-03-18
You say you have one API with Win32.    Does that mean there will also be just one 
Windows    SDK?    

Yes, there will be one Win32 SDK that developers can use to develop 32-bit applications 
for    Windows 3.1, Chicago and Windows NT.    In fact, we recently announced a new    
subscription service, the Microsoft Developer Network Level II that provides developers 
with    not only the Win32 toolkit, but every system toolkit we offer, on a single CD, 
updated    quarterly. 



What benefits are there to developers? 94-03-18
What benefits does Chicago offer to developers?    What are you doing to make 
developing    Windows-based applications easier?

The Microsoft Visual Basic programming system has dramatically streamlined and 
simplified    the development of Windows-based applications, and it will be enhanced to 
support the    development of 32-bit applications for Chicago.    Microsoft also is 
enhancing its Visual C++ * development system and Microsoft Foundation Class tools.



Will Visual Basic for Applications be included? 94-03-18
 Will Chicago include Visual Basic for Applications?    

Visual Basic for Applications will be offered as a separate product.



Will Chicago and NT use common device drivers? 94-03-18
Will Chicago and Windows NT share the same device drivers?

Generally not, since Chicago and Windows NT have different device driver models.    
However,    since both products support a modular, layered device driver architecture, 
there are areas of    substantial synergy.    For example, SCSI miniport adapters for 
Windows NT will be binary- compatible with Chicago, as will printer drivers and NDIS 
drivers for Windows NT. 



Will WOSA services be included? 94-03-18
Will WOSA services be included with Chicago?

WOSA is a general, open framework for implementing multiple back-end services in    
Windows while providing a single front-end interface for end users.    Services in Chicago   
such as messaging and remote network access are designed according to the WOSA    
framework.    Whether or not support for additional WOSA services, such as ODBC 
support,    will be shipped with Chicago is a packaging decision that will be made later in 
the    development cycle and will be based on customer and business needs.    All the 
WOSA- related toolkits are available today to developers through the Microsoft Developer
Network    Level II subscription service. 



Internet and Usenet



Usenet 94-03-15
If you received this FAQ from somewhere other than Usenet or Internet, you may not be 
familiar with Usenet.    Basically, Usenet is a loose collection of over 1,000,000 computers
which exchange mail and news.    The network is unstructured and highly distributed; 
most communication is either by TCP/IP over high-speed connections (or over dual-up 
links using public telephone lines), or UUCP over public telephone lines.    

Internet is the worldwide collection of computers linked using the TCP/IP protocol, 
consisting of somewhere    between 5,000,000 and 10,000,000 computers, usually 
connected by high-speed TCP/IP network connections. 

Usenet news is a software system where a person can post an article to a selected 
newsgroup, and have every other news reader be able to read it.    There are over 3,000 
newsgroups (including the alt groups), and daily volume of news now exceeds 50 MB.

While most Usenet systems are Unix-based, it is not a requirement, and there are a 
number of Usenet software packages available for Windows as well.    If you have an 
Internet or UUCP connection, ask your system administrator whether you have Usenet 
news available.    Some of the most common newsreading software packages are 
readnews, rn, trn, nn and notes.



Usenet Windows newsgroups 94-03-15
There are a total of eight Usenet newsgroups dealing with Microsoft Windows: 

· comp.os.ms-windows.advocacy
This group is intended for adversarial discussions, arguments and comparisons to 
other computers and operating systems.    Applicable to all Windows platforms.

· comp.os.ms-windows.announce
This is a low-volume moderated group with only Windows-related announcements 
(and the text versions of the FAQs) and with no discussion.      Moderated by Steve 
Graham (sgraham@shiloh.nimh.nih.gov).

· comp.os.ms-windows.apps
This group contains discussions, questions, and comments about the selection and 
use of Windows and Windows NT applications.

· comp.os.ms-windows.setup
This group is meant for questions and discussions about Windows and Windows for 
Workgroups setup process, driver availability and selection, and hardware 
compatability and selection. 

· comp.os.ms-windows.misc
All other discussions about Windows and Windows for Workgroups should be in this 
group.

· comp.os.ms-windows.video (proposed)
Discussions about vide0 adapters, monitors and video drivers for usee with Microsoft 
Windows and Windows NT.

· comp.os.ms-windows.networking.windows (proposed)
Discussions about Windows built-in networking capabilities: Windows for Workgroups,
Windows NT, Windows NT Advanced Server and LAN Manager.

· comp.os.ms-windows.networking.tcp-ip (proposed)
Discussions about TCP/IP networking with Windows, WinSock, WinSock-based 
applications, newsreaders, PPP and SLIP.

· comp.os.ms-windows.networking.misc (proposed)
Discussions about Windows and other networks, including Netware, Banyan Vines, 
LANtastic and LAN Server.

· comp.os.ms-windows.nt.setup
Questions and discussions about the Windows NT setup process, driver availability 
and selection, and hardware compatability and selection. 

· comp.os.ms-windows.nt.misc
All other discussions about Windows NT should be in this group.

· comp.os.ms-windows.programmer.tools
Discussions about the selection and use of    tools for Windows software development.

· comp.os.ms-windows.programmer.win32
All discussions about the Win32 applications programming interface (used in 
Windows NT and Win32s) and the Windows NT SDK belong in this group.. 

· comp.os.ms-windows.programmer.misc
This group is for all other discussions about Windows software development.

· comp.os.ms-windows.programmer.bitmaps (proposed)
Discussions about programming with bitmaps, palettes and DIBs.

· comp.os.ms-windows.programmer.controls (proposed)
Discussions about programming with controls, dialogs, custom controls and VBXs.

· comp.os.ms-windows.programmer. drivers (proposed)
Discussions about programming Windows and Windows NT drivers and VxDs.



· comp.os.ms-windows.programmer. graphics (proposed)
Discussions about programming with graphics, GDI, fonts and printing.

· comp.os.ms-windows.programmer.memory (proposed)
Discussions about memory management, processes and DLLs.

· comp.os.ms-windows.programmer.ole (proposed)
Discussions about programming with OLE, COM and DDE.

· comp.os.ms-windows.programmer.winhelp (proposed)
Discussions about development of WinHelp and MultiMedia viewer applications.

· comp.binaries.ms-windows
This group is for postings of free and shareware Windows applications, utilities, 
display and printer drivers    and for the latest FAQs.    Moderated by Tin Le 
(tin@saigon.com).

The following groups have been replaced by those shown above: 
· comp.windows.ms

This group was for discussions about Microsoft Windows.
· comp.windows.ms.programmer

This group was for discussions about programming for Microsoft Windows.

The following groups may also be of interest: 
· alt.winsock

This group is for discussions about the use and programming of the Windows Sockets 
interface.

· comp.databases.access        (proposed)
This group is for dicussions about Microsoft's Access database..

· comp.lang.basic.visual
This groups is for Visual Basic (both Windows and MS-DOS versions) discussions.

· comp.os.msdos.programmer
This groups contains general MS-DOS programming questions.    Some, especially 
those concerning compiler selection, may be of interest to Windows programmers.

· bit.listserv.win3-l
This group is a two-way gateway of the BITNET WIN3-L mailing list, dealing with all 
aspects of Windows 3.x.

· bit.listserv.access-l
This group is a two-way gateway of the BITNET ACCESS-L mailing list, dealing with 
Microsoft's Access database.

The following groups are not for Microsoft Windows!
· comp.windows.misc

This group is for miscellaneous discussions about windowing systems in general.
· comp.windows.news

This group is for discussions about the Sun Microsystems NeWS windowing system.

In general, these newsgroups are only available to computers connected to Usenet or 
Internet; they are not gatewayed into BITNET, CompuServe, Prodigy or other services. 
Some FidoNet BBS systems, however, do carry selected Usenet newsgroups.    If you 
cannot obtain access to these groups on your system, contact the author of this FAQ for 
possible alternatives.



Alternatives to Usenet 94-03-02
If you are unable to find a connection to the Internet (that procedure can not be easily 
defined, as the Internet does not have any sort of a formal structure), there are several 
alternatives available for finding more information about Windows, and for locating 
Windows software and drivers.

BITNET users (as well as any other with an electronic mail connection to Internet) can 
subscribe to lists such as WIN3-L (win3-l@uicvm.bitnet), a mailing list dedicated to 
Windows discussions.    This mailing list is similar in content to the comp.os.ms-
windows.misc newsgroup; no programmer mailing list exists on BITNET.    See the 
following list for a list of mailing lists.

America OnLine also provides access to Usenet newsgroups.

If you live in North America (or in one of selected Western European countries), you can 
subscribe to CompuServe, a commercial service.    CompuServe has extensive Windows-
oriented discussions and a fairly good selection of free software.    Although the level of 
discussion is often less technical, it is much more structured than the Internet.    
CompuServe also has numerous vendor-supported forums, including ones organized by 
Microsoft for Windows and Windows NT.

Many FidoNet-based BBS systems also carry the Usenet Windows newsgroups.    Consult 
a local BBS listing to find your nearest FidoNet BBS.



Windows-related mailing lists 94-03-02
The following mailing lists are Windows-related.    Please use the requests address for 
administrative mail (such as getting added to the list):

· Dr. Help
List: drhelp@eng.monash.edu.au
Requests: listserv@eng.monash.edu.au

· LabView
List: info-labview@pica.army.mil
Requests: info-labview-requesr@pica.army.mil

· Lotus Improv
List: improv@bmt.gun.com
Requests: improv-request@bmt.gun.com

· MathCAD
List: mathcad@eng.monash.edu.au
Requests: listserv@eng.monash.edu.au

· OWL
List: owl-list@cs.rpi.edu
Requests: owl-list@cs.rpi.edu

· ProtoGen/ProtoView
List: protoplus@netcom.com
Requests: protoplus-request@netcom.com

· WIN3-L (Windows 3.x)
List: win3-l@uicvm.bitnet
Requests: listserv@uicvm.bitnet



Freeware and shareware by ftp
While CompuServe (which has a lot of software) and your local BBS may have large 
selections, the Internet provides an immense resource for all PC users.    The key program
to access this software is called ftp (File Transfer Protocol), and it's usable from most 
Internet system, but is not usable through UUCP links.    

If you do have ftp available to you, follow the example below to connect to 
ftp.cica.indiana.edu (do not type in the // comments):

$ ftp ftp.cica.indiana.edu // make connection
Connected to ... // cica responds
Userid (user@cica): ftp // enter "ftp" as userid
Password: real_userid@site // enter your own userid
ftp> tenex // for binary transfers
ftp> cd /pub/pc/win3 // where the goodies are
ftp> ls -l // list the directory
ftp> get ls-ltR // get the current index
ftp> quit // we're done!
$ _

Of course, you can get multiple files at a time    read the ftp manual page for more 
information.    

Remember that shareware is not free: register the software you use to encourage the 
development of more low-cost software.



Popular Internet ftp sites 93-03-01
The following ftp sites provide significant amounts of software of interest to Windows 
users: 
· ftp.cica.indiana.edu (129.79.20.84)

Directory /pub/pc/win3  contains one of the largest selections of Windows software 
and device drivers anywhere.    Mirrored by wuarchive.    Please do not access 
ftp.cica.indiana.edu between 8am and 6pm EST to prevent overloading the system.

· wsmr-simtel20.army.mil (26.2.0.74)
Directory pd1:<msdos> contains a very large selection of MS-DOS (and some 
Windows) software.    Mirrored by wuarchive.

· wuarchive.wustl.edu (128.242.135.4)
Directory /mirrors/win3 contains a copy of the cica Windows archives, and directory
/mirrors/msdos contains a copy of the simtel10 MS-DOS archive.

· ftp.uu.net (137.39.1.9)
Directory /vendors/microsoft contains a lot of the Microsoft developer support 
materials available on CompuServe, including tech notes, sample sources, the ODBC 
SDK and WinHelp documentation for Windows and Win32 SDKs. 

· garbo.uwasa.fi (128.214.12.3)
Directories /win3 and /win31 contain a majority of the cica Windows archives, and a 
fair amount of non-cica material.    Note that garbo.uwasa.fi is located in Finland, and 
North American users should avoid congesting transatlantic Internet links by ftping 
from this site.    Mirrored by wuarchive.

· cc.monash.edu.au
Directory /pub/win3 contains a copy of the cica Windows archives.    Note that monash
is located in Australia, and North American users should avoid congesting transpacific
Internet links by ftping from this site.

· ftp.und.ac.za
Directory /pub/pc/win3/vbasic contains a a variety of things useful to Visual Basic 
programmers.    Note that und is located in SouthAfrica, and you should try to avoid 
congesting transpacific Internet links by excessive ftping from this site.

If your ftp program complains about an unknown site, you can substitute the numeric 
Internet address (shown after each site name above) for the name in the ftp command.



Using archie 92-09-21
If you know the program you're looking for, but don't know where to find it, you might try
using a utility called archie.    This program allows you to search for a filename in all the 
available ftp sites.

There are numerous archie servers available; to use one of them, telnet to the system, 
and sign on as archie.    Follow instructions to search for a file.    The following lists some 
of the know archie servers currently available for use; pick one in your geographical 
area:

· archie.rutgers.edu United States (Northeast)
· archie.sura.net United States (Southeast)
· archie.unl.edu United States (West)

· archie.mcgill.ca Canada
· archie.au Australia and New Zealand
· archie.funet.fi Europe
· archie.doc.ic.ac.uk United Kingdom



Ftp by email
There are several sites that will perform general FTP retrievals for you in response to a 
similar mail query, although it appears that the info-server@cs.net server is permanently
out of order.    

In general, please be considerate, and don't over-use these services.    If people start 
using them to retrieve megabytes and megabytes of GIF or WAV files, they will probably 
disappear.    Also, keep in mind that your system may be linked to the net using a long-
distance UUCP connection, and your sysadmin may not be happy about large mail files 
using up modem time and filling overloaded spool directories.

· bitftp@pucc.bitnet
For information on this one (available only to BITNET sites) send it the message:

help

· ftpmail@decwrl.dec.com
For information on this server, available to all Internet sites, send it a mail message 
with a body containing simply:

help

· mailserv@garbo.uwasa.fi
One final choice is to use the garbo.uwasa.fi server, which lets you access the 
garbo.uwasa.fi archive (which contains most of the cica files).    For instructions, send 
it a mail message with "Subject: garbo-request" and a single line of text "send help" 
to 

send help
Please do not use this service if you are located in North America!



FAQs (Frequently Asked Questions) 93-02-04
Hundreds of Usenet newsgroups have their own FAQs, most of them in text format.    You 
can retrieve almost all of these FAQs' latest versions by ftp from rtfm.mit.edu in the 
directory /pub/usenet/news-answers.



More about Internet and Usenet 94-03-15
To learn more about Internet and Usenet, I strongly recommend you purchase or borrow 
a copy of Ed Krol's The Whole Internet User's Guide and Catalog (ISBN 1-56592-025-2, 
$24.95), which covers email, news, ftp, archie and much more.    This 400-page handbook
is a thorough guide to getting around on the Net, clear enough for neophytes but with 
new information even for true Internet veterans.    A wide range of other books are also 
available; check your local bookstore for the selection.

To purchase The Whole Internet User's Guide and Catalog, check your local bookstore or 
contact the publisher, O'Reilly and Associates at 1-800-998-9938 (103 Morris St., 
Sebastopol, CA 95472).



FTP archives on CD-ROM 92-09-21
Walnut Creek offers copies of the cica, wuarchive and simtel  FTP archives on CD-ROM, at
prices ranging from $25 to $50, with annual subscriptions available.    Call (800) 786-
9907 or (510) 947-5996 for more information.



Setting Up and Configuring Windows



System Configuration



Minimum Windows 3.1 configurations
The minimum    system configurations to run Windows 3.1 are as follows:
· Standard Mode

286 processor, 640KB base memory, 256KB extended memory, EGA graphics
· 386 Enhanced Mode

386 processor, 640KB base memory, 1MB extended memory, EGA graphics

The following are recommended    minimum configurations (based on the experiences of 
many net Windows users) for good performance.
· Standard Mode

286/12 processor, 2MB total memory, VGA graphics, mouse
· 386 Enhanced Mode

386SX/16 processor, 4MB total memory, VGA graphics, mouse



Minimum Windows 3.0 configurations
The minimum    system configurations to run Windows 3.0 are as follows:
· Real Mode

8088 processor, 640KB base memory, CGA/Hercules graphics
· Standard Mode

286 processor, 640KB base memory, 256KB extended memory, CGA/Hercules 
graphics

· 386 Enhanced Mode
386 processor, 640KB base memory, 1MB extended memory, CGA/Hercules graphics

The following are recommended    minimum configurations (based on the experiences of 
many net Windows users) for good performance.    (Real Mode is not configurable for 
good performance, and many applications will not run in it due to a lack of memory.)
· Standard Mode

286/12 processor, 2MB total memory, VGA graphics, mouse
· 386 Enhanced Mode

386SX/16 processor, 4MB total memory, VGA graphics, mouse



Minimum Windows NT pre-release configuration 92-12-22
The minimum    recommended    system configuration to run the Windows NT pre-release 
Software Development Kit is as follows:

· 386DX/33 processor
· 12 MB memory
· 100 MB hard disk
· VGA graphics

The recommended    system configuration to run the final retail release of Windows NT, 
including networking and several applications, is expected to be the following (according 
to Microsoft):

· 386DX processor
· 8 MB memory
· 100 MB hard disk
· VGA graphics



Standard mode vs. 386 Enhanced mode
If you own a 386- or 486-based system, you have the choice of running in either 
Standard or Enhanced mode.    The following lists the advantages of each:

Standard mode
· Speed.    Many aspects of Windows run substantially faster in Standard mode than 

in 386 Enhanced mode.

386 Enhanced mode
· Virtual memory capability.
· Multiple DOS sessions are pre-emptively multitasked.
· DOS sessions may be run in a window.
· Able to run 386-specific applications such as Mathematica, FrameMaker and 

wdeb386.



Selecting a hardware configuration for Windows



Selecting a CPU/FPU 92-12-22
As always, faster is better.    However, CPU alone won't determine your system's Windows
performance.    

You can get fairly good performance even with a 386SX/20 processor given sufficient 
memory, and if you have a video accelerator card, a 386DX/40 doesn't feel much slower 
than a 486DX/33.    You most definitely won't be able to tell a 486DX/33 and a 486DX2/66
apart in "normal" Windows operation.

Windows itself will not take advantage of a floating point unit such as the 287 or 387.



Selecting the memory size 92-12-22
Again, the more memory the better.    

You can get tolerable performance with 2 MB, but 4 MB is a more realistic minimum for 
decent performance.    If you have 8 MB, you can use a reasonably large disk cache (such
as SmartDrive) and RAM disk; with 16 MB, you can disable swapping completely and get 
even better performance.

Make sure your memory is either on the motherboard, or on a high-speed bus (such as 
EISA or MCA).    The standard ISA bus will slow your memory accesses down to a crawl.



Selecting a hard disk 92-12-22
For best Windows performance, you want a WD-compatible disk controller.    As most SCSI
controllers (such as the excellent Adaptec 1542B and 1740) are not WD-compatible, they
can not use Windows' FastDisk 32-bit disk access facility.    Worse yet, you may need to 
double-buffer your SCSI drive with SmartDrive, further degrading performance.

The best bet for Windows 3.1 and future Windows NT performance is a high-speed IDE 
drive (all of which are WD-compatible).    The controllers are inexpensive (and built into 
many motherboards), and the new drives are quite fast.    IDE drives tend to be smaller, 
however, than their SCSI and ESDI counterparts, ranging from 40 MB up to about 500 MB
(SCSI and ESDI drives currently on the market range from 300 MB to over 2 GB).

The final option is to use an ESDI drive; these drives are usually identical to their SCSI 
counterparts, but with different interface electronics.    As long as you don't use a 
controller with a custom BIOS (such as the WD-1009), you can use Windows' 32-bit disk 
access for better performance.    While ESDI is generally somewhat slower than SCSI, the 
32-bit access capability far outweighs that difference.



Selecting a video adapter 94-01-20
Given Windows GUI orientation, a fast video adapter is essential for good performance.    
In addition, a better video adapter can provide higher resolution, higher refresh rates (for
a steadier picture) and more on-screen colors (for more realistic picture reproduction).

You should look for a card supporting a 70 Hz or 72 Hz refresh rate (provided your 
monitor can handle that), and likely at least 

A local bus or EISA graphics card will provide better performance, but the difference is 
not as significant with accelerated cards as it is with dub frame-buffer designs such as 
the ET4000 chipset.    In general, don't pay double just to get an EISA card!

The following will attempt to describe some of the high performance (i.e. better than 
VGA) video adapters currently on the market.    The descriptions are frequently based on 
the chipsets rather than commercial product names, as numerous vendors will market 
adapters using basically identical hardware.    All comments below are subjective and 
reflect the author's opinion only.    Do not base a purchase decision solely on this listing, 
but always test a video adapter using your own applications prior to purchase, if 
possible.

    4b:      4-bit color (16 colors)     8b:      8-bit color (256 colors)
15b: 15-bit color (32,768 colors)        24b: 24-bit color (16.7M colors)
*interlaced

· ATI: Mach 8
1280x1024x4b*, 1024x768x8b, 800x600x8b, 640x480x8b
This is the original ATI accelerator chipset, which powers the ATI 8514 Ultra, Graphics 
Ultra and Graphics Vantage.    The Ultra cards use VRAM video memory, while Vantage 
uses slower DRAM.    The 8514 Ultra does not include onboard VGA, but both other cards 
do.    All three cards are 8514 compatible.    These cards, while no longer the fastest 
around, provide excellent Windows performance at all resolutions.    The driver support is 
very good (with Windows NT beta drivers available), and ATI provides anti-aliased Crystal
Fonts for better readability.

· ATI: Mach 32
1280x1024x8b, 1024x768x15b, 800x600x24b, 640x480x24b
The second-generation ATI accelerator chipset powers the ATI Ultra+ and Ultra Pro.    The 
Ultra Pro uses VRAM video memory, while Ultra+ uses slower DRAM.    Both cards are 
8514 compatible.    Both cards are extremely fast and provide blinding Windows 
performance. The driver support is excellent, with even beta Windows NT drivers 
available.    ATI provides anti-aliased Crystal Fonts for better readability.    One problem is 
that the highest performance Ultra+/Pro setup requires a 4 MB memory aperture, which 
is not possible on an ISA-based system with 16 MB of memory; disabling the memory 
aperture reduces performance by at least 5-10%.    Effectively an ISA-based Ultra+ is 
slower in a 16 MB system than the original Mach 8-based Graphics Ultra.

· ATI: Mach 64
1280x1024x8b, 1024x768x15b, 800x600x24b, 640x480x24b
These are ATI's upcoming third-generation accelerator cards.

· Avance Logic: ALG2101
1280x1024x4b*, 1024x768x8b, 800x600x15b, 640x480x15b
The '2101 is a medium-speed performer with some serious reliability problems and 
buggy Windows drivers.



· Avance Logic: ALG2201
1280x1024x8b*, 1024x768x15b, 800x600x24b, 640x480x24b
The '2201 is the upcoming replacement for the '2101, with 24-bit true-color support, and 
intended for local bus designs.

· C&T: 82C481
1280x1024x8b*, 1024x768x15b, 800x600x24b, 640x480x24b
C&T's '481 chipset (often combined with the C&T Wingine chipset for VGA compatability) 
is a blazingly fast performer, but is currently hobbled by limited driver support.    Check 
that the modes you need are supported before buying, and be prepared to have 
Windows fly!

· Compaq: 128084
1024x768x8b, 800x600x15b, 640x480x8b
Compaq's excellent QVision accelerator design is now getting to be a bit long in the 
tooth, and its performance is below nearly all of its competitors.

· IIT: AGX015
1280x1024x8b*, 1152x960x8b, 1024x768x15b, 800x600x24b, 640x480x24b
The AGX015 is IIT's implementation of the XGA specification, although at least the first 
available cards (Hercules' Graphite series) are not XGA-compatible.    Despite some 
benchmark cheats, this remains an extremely fast card in real use, and wit has refresh 
rates of up to 90 Hz available.

· S3: 87C801
1280x1024x8b, 1024x768x15b, 800x600x24b, 640x480x24b
The '801 is a higher-performance (32-bit), lower-cost version of the '924 chipset, using 
inexpensive DRAM instead of the faster VRAM video memory.    The performance edge 
over the original '911 is in excess of 50% on WinMark benchmarks.

· S3: 87C805
1280x1024x8b, 1024x768x15b, 800x600x24b, 640x480x24b
The '805 is a further development of the '801 chipset, optimized for EISA and local 
buses, and with more memory to allow hi-color and true-color modes at higher 
resolutions.    Like the '801, it's a 32-bit DRAM design.

· S3: 87C911
1280x1024x4b*, 1024x768x8b, 800x600x15b, 640x480x24b
This is the original S3 accelerator chipset.    It provides very good all-around performance,
and is widely used in accelerator boards such as the Diamond Stealth.    For better 
performance, look for the newer '801 or '928 chipsets, though.

· S3: 87C924
1280x1024x4b*, 1024x768x8b, 800x600x15b, 640x480x24b
The '924 is an updated version of the original S3 '911 chipset.    Its performance is only 
somewhat improved over the original chipset (and less so than the '801 and '928), but it 
has some hardware bugs fixed (these bugs were previously worked around by the 
Windows drivers).

· S3: 87C928
1280x1024x15b*, 1024x768x24b, 800x600x24b, 640x480x24b
The '928 is a high-end version of the '805 chipset, intended for ISA as well as EISA and 
local buses, and supporting up to 4 MB of VRAM for true color at high resolutions.

· Texas Instruments: TMS 34010



4096x4096x24b    [the TMS34010 chipset effectively does not limit resolution]
The TMS34010 is a true coprocessed card instead of a fixed-function accelerator.    As it's 
design is not optimized for Windows, it is at its best in CAD applications and similar, 
which can take advatage of its display list processing capabilities.    It provides very good 
Windows performance, but at a very high price point.    Check performance of the specific
model before buying, though    the drivers are developed by individual vendors, and can 
have a trememndous impact on TMS34010 perforomance.

· Texas Instruments: TMS 34020
4096x4096x24b    [the TMS34020 chipset effectively does not limit resolution]
The TMS34020 is a 200 MHz 32-bit implementation of the original 100 MHz 16-bit TMS 
34010.    It can provide outstanding Windows performance (on par with the ATI Ultra Pro), 
but it does so at a very high price point.    The chipset is worth considering mainly if you 
also use your system for CAD.

· Tseng Laboratories: ET4000/W32i
1024x768x24b
The latest 32-bit implementation of the venerable ET4000 is amazingly speedy 
considering its low cost.    Cards such as the Hercules Dynamite are performing on par 
with ATI's Mach32 accelerators at less than half the price.    Highly recommended.

· Video 7: HT216
1280x1024x4b*, 1024x768x8b, 800x600x15b, 640x480x15b
Video 7's first accelerator chipset is an inexpensive design which provides middling 
performance, on par with the Compaq 128084 and the Weitek 5186.

· Western Digital: WD90C31
1280x1024x4b*, 1024x768x8b, 800x600x15b, 640x480x15b
Western Digital's new chipset is used by a number of display adapters, including the 
Paradise Windows Accelerator and the Diamond Speedstar 24x.    While the chipset 
benchmarks moderately well (slotting between ATI's and S3's first- and second-
generation chipsets), it has worse-than-expected real life performance, especially in 
scrolling.    The current drivers are also quite buggy and unreliable.

· Western Digital: WD90C33
1280x1024x8b, 1024x768x15b, 800x600x24b, 640x480x24b
WD's second generation design will be targeted at local bus designs, and will attempt to 
improve performance with more accelerated operations and a 32-bit design (instead of 
the 32-bit/16-bit hybrid design in the WD90C31).

· Weitek: W5186
1024x768x8b, 800x600x8b, 640x480x8b
Weitek's initial foray into accelerator chipsets does not provide stellar performance, 
largely since the accelerated operations are limited to BitBlits and line drawing.    An 16-
bit/8-bit internal design and a lack of support for more than 256 colors don't add to the 
attraction of the W5186 chipset.

· Weitek: W5286
1280x1024x4b*, 1024x768x8b, 800x600x15b, 640x480x24b
The upcoming second-generation Weitek chipset will attempt to correct some of the 
problems of the W5186, using a 32-bit/8-bit internal design, true-color support (albeit 
only at low resolutions) and accelerated color expansion and pattern fills.    It looks 
doubtful, though, that the W5286 would significantly surpass the top first-generation 
accelerators (such as the ATI Ultra and S3 87C911), let alone match the latest 
performers.





System BIOS compatability 93-04-22
A number of different computers have BIOS incompatabilities with Windows 3.1.    The 
following list contains BIOSes with such problems.    Contact you manufacturer for an 
update if you have one of these systems.

Manufacturer Version Problem
ALR MPS Incompatible with Seagate IDE disks
AMI 1987 Floppy access causes reboot
AMI 1989 Intermittent crashes
AMI 1991 Serial port problems for versions prior to 1991-07-07
AST Premium/286 Crashes, keyboard lockups and network errors
Award BIOS <= 3.04 Floppy read errors before version 3.05 
DTK BIOS <= 34 No IDE drive support
DTK BIOS 36 Setup utilities must be disabled
Peak BIOS 1.10 1.30 or newer is required
Phoenix BIOS <= 1987 1988 or newer is required
Quadtel BIOS <= 3.04 3.05 or newer is required
Tandon All Old BIOSes cause keyboard failures
Toshiba T3100/20 BIOS 4.2 is required
Toshiba T3100e BIOS 1.7 is required
Wyse All Setup detects 101 keyboard as 84
Zenith 286 Keyboard problems
Zenith 386/16 BIOS 2.6E or newer is required
Zenith TurboSport BIOS 2.4D or newer is required

The BIOS name and version number (or date) are usually displayed when the system 
boots.    As an alternative, you can use msd.exe, a DOS-based diagnostic utility included 
with Windows 3.1, to determine the BIOS your system is using.    Also, there are several 
diagnostic utilities available in wuarchive's /mirrors/msdos/info directory: sysch233, 
sysid602 and ifp1p155.



Video drivers



Identifying your video card 92-09-28
The first step in finding the correct Windows drivers for your video card is to determine 
the type of card you have.    First, you may have a "brand-name" card; if so, your box 
and/or documentation will ientify the type of card.    Second, you can look at the BIOS 
message (if any) displayed when you boot your system.    Third, you can open up your 
system, and look for identification on the card itself    usually either printed on the card 
itself or on some of the integrated circuits.    

As an alternative, you can use msd.exe, a DOS-based diagnostic utility included with 
Windows 3.1, to determine the manufacturer and type of video card in your system.    
Also, two utilities available from wuarchive, atmem10 and vgautils (in directory 
/mirrors/msdos/vga) may help you identify your video card.

See the following section on locating a video card driver for a listing of possible names to
look for.



Locating a driver
Once you have identified your card, you are ready to begin searching for the right driver. 
First, check whether Windows includes the driver you are searching for (Windows 3.1 
includes generic VGA (640x480x16) and SuperVGA (800x600x16) drivers, as well as 
numerous specific drivers).    Second, look at the diskettes you received in the video card 
package.    These may contain the appropriate driver, saving you from a further search.    

If neither Windows nor the diskettes have the drivers, or they are out of date, you may 
wish to check ftp.cica.indiana.edu for the latest one.    If there are none at cica, you can 
try one of the following:

· Contact your dealer
· Call the video card manufacturer
· Download the latest driver from the manufacturer's BBS
· Download the latest driver from the Microsoft BBS (206-936-6735) 

Note that Windows 3.1 drivers are normally dated after the release date of Windows 3.1 
itself (April 6, 1992).



Video card manufacturers
The following is a partial list of video display hardware vendors who support using 
Windows with their products.    CAUTION:    The numbers listed may not, by the time you 
read this, be up to date!

Ahead Systems 510-623-0961
Appian Technology 206-649-5363
ATI Technologies 416-756-4591
Boca Research 407-241-1601
Diamond Computer 408-730-1100
Everex Systems 510-226-9694
Focus Information 510-657-9451
Headland TechnologyVideo Seven 510-656-0503
Matrox Electronic 514-685-6008
Micro-Labs 312-648-6008
Micron Technology 208-368-2130
National Design 512-343-5054
NEC NEC 512-832-1962
Nth Graphics Nth Graphics 512-832-1962
Number Nine Computer Number Nine 617-862-7502
Orchid Technology Orchid 510-683-0327
Panacea WinSpeed 603-432-5193
Sigma Designs Sigma 510-770-0111
STB Systems STB 214-437-9615
Tecmar Tecmar 216-349-0853
Trident Microsystems Trident 415-691-1016
ViewSonic ViewSonic 213-944-2195

The following vendors do not provide BBS access, but do make updates available on 
CompuServe, in the forum indicated.

Tseng Laboratories ET3000, ET4000 WINADV



Using 256 (or more) colors in Windows
In order to use more than 16 colors in Windows, your display card and its driver must 
first support 256 colors.    Second, your application must know about 256 colors in order 
to take advantage of this feature, as this requires palette switching and some additional 
programming.    Many applications currently on the market only support 16 colors.    

In order to get 256 colors, your video card will need at least 320K (for 640x480), 512K 
(for 800x600) or 768K (for 1024x768) of RAM.    For most video cards, 256-color drivers 
are also much slower than 16-color drivers.    Some video cards support 15-bit (32,768 
colors) or 24-bit (16,777,216 colors) video; these can also be used in Windows given the 
appropriate display driver and sufficient video memory.



Panacea Winspeed
One alternative to the specific manufacturer-supplied drivers is to use Panacea's 
Winspeed drivers.    These drivers often provide a substantial speed improvement over 
vendor-supplied drivers, although some vendors have highly optimized drivers which can
meet or exceed Winspeed's performance.



CGA drivers 92-09-19
Windows 3.1 does not include CGA drivers, as the recommended minimum for running 
Windows 3.1 is EGA.    If you need to run Windows on a CGA system, you can download 
the CGA drivers from the Microsoft BBS (206-936-6735).



Printer drivers
The following is a partial list of printer manufacturers who support using Windows with 
their products.    CAUTION:    The numbers listed may not, by the time you read this, be up
to date!

Canon Canon 516-488-6528
Lexmark IBM laser printers 606-232-5653
NEC NEC 508-635-6328
Okidata Okidata 800-654-3282
Panasonic Panasonic, Roland 201-863-7487

The following vendors do not provide BBS access, but do make updates available on 
CompuServe, in the forum indicated.

DEC DEC DECPCI
Varityper Varityper Desktop Publishing



Eliminating the Ctrl-D in PostScript output 92-10-31
To prevent Windows from placing a Ctrl-D (printer reset) at the beginning of your 
PostScript output files, specify 

CtrlD=0
in the [ModelName,Port] section of your win.ini file.

Note that this method does not appear to work with the generic PostScript Printer driver.



EPS graphics print in portrait even on landscape pages 92-12-30
If EPS (Encapsulated PostScript) graphics won't print correctly in landscape mode, try 
adding the following line to the [Model,Port] section of your win.ini file:

LandscapeOrient=270



Hewlett-Packard DeskJet printing problems 92-12-16
If you are getting incomplete pages printed on your DeskJet, make sure that there is the 
the entry

PrtResFac=0
in the [ModelName,Port] section for the DeskJet in your win.ini file.

Note that only the drivers supplied by Hewlett-Packard support HP scalable fonts and/or 
color printing, and these do not currently support TrueType fonts.



PostScript printer uses incorrect fonts 92-08-10
If you have a PostScript printer installed, and your documents print with the incorrect 
font whenever you select something out of the ordinary (for example, WingDings or one 
of the Lucida fonts), your printer driver is likely configured incorrectly.    

In Control Panel's printer setup, click Setup..., then Options..., and finally Advanced....    
Now make sure you have the Use Printer Fonts for all True Type Fonts checkbox cleared.   
If you have this box checked, Windows will attempt to match each of your TrueType fonts 
to the "nearest" PostScript font, not always very successfully.

Alternately you may choose to purchase Adobe Type Manager, and use Type 1 PostScript 
fonts instead of TrueType fonts to avoid the problem.



Selecting a PostScript printer driver 92-10-31
If your PostScript printer model is not listed in the available printers listing, you should 
not choose the generic PostScript printer.    Microsoft advises that "if you select PostScript
Printer, you may encounter problems when printing".    Instead, you may wish to try 
Apple LaserWriter as your first possibility.



Using an Apple Imagewriter or Imagewriter II with Windows 93-06-19
the Apple Imagewriter and Imagewriter II are compatible with the C-Itoh 8510 printer, 
whose driver is included with Windows 3.1.    You will alse need to use a null modem with 
the serial cable connection from your PC to the printer, and set your serial port to 
9600/8N1.



Math coprocessors and WIN87EM.DLL
Windows 3.x itself does not take advantage of a math coprocessor.    Windows 
applications, on the other hand, may or may not, depending on the application: for 
example, Excel will, while Word for Windows won't.    In general, an 80x87 chip gives the 
greates speedup for trigonometric/log type of calculations, and does not significantly 
improve graphics speed in most cases.

The WIN87EM.DLL is a dynamic link library which provides floating-point emulation for 
Windows applications.    Any application which is capable of using an 80x87 will need this 
library on a machine without an 80x87.



Multimedia



AdLib cards and .wav files 92-09-14
The standard AdLib driver supplied with Windows 3.1 is a MIDI-only driver and is not 
capable of playing .wav files.    You can add this capability, however, by installing the 
driver contained in adlibw.zip, available at ftp.cica.indiana.edu  and other sites.



Using MIDI cards with Windows 3.1 92-12-20
if your sound card plays MIDI files (such as canyon.mid), but none of the selections 
under Control Panel's Sound icon are available, your card/driver does not support wave 
files.    You will need either to add a wave driver for your card (if available    contact your 
sound card manufacturer) or to get a card which supports wave drivers.



SoundBlaster Pro and Windows 3.1 93-02-25
One of the most common symptoms of SoundBlaster Pro problems in Windows 3.1 is a 
complete hang of the system on exit from Windows.    You need to use the SoundBlaster 
Pro drivers, not the SoundBlaster 1.5 drivers included with Windows 3.1.    The drivers 
shipped with SB Pro may be out of date, like those on Microsoft's BBS and on 
CompuServe (this may, however, have changed by the time you read this).    In any case,
ftp.cica.indiana.edu has the set of updated drivers available as sounds/sbpw31.zip.    You 
can also get them from Creative Labs' BBS at (408) 428-6660.

Note that if you tell the driver to expect an IRQ other than the one the SoundBlaster Pro 
actually uses, Windows will complete the driver installation.    When you than try to play a
.WAV file, Windows will not recognize any device capable of playing it.                                         



Using the PC's built-in speaker 92-09-14
Windows 3.1 does not contain a driver for playing sounds over the PC's built-in speaker, 
as the speaker is not quite standardized and not all machines would work as intended.    
If you would like to try, however, you should get a copy of the speaker driver, contained 
in the self-extracting archive speaker.exe, available at Microsoft's BBS, 
ftp.cica.indiana.edu  and other sites.



System resources
Free system resources are things such as window handles and global memory block 
handles (handle is a Windows programming term, but it is basically an identifier for a 
window or any other global item.    Each window (dialog, icon, memory block, or 
whatever) requires a handle.

Windows 3.0 has a limit of 64K of resources (32,768 handles), and Windows 3.1 has a 
limit of 128K of resources (65,536 handles).    Windows NT does not have a global 
resource limit.

You can't increase system resources by just adding more memory; the only real solution 
is to close some applications if you are running low.    Windows 3.0 Program Manager was
a resource hog, but the 3.1 version is much better.    

Some poorly-written applications will also not release all the resources they have 
grabbed when they exit.    You can check for this by checking the Free System Resources 
figure, starting up the application, working in it for some time, and then exiting.    If the 
Free System Resources figure is not the same as before you started, your application is 
not properly freeing its resources and it's time for you to call the vendor and complain!



Networking



Compatible Networks 93-01-20
The following networks have either been tested by Microsoft, or reported by Usenet users
to be functional with Windows 3.x:

Network earliest version
3Com 3 Plus 1.0
3Com 3+Open 1.0
Banyan Vines 4.0
BW NFS ?.?
DEC PathWorks 4.0
Frontier Tech Super-TCP 1.0 [Windows-based TCP/IP, SLIP and NFS]
FTP NFS ?.? [Windows-based telnet application]
IBM PC LAN 1.1 [except server]
LAN Manager 1.0
LAN Server 1.0
LANtastic 4.0
Novell Netware 2.15 [shell & utilities must be version 3.01]
Sun PC-NFS 3.5 [must use interrupt 3 instead of 5]
Wollongong NFS 2.0 [Windows-based telnet, FTP; include SLIP]

Note that many NFS packages have difficulty with Windows for Workgroups due to a bug 
in WfW FindNext implementation; check with the vendor to determine whether their NFS 
implementation has a workaround available.



Windows for Workgroups



Accessing Windows for Workgroups drives prior to starting Windows 92-08-25
Unless you read the documentation very thoroughly, you will get the impression that you
cannot access drives shared using Windows for Workgroups (or Windows NT) until you 
have started Windows for Workgroups on your own machine.    However, there is a way of
accessing the network (as a client only, not as a server) even from the DOS level.

To access the network resources, simply enter the command 

net logon /yes

at the DOS prompt.    Omitting the /yes option will still work, but will ask you whether you
are really sure you want to do this.    To disconnect the network, enter

net stop /yes

Note that this will use up 100K of your maximum 640K of DOS memory.



Usin NetBIOS from MS-DOS 94-01-20
You can start NetBIOS (including the NETBEUI protocol) by entering the following 
commands before starting Windows:

NET START NETBIND
NET START NETBEUI

You will then have access to NetBIOS even for MS-DOS applications without using 
Windows for Workgroups.



Sharing a CD-ROM drive with Windows for Workgroups 92-08-20
To share a CD-ROM drive with Windows for Workgroups, you must first use MSCDEX 
(Microsoft CD-ROM Extensions), v. 2.21 or later.    If you do not have a more recent 
version, 2.21 is included on your WfWG distribution disks.

In additition, you will need to specify the /s (share) option on the MSCDEX commandline 
in roder to allow sharing of the drive.

Finally, depending on how a workstation uses the shared CD-ROM drive, it may or may 
not need the MSCDEX installed on that station (typically, using the CD-ROM strictly for 
file access will not require the use of MSCDEX).    If you do install MSCDEX on 
workstations, do not specify the /s switch.



Windows for Workgroups with TCP/IP
Microsoft does not officially support using Windows for Workgroups with TCP/IP.    
However, it's possible to use your existing TCP/IP protocol with a shared NDIS protocol 
stack.    This will allow you to access NFS and TCP/IP (telnet and ftp) as usual, but with full
Windows for Workgroups functionality available as well.    Unfortunately you will generally
lose the Windows-specific capabilities of your NFS software (such as mounting NFS drives
from File Manager).

See the following sections for examples of how to set up Windows for Workgroups with a 
TCP/IP and NFS-based network.



DEC Pathworks with NDIS 94-01-20
The following example has been tested and is known to work with Pathworks.    Note that 
this example does not include the usual config.sys options such as device=himem.sys; 
you can add these as usual.

· config.sys
DEVICE=c:\win\protman.dos /i:c:\win
DEVICE=c:\win\depca.dos
DEVICE=c:\decnet\dllndis.exe
DEVICE=c:\win\workgrp.sys

· autoexec.bat
C:\win\net start
c:\decnet\sch /H
c:\decnet\dnneth.exe /LANA:1 /rem:2
c:\decnet\lat

· protocol.ini
 [network.setup]
version=0x3100
netcard=ms$ewtrb,1,MS$EWTRB
transport=ms$netbeui,MS$NETBEUI
lana0=ms$ewtrb,1,ms$netbeui
lana1=ms$ewtrb,1,datalink

[protman]
DriverName=PROTMAN$
PRIORITY=MS$NETBEUI

[MS$EWTRB]
DriverName=DEPCA$
RamAddress=0xD000
MaxMulticast=8
MaxTransmits=16

[MS$NETBEUI]
DriverName=netbeui$
SESSIONS=10
NCBS=32
BINDINGS=MS$EWTRB
LANABASE=0

[DATALINK]
DriverName=dll$mac
Bindings=ms$ewtrb
LG_Buffers=16
SM_Buffers=6
Outstanding=32
Heuristics=0



FTP TCP/IP: general 93-01-20
With FTP's TCP/IP, you will need to set up Windows for Workgroups to use the NDIS stack 
(see the Wollongong section for a sample protocol.ini); your TCP/IP can be set up as 
usual, using the NDIS protocol stack.    In addition, you will need to get a copy of the file 
wfwftp.386 from FTP; this file corrects the FindNext problem with Windows for 
Workgroups.    Copy this file to your system directory, and add the following line to the 
[386Enh] section of your system.ini file:

device=wfwftp.386

Thanks to Sue Youshock Pruyn and Larry Backman at FTP Software.



FTP TCP/IP: NDIS setup 93-04-30
The following example has been tested and is known to work with PC/TCP.    Note that this
example does not include the usual config.sys options such as device=himem.sys; you 
can add these as usual.

Thanks to Sue Youshock Pruyn at FTP Software.

· config.sys
device=c:\usr\windows\protman.dos /i:c:\usr\windows
device=c:\usr\windows\workgrp.sys
device=c:\usr\windows\enlkii.dos
device=c:\pctcp\dis_pkt.gup

· autoexec.bat
REM Note that the Microsoft net start command is used instead 
REM of the PC/TCP netbind.exe command.    

c:\usr\windows\net start    
c:\usr\windows\netbeui
c:\pctcp\ethdrv

· protocol.ini
[network.setup]                      
version=0x3100
netcard=ms$elnkii,1,MS$ELNKII
transport=ms$netbeui,MS$NETBEUI
lana0=ms$elnkii,1,ms$netbeui

[protman]
DriverName=PROTMAN$
PRIORITY=MS$NETBEUI

[MS$ELNKII]
DriverName=ELNKII$
INTERRUPT=3
IOADDRESS=0x300
MAXTRANSMITS=12
TRANSCEIVER=onboard

[MS$NETBEUI]
DriverName=netbeui$
SESSIONS=10
NCBS=32
BINDINGS=MS$ELNKII
LANABASE=0

[PKTDRV]
DRIVERNAME=PKTDRV$
BINDINGS=MS$ELNKII
INTVEC=0X65



FTP TCP/IP: generic DOS kernel setup 93-04-30
The following example has been tested and is known to work with PC/TCP.    Note that this
example does not include the usual config.sys options such as device=himem.sys; you 
can add these as usual.

Thanks to Sue Youshock Pruyn at FTP Software and Juha Petäjä 
<Juha.Petaja@ntc.nokia.com>.

· config.sys
device=c:\usr\windows\protman.dos /i:c:\usr\windows
device=c:\usr\windows\workgrp.sys
device=c:\usr\windows\elnk3.dos
device=c:\usr\windows\msipx.sys
device=c:\pctcp\dis_pkt.gup

· autoexec.bat
REM Note that the Microsoft net start command is used instead 
REM of the PC/TCP netbind.exe command.    
set pctcp=c:\pctcp\pctcp.ini
c:\usr\windows\net start
c:\usr\windows\msipx
c:\usr\windows\netx
c:\pctcp\ethdrv -t 8

· protocol.ini
[network.setup]                      
version=0x3100
netcard=ms$elnkii,1,MS$ELNKII
transport=ms$netbeui,MS$NETBEUI
lana0=ms$elnkii,1,ms$netbeui

[protman]
DriverName=PROTMAN$
PRIORITY=MS$NETBEUI

[MS$ELNKII]
DriverName=ELNKII$
INTERRUPT=3
IOADDRESS=0x300
MAXTRANSMITS=12
TRANSCEIVER=onboard

[MS$NETBEUI]
DriverName=netbeui$
SESSIONS=10
NCBS=32
BINDINGS=MS$ELNKII
LANABASE=0

[PKTDRV]
DRIVERNAME=PKTDRV$
BINDINGS=MS$ELNKII
INTVEC=0X65



SunSelect PC-NFS 94-03-19
The following example has been tested and is known to work with SunSoft PC-NFS 5.0 
and Windows for Workgroups 3.11.    Note that this example does not include the usual 
config.sys options such as device=himem.sys; you can add these as usual.

Thanks to Farid Rahmi for this information.

· PC-NFS 5.0 or newer is required (5.0b is preferred)
· A patch for multiprotocol NDIS is required (NFS-NDIS.SYS). It is available from    
SunSelect (Compuserve) or by ftp from ftp.york.ac.uk (/pub/pc-nfs)
· 32-bit File Access should be disabled. Typically, an Invalid COMMAND.COM message 
will appear upon exiting Windows for Workgroups if it is enabled.
· Western Digital/SMC cards (especially WD/SMC8013 series) might not work with a 
multiprotocol setup, even with the patch mentioned above. SunSelect and SMC are known to
be working on resolving this problem.

· config.sys
device=C:\usr\windows\ifshelp.sys

· autoexec.bat
C:\usr\windows\net start

SET TZ=WET0WDT
SET NFSDRIVE=C
SET NFSPATH=C:\usr\nfs
SET TN_DIR=C:\usr\nfs\TELNET

C:\usr\nfs\prt *
C:\usr\nfs\net init
C:\usr\nfs\rtm.exe

· c:\usr\windows\protocol.ini    (not c:\usr\nfs\protocol.ini!)
[network.setup]
version=0x3110
netcard=ms$elnk3,1,MS$ELNK3,3
transport=ms$nwlinknb,NWLINK
transport=ms$ndishlp,MS$NDISHLP
transport=ms$netbeui,NETBEUI
transport=nfs-ndis,NFS-NDIS
lana0=ms$elnk3,1,nfs-ndis
lana1=ms$elnk3,1,ms$nwlinknb
lana2=ms$elnk3,1,ms$ndishlp
lana3=ms$elnk3,1,ms$netbeui

[protman]
DriverName=PROTMAN$
PRIORITY=MS$NDISHLP

[NWLINK]
BINDINGS=MS$ELNK3
lanabase=1

[MS$NDISHLP]
DriverName=ndishlp$
BINDINGS=MS$ELNK3



lanabase=2

[NETBEUI]
DriverName=netbeui$
SESSIONS=10
NCBS=12
BINDINGS=MS$ELNK3
LANABASE=2

[NFS-NDIS]
DriverName=NFSLINK$
BINDINGS=MS$ELNK3
LANABASE=0

[MS$ELNK3]
DriverName=ELNK3$

[ELNK3]
Adapters=MS$ELNK3

The following is NOT supported by SunSelect or Microsoft, so you are on your own here. 
Peer to peer services are supposed to be used over some kind of NetBIOS 
implementation, so it is in theory possible to run them over something else that the 
(default) NetBEUI protocol provided with WFWG. The reason to choose another protocol is
that you just might want to access resources that are not on your local subnet and 
therefore you need a routable protocol, typically TCP-IP (or IPX for Novell fans).

You can use NB.EXE, an RFC 1001-2 implementation shipping with PCNFS since 5.0 to get
access to peer services over NetBIOS. The price to pay is performance : transferring files 
using this method between 2 PCs will typically get you between 2 and 20KB/sec,. This is 
a PCNFS issue only, but that's the way it is.

To do the trick, get rid of other protocols in the "Network Setup" utility of WFWG, leaving 
PCNFS as sole protocol.    Note that now that only one protocol is required, the SMC 
problem disappears if you use the NFS-NDIS.SYS provided with the PCNFS 5.0 box. Do not
apply the patch.

Second thing to do is modify AUTOEXEC.BAT like this :

· autoexec.bat
C:\usr\nfs\rtm /heap 64 /segsize 1024
C:\usr\nfs\nb -n 8 -f C:\USR\NFS\NBNAMES

This will start up NetBIOS with 8 sessions at boot time.

Next, create a file to map the NetBIOS names to IP addresses. This will allow you to use 
resources which are not on your local subnet. The file can be anywhere, such as C:\USR\
NFS\NBNAMES in the above example.

141.253.2.35      ANNEX5
141.253.2.214 PPC
141.253.1.138    DELL

The ANNEX5 and PPC machines are on the same subnet and have the same workgroup 
name (ANNEX), while the DELL machine is both on another subnet and has another 



workgroup name (CASTLE).

To connect resources from DELL, you need to type in the name manually as \\DELL\ 
before you can browse its directories and files.

Known Limitations

To start with, modifying the number of sockets (RTM /heap 64) will eat up memory and it 
might not be possible to load this TSR into high memory afterwards. Also, NB.EXE will 
take away another 69KB so you could end up with as little as 400KB of DOS memory to 
start with. Nothing you can do here to have substiantial gains, except lowering the 
number of sockets and  the number of NetBIOS sessions, which is related. This will 
probably limit you number of peer connections.

As said before, the overhead of NB.EXE is enormous and transferring large files (1MB) 
between 2 PC's will easily take 10 minutes where this would be done in seconds using 
NetBEUI. But for small files, chatting, fax (?),etc... speed might be less important than 
connectivity.

Browsing on the local subnet to find other peer machines might not give very good 
results, so on some occasions it might be better to type in a known machine name than 
wait for it to appear in the list box.

Last but not least, do not call SunSelect for this. The installation manual only supports 
coexistence with NetBEUI, not running peer services over NB. Let's hope this changes in 
future releases.



WinQVT/Net 93-04-25
The following example has been tested and is known to work with WinQVT/Net.    Note 
that this example does not include the usual config.sys options such as 
device=himem.sys; you can add these as usual.

· config.sys
device=C:\usr\windows\protman.dos /i:C:\usr\windows
device=C:\usr\windows\workgrp.sys
device=C:\usr\windows\ne2000.dos
device=c:\usr\windows\dis_pkt.dos
device=C:\usr\windows\msipx.sys

· autoexec.bat
pktint
C:\usr\windows\net start
C:\usr\windows\msipx
C:\usr\windows\netx
REM The next line may or may not be necessary
winpkt 0x61 0x62
 

· protocol.ini
[network.setup]
version=0x3100
netcard=ms$ne2clone,1,MS$NE2CLONE
transport=ms$netbeui,MS$NETBEUI
transport=ms$ipx,MS$IPX
lana0=ms$ne2clone,1,ms$ipx
lana1=ms$ne2clone,1,ms$netbeui

[protman]
DriverName=PROTMAN$
PRIORITY=MS$NETBEUI

[MS$NE2CLONE]
DriverName=MS2000$
IOBASE=0x300
INTERRUPT=3

[PKTDRV]
drivername=pktdrv$
bindings=ms$ne2clone
intvec=0x62
chainvec=0x66

[MS$NETBEUI]
DriverName=netbeui$
SESSIONS=10
NCBS=32
BINDINGS=MS$NE2CLONE
LANABASE=1

[MS$IPX]
DriverName=IPX$



MediaType=Novell/Ethernet
BINDINGS=MS$NE2CLONE



Wollongong Pathway Access/NFS 92-12-30
The following example has been tested and is known to work with Wollongong's Access 
TCP/IP and NFS product, and SMC' 8013EP network card.    If you are using BW, Sun, FTP 
or some other vendor's software, you will likely need to modify some of the driver names 
and options, and you will definitely need to adapt the network card selection and 
configuration to match yours.    Note that this example does not include the usual 
config.sys options such as device=himem.sys; you can add these as usual.

Thanks to Ron Olsthoorn at Wollongong Canada.

· config.sys
stacks = 9,256
device = c:\usr\windows\protman.dos /i:c:\usr\windows
device = c:\usr\windows\workgrp.sys
device = c:\usr\windows\smcmac.dos

· autoexec.bat
rem The following line configures Pathway Access to interrupt 65
pwconfig -n:65
c:\usr\pathway\ndis -d:3 -i:A
c:\usr\windows\net start
c:\usr\pathway\pwtcp
c:\usr\pathway\nfs
c:\usr\pathway\mount u:    \\servername\\/u/joeuser

· protocol.ini
[network.setup]
version=0x3100
netcard=ms$w13ep,1,MS$W13EP
transport=ms$netbeui,MS$NETBEUI
lana0=ms$w13ep,1,ms$netbeui

[protman]
DriverName=PROTMAN$
Priority=MS$NETBEUI

[MS$W13EP]
DriverName=SMCMAC$
IRQ=10
RAMAddress=0xC800
IOBase=0x240
ReceiveBufSize=1024

[MS$NETBEUI]
DriverName=netbeui$
Sessions=10
NCBS=32
Bindings=MS$W13EP
LANAbase=0



Novell's NWPOPUP utility won't initialize 92-12-30
If you are running in 386 Enhanced mode, and the version of nwpopup.exe is dated 
earlier than 10 March, 1992, nwpopup.exe will not initialize properly under Windows 
3.1. 

You may also try placing the following line in the [386Enh] section of your system.ini 
file:

TimerCriticalSection=10000

This increases the amount of time (milliseconds) before the critical section is timed out.



WINSOCK.DLL-based TCP/IP networking 93-11-16
Winsock.dll is a vendor-specific library that provides a standardized interface for 
accessing that vendors proprietary TCP/IP network transport layer.    Generally you should
contact your TCP/IP software vendor to obtain the correct version of winsock.dl.

There are, however, two shareware versions of winsock.dll available, both of which 
work with the freely available packet driver.

Trumpet Winsock
This package was written by Peter Tattam, and works with ODI and NDIS drivers as 
well as the Clarkson packet drivers.    It is available via ftp as:

ftp.utas.edu.au:/pc/trumpet/winsock

VxDTCP
This package was written by Jagane Sundar, and thanks to its VxD-based 
implementation, is very fst.    It also supports ODI, NDIS and packet drivers.    It is 
available via ftp as:

biochemistry.bioc.cwru.edu:/pub/wintcp



Integrating with Unix e-mail 94-01-24
In general, Windows-nbase email packages will not talk to Unix hosts over the network 
(unless you're using Microsoft's LAN Manager).    If you wish to use Windows-based email 
over a TCP/IP network, you need an SMTP-compatible email package such as Mail-It (from
Unipalm Ltd., Cambridge, UK; +44 223 42002; tom@unipalm.co.uk ), Cinetic Mail 
Manager (from Cinetic Software, available as shareware), or Wollongongs mail software 
(which is included with their TCP/IP software).



Serial communications



Using COM3 and COM4 92-11-09
This is a generally a problem only in 386 enhanced mode.    To use these ports, you will 
need to tell Windows where they are located.

For Windows 3.1, you should run the MSD.EXE utility while outside Windows. This utility 
will allow you to determine your COM port configuration. After running MSD, use the 
Control Panel's Ports utility to tell Windows how your ports are configured.

For Windows 3.0, the instructions for doing this can be found in the Windows readme file 
sysini2.txt, which should be located in your Windows directory.    In summary, what you 
need to do is tell Windows what memory addresses and interrupts (IRQs) your COM3 and 
COM4 ports use.    This should work, but is not guaranteed to: COM3 and Com4 are not 
standardized, and this is one of the most difficult things to get working with Windows.    If 
possible, move your devices to COM1 or COM2.    

If the port still does not work after specifying the correct IRQ and memory address for the
port, there is another possibile solution: Assuming the ports work OK from plain DOS, try 
setting up COM3.OS2 (or COM4.OS2) instead of the usual COM3 or COM4.    The Windows 
3.0 manual says this is just for OS/2 machines, but it seems to work for many clones.

Also note that due to interrupt conflicts, machines without an EISA or Microchannel bus 
are generally not able to use both COM1 and COM3, or COM2 and COM4 simultaneously.

Finally, some video accelerator cards, such as the ATI Vantage and Ultra series, and the 
S3 89C911-based cards, use the address normally assigned to COM4, preventing you 
from using this port number.



Using a high-performance 16550 serial port 92-09-15
You can use a 16550-based serial card, or upgrade your serial card to use a 16550 chip 
instead of an 8250 or 16450 (get the 16550AFN if you're buying a chip only) to improve 
Windows serial communication performance.    This is most noticeable at 9600+ baud 
rates using advanced protocols such as Zmodem.

If you use a Windows-base communications package, the 16550 is automatically 
enabled.    You can disable it, however, by setting

COMxFIFO=off
in the [386Enh] section of your system.ini file, where x is your serial port number (1 to 
4).



DOS boxes and 16550 serial ports 92-09-28
For DOS-based applications, the use of the 16550 serial port chip (and its built-in FIFO 
buffers) is not enabled by default.    What you need to do is set

COMxBuff=off
in the [386Enh] section of your system.ini file, where x is your serial port number (1 to 
4).    This will disable Windows' buffering of that serial port, and allow the DOS app to 
access it directly.    This is not recommended for use with Windows-based communication
packages!

Another alternative is to use chcomb.386 (replace the device=*combuff line in the 
system.ini file with device=chcomb.386), a shareware device driver which allows you to
use a 16550 for both WIndows and DOS applications.



SmartDrive and 16550 high-speed transfers 92-09-27
If you use SmartDrive with Windows 3.1, disk writes are cached by default.    While this 
is generally a good idea, this causes a problem with high-speed downloads, since 
SmartDrive turns off all interrupts when it is performing the delayed disk write.    Since 
the interrupts are turned off, you may lose a packet whenever the disk light goes on!    

The easiest workaround is to disable write caching for your download drive.



Disk drives and virtual memory



Virtual memory and swapfiles 92-09-19
The type of swapfile you select for running in 386 Enhanced mode can have a significant 
impact on your performance within Windows.    

If you have 12 MB or more of memory, you should likely disable swapping completely; 
this provides substantially better performance than either permanent or temporary 
swapfiles.    You may also be able to do this with 8 MB, depending on the size of your disk 
cache and the number of applications (especially DOS applications) you run 
simultaneously.

If you determine that you do need a swapfile, you should usually use a permanent one.    
Permanent swapfiles allow Windows to start up much faster than temporary ones, which 
must be recreated every time you start Windows.    Permanent swapfiles, however, 
require contiguous (unfragmented) disk space; you may need to compress your disk, 
using a tool such as Norton SpeedDisk or PC Tools first.



Maximum swapfile size 92-09-28
Windows 3.1 determines your virtual memory limit by rounding the amount of RAM on 
your system to the nearest 4 MB, multiplying by 4, and then subtracting the amount of 
the system RAM from the total.    This is then the maximum amount of virtual memory 
(swapfile size) you can use, provided you have sufficient unfragmented hard disk space 
(see previous section).

The multiplier of 4 is a default that can be changed by using a 

PageOverCommit= 

setting in the [386Enh] section of the system.ini file.    The multiplier can be from 1 to 
20.



Windows 3.x and Stacker 92-11-09
Stacker 2.0 works well with Windows 3.0 and 3.1.    You should, however, follow the 
guidelines below for using Stacker with Windows:

· Never place a permanent swapfile on a stacked disk.
· Never place a temporary swapfile on a stacked disk.
· Never use SmartDrive to cache the stacked volume
· Do use SmartDrive to cache the unstacked volume containing the stacked volume
· Place SmartDrive before Stacker in your autoexec.bat

To enhance your memory usage, you may wish to stack your RAMdrive to provide 
additional room for temporary files (such as the Print Manager's spool files).

Note: Beware that although Stacker will assume that it can compress your data to 
provide 2x the physical storage capacity, it cannot guarantee that, and placing 
your temporary files on a stacked drive (whether a disk drive or a RAMdrive) may 
cause the stacked drive to run out of room unexpectedly if the compression ratio 
does not reach 2x (you may wish to read up on this in your Stacker 
documentation).    If this happens, Windows will experience a catastrophic disk 
error    and I think we can all agree that that's not a pleasant experience!



SCSI controllers
If you have a bus-mastering SCSI adapter such as the Adaptec 1542, you should be 
installing the aspi4dos.sys ASPI driver (provided with your controller, or available from 
Adaptec's BBS at (408) 945-7727) as the first device in your config.sys.    Using the ASPI 
driver drops the requirement for SmartDrive descrivbed below.

Normally, in 386 enhanced mode, Windows 3.x supports only ST-506, ESDI and IDE disk 
controllers.    If you have a SCSI controller, you need to load SmartDrive in order to allow 
Windows to recognize your hard disk    and with Windows 3.1, you should use the 
/double_buffer option (see the next section).    Do not disable double buffering in a bus-
mastering SCSI drive unless you're using the ASPI driver described above.

As a third alternative, you may insert the following line in your system.ini file, in the 
[386enh] section:

VirtualHDIRQ=off

Finally, some people report having problems with permanent swapfiles on SCSI drives 
using Windows 3.0.    



SmartDrive double buffering on SCSI drives 92-12-30
When you install WIndows 3.1 on a system with a SCSI drive, it automatically adds the 
line

device=c:\usr\windows\smartdrv.exe /double_buffer

to your config.sys.    To determine whether you actually need double buffering, run 
SmartDrive again from the command line to check on its status.    Typically, the initial 
display would be similar to the one below:

Microsoft SMARTDrive Disk Cache version 4.0
Copyright 1991,1992 Microsoft Corp.

Cache size: 1,048,576 bytes
Cache size while running Windows: 1,048,576 bytes

                        Disk Caching Status
drive      read cache      write cache      buffering
--------------------------------------------
    A:              yes                      no                      no
    B:              yes                      no                      no
    C:              yes                      yes                    -

For help, type "Smartdrv /?".

Here SmartDrive has not yet determined whether double buffering is necessary or not.    
To force SmartDrive to make up its mind, run two simultaneous DOS sessions from within
Windows, and do some disk accessing from each.    After this, SmartDrive should be able 
to determine the need for double buffering.    If the double buffering is not required, the 
display will be similar to the one below:

Microsoft SMARTDrive Disk Cache version 4.0
Copyright 1991,1992 Microsoft Corp.

Cache size: 1,048,576 bytes
Cache size while running Windows: 1,048,576 bytes

                        Disk Caching Status
drive      read cache      write cache      buffering
--------------------------------------------
    A:              yes                      no                      no
    B:              yes                      no                      no
    C:              yes                      yes                    no

For help, type "Smartdrv /?".

If this is the case, you can remove the SmartDrive line from your config.sys. 



Windows 3.x and large hard disks
In rare cases, there are problems with using Windows 3.0 on large hard disks.    Your 
system may be at risk if:

· You are using third-party partitioning software, such as:
· Disk Manager (dmdrv.bin)
· InnerSpace (edvr.sys)
· SpeedStor (sstor.sys or hardrive.sys)
· Vfeatures Deluxe (fixt_drv.sys)

· and you are using SmartDrive (smartdrv.sys) as your disk cache 
· and your hard disk has more than 1023 cylinders

If your hard disk has fewer than 1024 cylinders, you may still be at risk if the first two 
conditions hold true, you are using DOS 3.30 or later, and your hard disk is not 
supported by your BIOS.    To avoid problems, you can either stop using SmartDrive, or 
reformat your disk using the DOS FDISK utility.

There are no problems with large partitions created by the FDISK program included with 
MS-DOS 4.0 and some versions of MS-DOS 3.3.

If you are still having problems, call Microsoft Technical Support at (206) 454-2030.



Troubleshooting
One essential tool for troubleshooting Windows 3.x problems is Microsoft's Windows 
Resource Toolkit.    This combination of a comprehensive reference and some utility tools 
is priced at around $30, and can't be beat for value.    If you are responsible for keeping a
number of Windows systems running, run, don't walk, to the nearest phone and order it 
now!

The toolkit is also freely available in Word for Windows format from ftp.cica.indiana.edu 
(and its mirror sites); while this version is complete, it is large, and will take significant 
time to ftp and download (not to mention print!).



BMP wallpaper won't display correctly
Some of the possible reasons are:

· Your .bmp file is corrupted.    Try reading it into Paintbrush to verify that it is 
readable.

· You are trying to display a bitmap with more colors than your video driver 
supports for example, 256 colors with a 16-color driver, or 16M colors with a 256-
color driver).

· You have insufficient memory to display the bitmap.    A 800x600x16 bitmap 
requires 256K of memory; 1024x768x256 would require 768K!

For 256-to-16 color dithering, you may try using a utility such as PaintShop Pro.



Frequent GPFs (General Protection Faults)
If you are experiencing frequent Windows 3.1 crashes, try starting Windows with the 
command

win /d:xsv

If the GPFs do not appear, add the line
VirtualHDIRQ=off

to the [386Enh] section of your system.ini file.    If the GPFs contine, try
win /d:xs

If the GPFs do not appear, add the line
SystemROMBreakPoint=false

to the [386Enh] section of your system.ini file.    If the GPFs contine, try
win /d:x

If the GPFs do not appear, add the line
EMMExclude=A000-EFFF

to the [386Enh] section of your system.ini file.    While this will get Windows running 
more reliably, you should probably try to narrow down the range of memory that actually
has to be excluded.



File Manager won't format floppies
If you are having trouble formatting floppies from File Manager, try adding one or more 

DEVICE=DRIVER.SYS /D:# /F:#
lines to your config.sys; see your DOS manual for details.



Incorrect system version; reinstall the 386 enhanced version of Windows 93-
01-29

If you get the above message when starting a DOS session, you are experiencing one of 
three potential problems:

· You are using a display driver written for Windows 3.0.    Updating it to a 3.1 
compatible version    should make the problem disappear.

· Your display card selection is not consistent: the display.drv=, 386Grabber= and 
display= selections in your system.ini may not be consistent with each other.    
Use setup to install a fresh set of display drivers from the original distribution 
diskettes.

· Your winoa386.mod driver (in your system directory) may be out of date.    If that
file's date is earlier than win386.exe, use the expand command to get a new 
copy of winoa386.mod from your original Windows diskettes.



Mouse hangs when using communications software
This problem is usually caused by a mouse and a modem being on the same serial port 
pair (either COM1/COM3, or COM2/COM4).    Each pair shares a common interrupt due to 
restrictions of the original IBM PC architecture, and so can not be used simultaneously.

If you are experiencing this problem, you should move either your modem or mouse a 
different serial port.



Object Linking and Embedding (OLE 2.0) does not work 93-12-05
The early versions of the OLE libraries shipped with applications such as CorelDraw! had 
some deficiencies; if you are experiencing difficulties with using OLE, contact your 
application vendor for an OLE update.

Also, you should make sure you are running SHARE if you intend to use OLE 2.0; this is 
required for correct operation.



Parity errors with Windows 3.1 92-09-19
Parity errors are real, and detected reliably by Windows 3.1 (Windows 3.0 ignored them 
for the most part).    Unfortunately most memory test programs do not properly test 32-
bit memory accesses, and thus do not detect all possible memory problems.    
Environments such as Windows 3.1, Windows NT, Unix, Xenix and OS/2 2.0, however, do 
exercise this aspect    and, as a result, report memory problems where the memory 
testers don't catch them.

Below are some of the possible causes for parity errors, in approximate order of 
likelyhood:

· Defective memory module
· 80ns memory where 70ns is required
· Two different speeds of memory modules
· DMA or memory conflicts
· Outdated BIOS
· Defective DMA on the CPU chip

If you're willing to play with fire and gasoline (if, for example, you have 8-bit memory 
with no parity bit), you can disable parity checking by removing or commenting out the 
following line in the [386Enh] section of your system.ini file:

device=*parity

Note that this will disable your parity checking completely and may cause 
unexpected crashes or errors if your memory has parity errors!



Performance deterioration in a 386 Enhanced mode DOS session
The most likely cause of this type of a problem is slow memory.    If your onboard memory
is accessed with basically no wait states, but you have a slower memory expansion card, 
your machine will run slower whenever it is using those higher memory addresses.    This 
will generally happen when you start a DOS session, and often result in 30-50% 
performance reductions using various benchmarks.    The performance is actually also 
reduced within Windows, but it's difficult to notice this due to the lack of a suitable 
benchmark.    The proper cure for this problem is to either upgrade your memory 
expansion card, or to correct whatever problem is causing your machine to access 
extended memory with such poor problem.

DOS application performace is also degraded by using a .PIF file (such as the default .PIF)
with the Monitor Ports option enabled, but to a much smaller degree.    With Monitor 
Ports disabled, DOS session performance should be within 5-10% of the performance 
under bare DOS.



Problems creating a permanent swapfile in Windows 3.0
First of all, you must be running in real mode to be able to create a permanent swapfile.   
Second, You must not have any SUBSTed drives or Windows won't create the swapfile.    
Once the swapfile has been created, you can re-SUBST your drives (although the use of 
SUBST is not recommended in general).    You also can't create a permanent swapfile on a
drive partitioned with third-party software such as SpeedStor.    

If you are installing on a Novell client, you must first disable the receive network 
messages feature (using the network icon in the Control Panel) and reboot.    Once you 
have installed the swapfile, turn messages back on again.



Program Manager claims only 8 KB of free memory 92-12-30
In Windows 3.1, it is possible that Program Manager (and other Windows 3.1 programs) 
will claim that you have only 8 KB memory when you really have 8 MB (that is, it chops 
off the kilobytes part and displays only megabytes    but with "KB" after the figure).

This is caused by a null thousands separator in Control Panel's International settings.    
Set the
separator to either blank or some character to restore correct behaviour.



Using a slow expansion memory board with Windows 92-11-11
If some of your memory is on a slower memory expansion board (such as a standard ISA 
bus memory board, operating at 8 MHz in a 33 MHz system, you may experience serious 
performance deterioration as soon as Windows starts using the slower memory on the 
expansion board.    (For example, see section Performance deterioration in a 386 
Enhanced mode DOS session.)

Unfortunately Windows 3.1 does not allow you to specify memory ranges to be used for a
RAMdisk or disk cache, and thus you can't control which memory gets used first.    In this 
case, the best solution is to use QEMM-386, which allows you to do just that.    Place your 
RAMdisk and disk cache in the slow memory (they will not suffer a significant 
performance drop), and leave the fast memory on the motherboard available for 
Windows' use.



Windows 3.0 refuses to run without a file called WINA20.386
Quoting from the MS-DOS 5.0 readme.txt file:

4.3 WINA20.386 File

Setup installs a read-only file named WINA20.386 in your root directory.    If you move the
WINA20.386 file to a different directory, do the following:

· Add a SWITCHES=/W command to your CONFIG.SYS file.
· Add a DEVICE=[drive:][path]]WINA20.386 command to the [386Enh] section 

of your Windows system.ini file.

Windows 3.1 does not require this file to be present.



Windows 3.1 hangs or crashes during startup
Try starting Windows with the command line 

win /b

If it repeats the same crash or hang, take a look at the file bootlog.txt in your Windows 
directory.    It will have two lines such as 

LoadStart = SYSTEM.DRV
and

LoadSuccess = SYSTEM.DRV
for every driver succesfully loaded; the culprit driver will show a line such as

LoadFail = WIN3-64S.DRV Failure code is 05

If it's a standard Windows driver, try reloading it from diskettes; otherwise, for a third-
party driver, try to locate an updated driver either from cica, your supplier or direct from 
the manufacturer.



Windows 3.1 hangs or waits a long time on exit
Windows 3.1 tries to reset the mouse driver on exit, and some IBM PS/2 models have 
great difficulty with this procedure, timing out only after an extended wait.    In order to 
avoid the problem, add the line

InitPS2MouseAtExit=False

to the [386Enh] section of your system.ini file.



Windows 3.1 Resource Kit won't install
The most common WRK installation problem is an excessively long path.    If you have 
problems, try reducing the length of your path for the installation, and you should be OK.



Windows 3.x waits a long time on startup
One possible reason is the use of a serial mouse on COM2 instead of COM1.    If you have 
a serial mouse, Windows will first attempt to find it (with great persistence) on COM1, 
before it looks on COM2.    If your mouse is on COM2, move it to COM1.

Using a temporary swapfile instead of a permanent one for 386 enhanced mode also 
slows down the startup process, but not to even nearly the same extent as the serial 
mouse problem.

With Windows 3.0, it has also been reported that adding too many fonts through the 
Control Panel will drastically slow down the startup, and with both Windows 3.0 and 3.1, 
a very large number of ATM fonts will also slow down the startup process.



Windows for Workgroups 3.11 claims ports are in use 94-02-25
In some cases upgrading Windows for Workgroups 3.11 over Windows 3.1 does not 
update your system.ini file correctly.    If you are getting this error when attempting to 
print or use a serial port, check to see that the following lines are in the [386Enh] section
of your system.ini, and add them if necessary:

device=serial.386
device=vcomm.386
device=lpt.386



Windows and DOS



Configuring DOS sessions



DOS in a window
You can run a both the standard DOS command interpreter (command.com) and other 
DOS applications from within Windows.    In Real mode, you are limited to a single 
session.    In Standard mode, you can have multiple sessions, but they must still run full-
screen.    In 386 Enhanced mode, you can have multiple sessions, and they can run in a 
window.

You can control the starting up in a window vs. full-screen by setting up a .pif file for the 
program (command.com    or any other DOS program).    You canalso switch the state by 
pressing Alt+Enter.



Lotus 1-2-3 in Windows
Lotus 1-2-3, versions 1.x, 2.x and 3.1 run in all modes, but do not support any of the 
features of the Windows environment.    For all intents and purposes, version 3.0 doesn't 
run under Windows.

If you want to use a spreadsheet in the Windows environment, however, you will be best 
off buying a real Windows spreadsheet such as Excel, WingZ, CACompete! or even 1-2-3 
for Windows.



Reducing the amount of "jerkiness" in DOS window updating
Windows 3.1 updates the DOS windows by default every 50 ms.    To increase the update 
frequency, specify another update interval (such as 20 ms) by adding a line to the 
[386Enh] section of system.ini:

WindowUpdateTime=20

A smaller interval will provide smoother updates but impose a higher load on the system.



Extended memory in DOS sessions
After you run Windows, a utility such as Norton SI will often report that you don't have 
any extended memory.    This is not a bug, but rather a result of the Windows memory 
management system..    Windows requires applications to access extended memory using
one of two mechanisms, known as "XMS" and "DPMI".    These mechanism are 
implemented in himem.sys and emm386.exe.    If you have device=himem.sys in your 
config.sys, the first XMS call (by Windows or SmartDrive, for example) will transfer 
control of the extended memory to himem.sys, and thus make it inaccessible to non-
XMS/non-DPMI applications.



Changing the font size for a DOS window 
All video drivers updated for Windows 3.1 allow on-the-fly font changes; to get the same 
functionality using older 3.0 drivers (in Windows 3.1), add the line

FontChangeEnable=1

to the [NonWindowsApp] section of the system.ini file.    If you experience strange 
cursor behaviour or missing characters, remove the line from your system.ini.    There 
are also alternate Windows 3.0 DOS fonts available at ftp.cica.indiana.edu.



Changing the number of lines inr a DOS window
To use more than 25 lines in a DOS window, add the line

ScreenLines=50

to the [NonWindowsApp] section of the system.ini file.    If your screen doesn't quite fit 
50 lines in a DOS window with a decent font, you may want to follow this procedure:

· Use a VGA font editor (such as VFONT) to create a DOS VGA screen font with 
more than 25 lines.

· Start up a DOS session (in a window)
· In that window, change the font (and thus screen size) to your new font/size.    

Voila!



Mouse in a DOS window
In Windows 3.0, if you are running a DOS application in a window, Windows will retain 
control of the mouse for cutting and pasting.    You can use a mouse in a full-screen DOS 
session if you install a mouse driver by running mouse.com (either before starting 
Windows, or inside the DOS session), or by including

device=mouse.sys

in your config.sys file. If you're running WordPerfect 5.1 inside Windows, WordPerfect 
must be started full-screen in order to detect the mouse.    Once it has started, you can 
use Alt+Enter to run in a window, if you wish.

In Windows 3.1, the mouse will automatically work in a DOS window if you have a video 
driver which has been updated for 3.1.    Old 3.0 drivers do work, but they do not by 
default provide mouse functionality inside DOS windows, although you can force them to 
do so by adding the line 

MouseinDosBox=1

to the [NonWindowsApp] section of the system.ini file.

If you have a Microsoft mouse, you should use the mouse driver version 8.20, included 
on the Windows 3.1 disks, named mouse.co_ and mouse.sy_. Expand these files using 
expand.exe (also included on the disks) before using them.



TSRs in DOS sessions
Some TSR (Terminate and Stay Resident) programs will not work if you install them 
before running Windows.    Some of them will not work if you install them inside a DOS 
session.    Generally the best idea is to avoid TSRs completely unless you absolutely have
to have them.
See also the description of winstart.bat in the Windows *.txt files.



VGA graphics in a windowed DOS session
Windows 3.1 will support VGA graphics in a windows DOS session if you have the correct 
display driver.    True Windows 3.1 display drivers (such as the standard SuperVGA driver)
will do this, but some partial implementations may not.



Troubleshooting DOS applications



Can't run VGA graphics in a window 93-07-15
If you can't run DOS-based VGA graphics programs in a window you are probably seeing 
the message "You cannot run this application while another high-resolution application is 
running full screen".    The "other" application is, in fact, Windows itself.    

In this case, you need to reduce the resolution of your Windows desktop (possibly down 
to the basic VGA 640x480x16) in order to free enough video memory to allow the other 
application to run VGA graphics simultaneously with Windows.    You may also have to 
add memory to your video card.                                                              
                                                                                                                                                                
The plain VGA VDD (device=*vddvga) assumes that you have 256K on your display card. 
You can explicitly override this assumption by adding, for example, the line

SVGAMemory=512

to the [386Enh] section of your system.ini.    This trick is known to work only if your 
display driver is using device=*vddvga; contact your video card supplier for a 
workaround for workarounds fpr custom VDD devices.



Corrupted diskettes when copying files in a DOS session
If you are getting corrupted diskettes with a 0xff as every other byte when copying files 
to a floppy within a DOS session, the most likely cause is an expansion board using the 
same memory area also used by Windows for EMM. You should check that you 
EMMExclude all areas used by your cards.
The Video-7 1024 SVGA board needs a more radical measure: you need to change a 
jumper to do all ROM decoding in c000 - c7ff, and change a DIP switch to force 8-bit ROM
access.



High color and true color modes run out of resources 94-01-20
When using high color (16 bits, or 65,536 colors) or true color (24 bits, or 16.7M colors), 
Windows needs 2x-4x as much resources for each of the icons you display.    This conflicts
with Program Manager's liberal use of icons for programs and groups.    Other Windows 
shells are often more frugal with their use of icons.

If you need to use high color or true color, and want to keep using Program Manager, 
reduce the number of groups, and keep no more than 15 icons in each group.



Out of Environment Space
When Windows starts up a DOS session, it by default gives it an environment
of 224 bytes, or the space required to hold your current environment, whichever is larger.
If you need more space, there are two methods of circumventing this.    In order of 
desirability:

·  Use a .pif file for each DOS application you run
In this you can specify the environment size by using the /e:nnn option (see your DOS
manual).    You will need a separate .pif file for each program (although in Windows 
3.1 you can create a _default.pif, which is used by all DOS applications which do not
have their own .pif files).    You can just create a command.pif with a suitable /e:nnn,
and then specify in the win.ini a line such as

[Extensions]
bat=command.pif ^.bat                // for DOS users
ksh=sh.exe ^.ksh                          // for MKS users

With this, you can create batch file icons freely, and still get the options specified in 
command.pif or sh.pif.

· Use a dummy variable
By specifying a dummy variable (such as DUMMY1=xxxxx...)    before starting 
Windows, you can reserve some space in the environment.    Then, as the first thing in
each command.com session, do

set DUMMY1=

to reclaim the space used by DUMMY1 for use by other environment variables.



Protected-mode software
Some protected-mode applications currently on the market still use an older extended 
memory interface called VCPI (Virtual Control Program Interface), which is incompatible 
with Windows' DPMI (DOS Protected Mode Interface).    Microsoft went against an 
established standard in choosing DPMI, but there are valid technical reasons why VCPI 
was not chosen for Windows.

At this point, you have three choices:

· Run your protected-mode software under DOS
This means that you must NOT use Windows or SmartDrive before running your VCPI 
software, and may require you to have two different config.sys files.

· Plead with your software developer
Call up the software vendor and ask them whether they are developing either a 
Windows-based version, or, at the minimum, one which uses DPMI instead of VCPI.    
They should already be working on it anyway, given the momentum and market 
share that Windows 3.x has.

· Buy QEMM/386 or 386Max
Both of these packages provide VCPI.    You'll be able to run your protected-mode 
software as well as Windows 3.0 and 3.1.



DOS shells and extenders



QEMM/386 and DesqView/386
You can use versions 5.0 of QEMM/386 and below with real-mode Windows 3.0 only.    
However, QEMM/386, versions 5.1 and higher, provides XMS services for Windows, thus 
allowing Windows to run in all modes under QEMM/386, plus providing compatability with
VCPI applications. 

Windows will run in Standard (Windows 3.0 and 3.1) and Real (3.0 only) modes as a 
DesqView/386 task.



MKS Toolkit: setting up
There are two possible problems with running Windows from the MKS Toolkit. First, with 
versions up to and including 3.1c of the Toolkit, the use of login.exe precludes the use of 
Windows 3.0 in any but the real mode.    To avoid this, have your machine boot directly 
into the Korn shell or command.com (you may use init.exe if you wish).

Second, somebody at Microsoft had a brain fade, and Windows gets confused if it is 
started with a forward slash path.    Thus, if you simply type "win" in Korn shell, the shell 
invokes Windows with something like

c:/usr/windows/win.com

and Windows doesn't know where to find itself!    To cure this, specify a shell alias for 
Windows: I use

alias -x win='c:\\usr\\windows\\win.com'

Note that the double backslashes are necessary for the Korn shell, even inside the single 
quotes.

The newer versions of MKS Toolkit allow (standard and 386 enhanced mode) Windows to 
run directly from the login: prompt; but they still won't let you run standard/386 
enhanced Windows from the shell (if you used login). An updated version of init.exe is 
available from MKS for users of older versions of the MKS Toolkit.



MKS Toolkit: maximizing DOS session memory
If you run MKS Toolkit by starting up init.exe from config.sys, and then starting the shell 
from /etc/inittab, you will likely find that there isn't much memory available in the DOS 
(shell) sessions you start from inside Windows.

One way to address this is to start up Windows immediately upon booting, avoiding 
loading the shell into the valuable DOS low memory.    There are at least two ways of 
doing this cleanly:

· As the last line in your profile.ksh, add the command

exec c:\\windows\\win.com

(or whatever the path is to your Windows directory).    Using the exec command 
retains the environment you have set up in your profile.ksh and environ.ksh files, 
but overlays the shell memory with Windows, avoiding memory loss.

Since the startup script executes Windows at the end, make sure that you so not run 
sh -L from Windows, as this would attempt to restart Windows.

· Given that command.com    uses much less memory than the shell, you can specify 
(as the last line in /etc/inittab, instead of starting up the shell) the following:

ms;35;respawn;c:/dos/command.com /c c:\etc\init.bat

Then, in /etc/init.bat, specify all your essential environment variables, and as the 
last line start up Windows.    This method wastest a few kilobytes of low memory 
compared to hte first one, but allows you run sh -L without risk.



MS-SH
The basic problem is the MS-SH swap setting.    In Real mode, you will need to use swap 
disk.    In Standard mode, you can also use swap extend, but you will have to specify at 
least 200K of XMS memory in the MS-SH .pif file. Alternatively, if you are using Standard 
or 386 Enhanced mode, you can use swap ems, but again you will need to specify at 
least 200K of EMS memory in your .pif file.    

A bug in the current (as of this writing) version of MS-SH prevents swap extend from 
working in 386 enhanced mode; MS-SH will always crash with a panic error.    With 
Windows 3.1, swap xms works as intended, and is the appropriate setting.



Windows Tips, Tricks and Secrets



General



Automatically opening applications on startup, with predefined window positions
93-04-30

You can load applications automatically in two ways:

· By adding them to the Startup group in Windows 3.1 Program Manager. To run 
start them as icons, check the Run iconized checkbox in the File » Properties 
dialog for the program.

· By specifying them on the load= or run= line in win.ini.    This will load the 
specified applications, respectively, either with their default window sizes, or 
as icons.

If you need specific window sizes or positions, you will need to use another utility, either 
shareware package (such as TopDesk, Layout, Command Post or Aporia) or a commercial 
one (such as Batchworks, Bridge or NewWave).    TopDesk is included in the Windows 
Resource Kit.



Changing or bypassing the startup logo
To bypass the logo, you can start Windows with the command line such as

win :

Be warned, however, that some people have had problems with this.    Also, skipping the 
startup logo does not significantly speed up the Windows startup process.

To change the logo to something else, you need to first create a .RLE file (using a 
graphics utility package), with no more than 16 colours, and not exceeding the VGA 
640x480 screen resolution, and no more than 64K in size. Once you have this file, called, 
say, mylogo.rle, enter the following command in your system subdirectory:

copy win.cnf/B+vgalogo.lgo/B+mylogo.rle/B win.com

If you use CGA or EGA, limit the .RLE file to the appropriate resolution, and replace the 
vgalogo above with cgalogo or egalogo.



Changing the font used for the icon labels
To use 10-point Arial (substitute your own favorite below), add the following two lines to 
your [Desktop] section of your win.ini file:

IconTitleFacename=Arial
IconTitleSize=10

A shareware Control Panel utility, More Control also gives you control over the icon fonts.



Disabling the network warnings on startup 93-08-15
Normally Windows will warn you on startup if it is unable to connect to the network you 
have set up.    You can disable this warning by adding the following line to the [Windows] 
section of your win.ini file:

NetWarn=0



Limiting the size of the temporary swap file
In Windows 3.1, you can add a line such as

MinUserDiskSpace=4096

to the [386Enh] section of the system.ini file to limit the temporary swap file's size.    
The above line doesn't actually set the size of the swap file, but rather limits its growth 
to always retain at least 4096 KB (4 MB) of available disk space for your and your 
applications' own use.



Making Windows 3.x act like 2.x runtime
The Windows 2.x runtime version would start Windows from the DOS prompt, and exit 
back to DOS when you exit the application.

You can do this as follows (the example is for Excel; others are similar):

· Create a new directory called c:\excel (it doesn't have to be distinct; it could 
be your normal Excel directory, as long as it's not the main Windows 3.x 
directory).

· Copy the following to the new directory from the Windows directory:
win.com
win.ini
system.ini

· In the new directory modify the [boot] section of system.ini by changing the 
shell= line to point to the one and only program you want to run.    The original
line should read:

shell=progman.exe

and the modified line should be something like: 

shell=c:\excel\excel.exe

Remember to type the complete fileid of the program to be executed, 
including the .exe suffix.

· To execute the dedicated Windows session just put the new directory ahead of
the normal Windows directory in your path and issue the 'win' command, or 
start Windows with the command 'c:\excel\win'.    What we're doing here is 
making Windows think it's running on a network where the actual executable 
files etc. are on a network server, and only the basic control files (and 
win.com) are on the user's local disk.

Note that this technique isolates any changes in win.ini and system.ini made in the 
dedicated task from any changes made in normal Windows; this may or may not be 
desirable.    If you need to keep the two flavors of Windows in sync you'll have to provide 
an outboard copy function to refresh the files.



Printing PostScript files without a PostScript printer
To print PostScript files on a printer without PostScript, you'll need to get a third-party 
PostScript interpreter.    One such product is GhostScript, available free from the GNU 
project.    The current version, 2.52, can be found by ftp as 
/mirrors/msdos/postscript/gs252win.zip  on wuarchive.



Search path in Windows
In addition to the standard MS-DOS search path, Windows will also search the Windows 
and system directories.    In general, the search order is as follows:

· Current directory on current drive
· Windows directory
· System directory
· MS-DOS search path
· Current directory on network drives



Swapping the Ctrl and CapsLock keys
One method is to use the public domain program CCSwap, written by David 
Michmerhuizen.    You can find this as swap10.zip at your favorite FTP site,

Alternately, you may be able to use a different keyboard driver.    A good one comes with 
the distribution of Kermit for Windows, available either from cica or from the official 
Kermit archive at watsun.cc.columbia.edu.



Minimizing Windows disk space usage 93-10-15
Although Windows 3.1 takes a fairly large amount of disk space when installed, it is 
possible to pare it down a couple of megabytes in order to run on a system (such as a 
notebook) with limited hard disk space.    You will need to do a normal install first, and 
then delete all but the bare essentials from the Windows directory.

The following sample setup is for a 386-based notebook with a VGA display; thanks to 
Simon Tooke <simon@sco.com> for coming up with this.    Note that the setup does not 
include File Manager or Print Manager; add them if you expect to need them.

Filename Size
control.exe 15872
control.ini 4124
dosapp.ini 42
main.grp 1516
progman.exe 115312
progman.ini 101
reg.dat 352
system.ini 1759
system/citoh.drv 4720
system/comm.drv 9280
system/commdlg.dll 89248
system/control.inf 20993
system/ddeml.dll 36864
system/dosapp.fon 36656
system/gdi.exe 220800
system/keyboard.drv 7568
system/krnl386.exe 75490
system/lmouse.dll 45792
system/lmouse.drv 14352
system/lvmd.386 9705
system/lzexpand.dll 9936
system/main.cpl 148560
system/shell.dll 41600
system/sound.drv 3440
system/system.drv 2304
system/tty.drv 30496
system/unidrv.dll 119296
system/user.exe 264016
system/ver.dll 9008
system/vga.3gr 16384
system/vga.drv 73200
system/vgafix.fon 5360
system/vgaoem.fon 5168
system/vgasys.fon 7280
system/win386.exe 544789
system/winoa386.mod 49248
win.com 44170
win.ini 3445
Total 2088246



VT100 emulation for Windows 93-07-15
There are two free options available for VT100 emulation: Windows Terminal and 
WinKermit.    Each has its downfalls, and your other option is a commercial terminal 
emulator, a number of which are described in the Available WIndows Applications section
of this document.

If you're looking at VT100 emulation over TCP/IP, you might also consider NCSA 
WinTelnet, which is also free.



Program Manager



Assigning a hotkey to Program Manager 93-06-15
To assign a hotkey to Program Manager itself, add Program Manager to the Startup group
(it will not actually start a second copy), and assign it a hotkey.



Changing the font used for the icon labels 92-09-19
To use 10-point Arial (substitute your own favorite below), add the following two lines to 
your [Desktop] section of your win.ini file:

Icontitlefacename=Arial
Icontitlesize=10

A shareware Control Panel utility, More Control also gives you control over the icon fonts.



Changing the program icon
Choose the item in Program Manager, and then select File Properties. Click on Icon..., 
and then enter the name of the file containing the new icon.    

If the icon file is a .DLL or .EXE containing multiple icons, you can either scroll though the
available icons (in Windows 3.1) or cycle through them by clicking Next Icon (Windows 
3.0).    After selecting the correct icon, click OK, and then OK again.    You can also use 
icons from other programs by the same method: just specify the name of the .exe file 
instead of an .ICO or .DLL file.

The icon that is displayed by the application when it is minimized is controlled by the 
application.    It is not normally possible to change that; however, several workarounds 
exist for changing the icons of running DOS applications.    

· Windows 3.1 will display the selected Program Manager icon for each running 
DOS application.

· In Windows 3.0 you can use the iinject or puticon utility to replace the 
standard DOS icon, which is contained in winoa286.mod and/or 
winoa386.mod.    

· The IconFixer utility monitors your DOS applicationsin Windows 3.0, and 
updates their icons as you minimize them, allowing you to have different icons
for different DOS applications. 

 All three utilities are available from ftp.cica.indiana.edu.



Changing the title of the Program Manager window 92-09-28
In Windows 3.1, you can specify the title of the Program Manager window by adding a 
Program Manager icon to your Startup group.    Windows will not start up a second copy 
of Program Manager, but will use the title you specify in File » Properties for the icon.



Converting documents to PostScript format 93-03-01
There is a very simple way to convert documents of all types to PostScript format: simply
select the PostScript printer driver from the Control Panel, and set the printer connection 
to FILE: .    Then, usign your application, print the file to the PostScript printer, and enter 
the name of the PostScript output file.



Creating your own icons 92-09-28
You can create your own custom icons with either IconDraw (shareware), Icon12 
(shareware), Tamr11 (shareware), SDKPaint (a part of the Windows SDK) or Resource 
Workshop (a part of Borland C++).    Simply draw your icon, and save it as an .ICO file.



Creating your own wallpaper
You can save a .msp file as a .bmp from Windows Paintbrush.    You can convert a .gif 
file to a .bmp using the gif2bmp utility from cica.    wingif will also do a good conversion, 
including dithering 256-color images to 16 colors (rescale before dithering!).    A third, 
and the most flexible, conversion program is PaintShop Pro, which will do color 
conversions (16M, 32K, 256 and 16 colors), many format conversions, scaling and 
clipping.    Both wingif and PaintShop Pro are shareware, and available at 
ftp.cica.indiana.edu.

A JPEG-format file can also be converted to a wallpaper bitmap by first uncompressing it 
with the cjpeg/djpeg utility (free, available at wuarchive.wustl.edu and other sites) to a
.gif, and then using one of the utilities above to convert the .gif to a .bmp.



Previewing PostScript output 93-07-15
To preview PostScript output on Windows, you can use Ghostview and/or Ghostscript, a 
free utility from the GNU project.    The current version can be found on 
ftp.cica.indiana.edu and other archive sites as GSxxxWIN.ZIP where xxx is the version 
number (which changes frequently).



Restricting the Program Manager 93-01-02
If you want to prevent a user from changing the Program Manager configuration, you can
insert a combination of the following lines into the [Restrictions] section of progman.ini:

NoRun=1 Disables the Run command
NoClose=1 Disables the Exit Windows command
NoSaveSettings=1 Disables the Save Settings command
NoFileMenu=1 Removes the File menu
EditLevel=(see below) Sets the edit restriction level

The following are the EditLevel restrictions:
1 Disables creating,deleting and renaming groups
2 As 1, plus disables creation/deletion of program items
3 As 2, plus disables changing program item command lines
4 As 3, plus disables changing program information

If you boot directly into Windows (and restart it immediately on exit), don't allow any 
unrestricted DOS sessions from Program Manager, and make progman.ini read-only, 
you can accomplish a reasonable level of protection from users changing their 
configuration.



Saving Program Manager settings without exiting Windows 93-03-01
In Windows 3.0, the trick is to try to select File » Exit with a DOS sessionactive; 
Windows will save the settings, and then refuse to exit.    

In Windows 3.1, you can press Alt+Shift+F4 at any time (while you are in Program 
Manager) to save the settings    or hold down the Shift key while you double-click 
Program Manager's close box.



Starting Windows without activating the applications in the Startup group
You can do this by holding down the Shift key when the Windows startup screen appears,
and then releasing it once Program Manager is active.



Starting an application in a different directory
To start up a Windows application in a default directory other than the Windows directory
(or application executable directory), you have a number of choices:

· In Windows 3.1, set the Working Directory under File Properties for the 
application.

· Create a auto-execute macro for that application, which will change your directory
upon startup.

· Specify your application's path in Program Manager as something such as d:\u\
personal\letters\winword.exe.    As long as the application is on your path, it will 
be started as usual, but with the default directory being the one you specified in 
Program Manager.    Note that Program Manager will complain of this when you 
enter the path (and may require you to manually select an icon), but it will work.

· Create a dummy document for your application in the desired directory.    As long 
as you have your application listed under [Extensions] in your win.ini file, 
starting that document from Program Manager (either with File » Run or by 
adding it as an icon to a group) will then start the application with that document 
loaded, and in the correct directory.

.
·  For Word for Windows 2.0, add the line

Doc-Path=pathname
into the [Microsoft Word 2.0] section of your win.ini file.    This will cause Word to 
start up in the specified directory every time.



Using environment variables 93-06-15
Program Manager can use environment variables similar to MS-DOS batch files: for 
example, specifying the program name as %APPS%\my-app.exe will substitute in the 
value of the APPS environment variable.    There is no way, however, of setting the 
environment variables from within Windows; you will need to set them either before 
starting Windows or in winstart.bat (which is described in the Windows 
documentation).



Windows accessories



Cardfile: converting to ASCII text 92-09-27
To convert a cardfile to a text file, use the WinCrd utility, available from 
ftp.cica.indiana.edu.



Clock: Windows 3.1 Clock limitations
The Windows 3.1 clock is limited to one instance (simultaneously running copy) by 
design, as it retains the position and size you last specified for it.    You can, however, run 
any number of Windows 3.0 clocks that you want in 3.1.    As an alternative, you may 
want to take a look at the TimeFrame freeware program from ftp.cica.indiana.edu, which 
places the current time in the title bar of the active window. 



Control Panel: accessing control panels directly 93-06-20
You can access individual control panels directly by creating an icon in Program Manager 
(or equivalent) with, for example, the following commandline:

control main.cpl network

The last parameter should match the spelling of the name of the icon in the usual Control
Panel window.



Help: changing the default window size 93-03-01
To change default size of the WinHelp window, you can change the following lines in the 
[Windows Help] section of your win.ini file:

M_WindowPosition=[0,0,640,480,0]



Help: changing the keyword colors 93-07-15
To change the keyword colors in your Windows help files, you can add some or all of the 
following lines to the [Windows Help] section of your win.ini file:

JumpColor=0 0 128
PopupColor=128 0 128
IFJumpColor=0 0 192
IFPopupColor=192 0 192

The colors are in RGB format; this particular example will set the jump color to dark blue,
and the popup color to dark magenta.    The IF colors are for interfile jumps and/or 
popups.



Notepad: F5 and current time
F5 in Windows 3.0 Notepad inserts only a date and not the time as well    it's a known 
bug.    And it's fixed in Windows 3.1.



Recorder: recording more than 60 seconds of sound
If you want to record, say, three minutes, follow this procedure:    
· Record 60 seconds (Recorder will stop).    
· Immediately record again for 60 seconds. 
· Repeat one more time.    
· Drag the scroll bar thumb all the way to the left
With this procedure, you will be able to record 180 seconds of sound.    Repeat more 
times if you need more than 3 minutes of sound.



Terminal: keypad
Press ScrollLock to toggle the keypad between local and remote mode. The default is 
local mode.



General: Can't open TEMP.WRI (or similar message)
A message similar to this one is likely caused by an invalid definition of the TEMP 
environment variable in your autoexec.bat.    Having a trailing space on the definition 
line can cause various Windows applications to generate invalid temporary filenames 
similar to the one noted.    Correct the problem by making sure there are no trailing 
blanks.



Changing default directories



Bitmaps 93-04-30
You cannot move the bitmaps from the Windows directory unless you use a utility 
program such as BitmapView or PaperBoy.        BitmapView is included in the Windows 
Resource Kit.



Fonts
To move your TrueType fonts to a different directory, follow the procedure outlined below.

The trick is in knowing how Windows finds your truetype fonts.    If you have ever done 
any digging around in your system directory, you may have noticed that there is a little 
(1300 byte) .fot file for each of your .ttf files that you have installed.    

Now, unlike an ATM font which exists in two files, one containing the screen definition, 
and the other containing the printer definition, a TrueType font has all the information for 
both in one file (the .ttf), so why does the other exist?    So far, the exact reason remains 
a mystery, but the .fot file does contain the full path to the corresponding .ttf file    and 
the win.ini's [Fonts]    section points to the .fot file.

Here are step-by-step instructions for moving the TrueType (and other) fonts:

· First, move your .ttf files to where you want then to reside permanently    
preferably someplace outside the windows directory tree for ease of upgrading.

· If these TrueType fonts were previously installed, you will have to create new .fot 
files, so go into the ControlPanel and remove, but don't delete, those TrueType 
fonts that you had installed (make sure to remove only the TrueType fonts!).

· Next, add your TrueType fonts through the Control Panel.    Now, before you select 
any, be sure to uncheck the Copy Fonts to Windows Directory    box.    If you leave 
this checked, the .fot files will point to the newly copied .ttf files that got 
relocated into your system directory.    Highlight the fonts you want, and click OK.

· Now just move all the .fot files also to another location and then modify the 
[Fonts] section of your win.ini file to point to where your .fot files are located.

Thanks to Mike Bendtsen <msbendts @ mtu.edu>.



Icons
Yoy may place your fonts in any directory you wish, as long as you update your Program 
Manager's File » Properties dialogs to point to the correct location.



Fonts



Accessing foreign/accented characters 93-03-01
There are two basic methods for accessing foreign and/or accented characters in 
Windows.    The first is to use the CharMap utility (or equivalent in your word processor: 
Insert » Symbol in Word, Font » WP Characters in WordPerfect) to insert the 
appropriate characters into your text.    

If you use a lot if accented characters, though, you may want to select the English 
(International) keyboard in the Control Panel.    This makes the backquote, forward quote 
etc. into "dead" keys: pressing "~" followed by "n" would generate the ñ character.    To 
get the original meaning of the dead keys, you need to press that key and then follow it 
with a space.



Converting font formats
There are at least two packages available to convert between Type 1 (ATM) and TrueType 
formats: AllType ($79) and FontMonger ($99).    AllType, however, imposes its own 
copyright on any converted fonts, as well as doing a generally unsatisfactory job of 
coverting from ATM to TrueType.    

Macintosh TrueType fonts are also directly compatable with Windows (you only need to 
strip off the resource fork from the Mac file).



Converting Macintosh Type 1 (ATM) fonts to Windows
Thanks for this procedure to Norman Walsh, the maintainer of the comp.fonts FAQ.

Converting Macintosh Type1 fonts into PC Type1 fonts can be done using purely 
free/shareware tools.    I've outlined the procedure below.    Make sure you read
the "readme" files that accompany many fonts.    Some font authors specifically deny 
permission to do cross-platform conversions.

The tools you need:
xbin xbin23.zip in /pub/msdos/mac on oak.oakland.edu (or other mirrors)
unsit unsit30.zip in /pub/msdos/mac on oak.oakland.edu
uncpt ext-pc.zip in /pub/pc/win3/util on ftp.cica.indiana.edu
refont refont11.zip in /pub/pc/win3/fonts on ftp.cica.indiana.edu
bmap2afm bm2af01.zip in /pub/norm/mac-font-tools on ibis.cs.umass.edu

xbin converts Mac BinHexed files back into binary format.    BinHex is the Mac 
equivalent of uuencoding: it translates files into hexidecimal digits so that mailers 
can send them around without difficulty.    It also aids in cross-platform copying.    
BinHexed files generally have filenames of the form "xxx.yyy.HQX".

unsit explodes Stuffit archives.    Stuffit archives generally have filenames of the form
"xxx.SIT".

uncpt exploces Compactor archives.    The ext-pc implementation is called extract 
and does not require Windows (even thought it's in the Windows section on cica).    
Compactor archives generally have filenames of the form "xxx.CPT".

refont converts Mac type1 fonts into PC type1 fonts.

bmap2afm constructs AFM files from the metric information contained in Mac screen
fonts (.bmap files).    The screen font files do not have any standard name (although 
they frequently have the extension .bmap).    The screen fonts have file type "FFIL" 
which, in combination with some common sense, is usually sufficient to identify them.

It's probably a good idea to check with archie for closer sites if you're not in North 
America.    These tools run under MS-DOS.    xbin and unsit can also be run under 
Unix.

How to do it:
Collect the Mac fonts from the archive or BBS of your choice.    Most of these files will 
be in BinHexed format.    As a running example, we'll use the imaginary font 
"Plugh.cpt.hqx".    When you download this font to my PC, you would use the name 
"PLUGH.CPX".    The actual name you use is immaterial.

Run xbin on PLUGH.CPX.    This will produce PLUGH.DAT, PLUGH.INF, and PLUGH.RSR.   
The data fork of the Mac file (the .DAT file) is the only one of interest to
us, you can delete the others.

If the original file had been "Plugh.sit.hqx", we would be using the unsit program.    
Since we chose a .cpt file for this example, I'm going to run uncpt..    Run uncpt on 
PLUGH.DAT.    You'll want to extract the AFM file (if present), the documentation or 
readme file (if present), and the Type1 outline file.    The AFM and README files will be
in the data fork of the archive file.    The Type1 outline will be in the resource fork.    
The AFM and README files have Mac "TEXT" type.    The Type1 outline file has "LWFN"
type.    Use the docs for uncpt and unsit as a guide.    If you got this far you probably 



won't have much difficulty.

If the font does not contain an AFM file, extract the screen font.    Screen fonts 
frequently have the extension .bmap and are "FFIL" type files.    Use Bmap2AFM to 
construct an AFM from the screen font.    If the archive does contain an AFM file, it's 
safe to bet that the author's AFM will be better than the one created by Bmap2AFM.

Finally, run refont on the Type1 outline that you extracted above.    The result should 
be an appropriate PC type1 outline.    refont will create a PFM file for you from the 
AFM file, if you desire.



Replacing your System font with a serif font 92-11-05
Thanks to Peter Karrer <pkarrer@bernina.ethz.ch>.

Here's a way to produce your own system font from the MS Serif font (similar to Times 
Roman) in Windows 3.1. No warranties of course...

If you're using "small" fonts (fonts.fon=vgasys.fon in system.ini):

Make sure you have VGASYS.FON, 7280 bytes, and SERIFE.FON, 57936 bytes.
Use debug to do the following:

C:\WIN\SYSTEM> debug serife.fon
- nmyvgasys.fon
- m15b6 l14b3 100
- rcx
CX E250
:14b3
- w
Writing 014B3 bytes
C:\WIN\SYSTEM> debug vgasys.fon
- nmyvgasys.fon
- l6b6
- rcx
CX 14B3
:1C70
- w
Writing 01C70 bytes
- q

In your system.ini file, replace fonts.fon=vgasys.fon with fonts.fon=myvgasys.fon.

If you're using "large" fonts (fonts.fon=8514sys.fon in system.ini):

Make sure you have 8514SYS.FON, 9280 bytes, and SERIFF.FON, 81728 bytes.
Use debug to do the following:

C:\WIN\SYSTEM> debug seriff.fon
- nmy8514sy.fon
- m1b36 l1c20 100
- rcx
CX 3F40
:1c20
- rbx
BX 0001
:0
- w
Writing 01C20 bytes
C:\WIN\SYSTEM> debug 8514sys.fon
- nmy8514sy.fon
- l336
- rcx
CX 1C20
:2440
- w
Writing 02440 bytes
- q

In your system.ini file, replace fonts.fon=8514sys.fon with 
fonts.fon=my8514sy.fon.





ZIP code bar code fonts 92-11-11
Word Office Productivity Pack (wopr-20a.zip and wopr-20b.zip on ftp.cica.indiana.edu 
and its mirror sites) will automatically print bar codes on envelopes.    The package does 
require Word for Windows 2.0, though.



Applications



Access: printing a database diagram 93-04-30
One sample approach to printing a complete database table/relation diagram is included 
as Database Analyzer    in the analyzer.mda database, which is included in the Access 
package.



Ami Pro 3.0: getting a menu of special characters 93-07-15
You can create a menu item which will pop up a dialog with the full Windows character 
set (similar to Word's Insert Character) for selecting special characters by using the 
typechar.smm macro, which is included with Ami Pro 3.0.



DayBook: running on Windows 3.1
The Windows 3.0 doesn't work well after upgrading to Windows 3.1.    However, you can 
get it working and even keep your old datafiles using the following steps:

· Install ToolBook again (run tbksetup) after renaming your old daybook.tbk file.
· Start DayBook with the empty daybook.tbk.
· Open the old daybook file (from windows version 3.0)
· Save it as daybook.tal.
· Exit ToolBook.
· Rename daybook.tal to daybook.tbk.                                                                          
· Now you can use the old information again under Windows 3.1



Excel: Calling DLL routines 92-12-16
Excel can call C and/or Fortran routines located in an external DLL.    In order to 
implement such DLLs, you will need the Excel SDK ($49 from Microsoft).



Excel: Doing log-log graphs 92-12-16
To create a log-log graph, check the log checkbox under Format » Scale for each of the 
axis.



Excel: Multiple X-Y graphs on shared X-axis 93-04-30
To draw multiple graphs on a single sheet, you will need to use the scatter graph, create 
the first series automatically, then create the second series (which will, by default, use 
the X values of the first series), and then manually change the X-values of the second 
series to point to the correct datablock on your worksheet.



Improv: converting hexadecimal numbers 93-10-17
While Improv will nicely convert hexadecimal strings to numbers as long as there are 
alphabetic characters in the string, it will produce an ERR value if given a number 
without alphabetic characters.    To correct this, use a formula such as the one below:

HexValue = decimal( if ( isstring(Input), Input , string ( Input , 0) ) )



Norton Desktop: Wider listbox for Scheduler 92-11-15
You can change the Scheduler's listbox width by using a resource editor (such as 
Resource Workshop, included with Borland's latest Windows language products) to resize 
the list box, move the headings and move the buttons.

If you don't have any programming tools, you are basically out of luck.



Norton Desktop: Using smaller fonts for lists 92-11-15
Most of the listboxes in NDW use the font size selected in the menus; make sure you 
select the correct size.



Procomm Plus: Adding fonts 93-11-12
Procomm Plus for Windows will automatically make available any additional TrueType 
fonts you have installed in your system.    However, you can only use fixed-width fonts, as
proportional fonts do not work well in terminal applications.    One of the possible 
commercial font packages to use is Microsofts Font Pack 1, which contains the excellent 
Lucida Sans Typewriter fixed-width font.



WinQVTNet: Hiding a gateway 92-12-16
To hide a gateway, specify visible=no under that host in your qvtnet.rc file.



Word for Windows: changing bullet paragraph indent 92-12-30
You can do this by creating a macro that creates a bullet, and then linking the bullet 
button on the toolbar to that macro, rather than to the standard command.    The macro 
should include a call to the ToolsBulletListDefault command, followed by your modified 
paragraphg formatting commands.



Word for Windows: centering equations 93-04-30
To create equations that look like this:

y = 2 (1)
and

x = y + z + log( w ) (2)

you will need to set a Center Tab at the center of your page, and a Right Tab at the right 
margin.    Now press Tab, insert your equation, press Tab again, and enter your equation 
number.



Word for Windows 2.0: converting batches of WP files to Word 93-11-13
To cnvert a large number of WordPerfect (for DOS or Windows) files to Word format, open 
the supplied newmacro.doc file, and use the Batch Conversion macro to do the job.



Word for Windows 2.0: custom toolbar icons 93-12-21
To change the icons in the Word for Windows 2.0 toolbar, add the line

LoadToolbarBitmaps=1
in the [WinWord2.0] section of your win.ini file.    When Word starts up, it will look for 
and load four bitmaps called v1tbar.bmp, v2tbar.bmp, v2tbar.bmp and v4tbar.bmp.  
Each bitmap holds 26 "icons" which of 18 pixels wide and 16 pixels high.    If you are 
using 1024x768 resolution, the bitmaps are 81tbar.bmp, 82tbar.bmp, 83tbar.bmp 
and 84tbar.bmp.

You can more easily change these bitmaps using the WOPR utility package (available as 
shareware).

Word for Windows 6.0 allows you to fully customize any of the multiple toolbars.



Word for Windows: drop caps (large 1st characters of paragraphs) 93-04-30
Creating a drop cap is really quite easy in Word, once you know what you are looking for. 

Create the paragraph, select the first character, change it to the font and size you want it
to be, and then select Insert » Frame to create a frame.    The frame will automatically 
size to the character and align with the top of the paragraph.    That's all there is to it!

Word 2.0c includes a macro which performs the above process automatically.



Word for Windows: fonts larger than 127 points 92-11-11
Since Word for Windows will not allow selection of a pointsize beyond 127, for very large 
pointsizes the best thing to do is enter the text in WordArt, and then scale the WordArt 
object to desired size in the Word document.



Word for Windows: foreign-language dictionaries and thesauri 92-12-30
To get a foreign-language spell checker dictionary or thesaurus for Word for Windows, 
you should contact Alki Software in Seattle, WA (800-669-9673).    Available languages 
include British English, French, German, Italian, Spanish, Portuguese, Swedish, Finnish 
and more.



Word for Windows: getting rid of the list of last files edited
To empty the list of last files edited before someone else uses your machine, simply 
remove the file winword.ini from your Word for Windows directory.    You may wish to put 
this in your autoexec.bat file.



Word for Windows: inserting today's date 93-04-30
Using Word's built-in Insert » Date and Time... command will insert a date, but will 
update it every time you open the document.    There are several ways to insert today's 
date and forcing it not to be updated:

After using Insert » Date and Time..., select the date and hit Ctrl+F11 to lock 
the field.    This will cause it not to be updated until you unlock it.
After using Insert » Date and Time..., select the date and hit Ctrl+F9 to unlink 
the field.    This replaces the field with its contents; you will not be able to update 
the field again.
Use Insert » Field... and inset a CREATEDATE (or, depending on your preference, 
SAVDATE) field.    This will insert the date the document was created, however, and
not necessarily today's date.



Word for Windows: linking in subdocuments 92-11-02
Word for Windows' Link Document, Include document and Insert Document commands all
include the entire text of the subdocument in the main document.    If you want to "link" 
in a document for indexing or a table of contents but not bloat up the main document 
with all the actual text, use the RD (Refer Document) field.    It won't print or edit the 
subdocument from the main document, but it does work for indexing and tables of 
contents.



Word for Windows: numbering equations 92-12-16
To number equations in Word for Windows, insert a \seq field and use a sequence name 
like "Equation" to identify the sequence.    For example:

x = 0 ({\seq Equation}



Word for Windows: overlining words 92-09-14
To overline a phrase in Word for Windows, insert a \eq field and use the \x\to option to 
draw just the top of the box around the "equation".    So, for example, to overline "Bar", 
you might enter

The Foo {\eq \x\to(Bar)} and Grille



Word for Windows: printing even and odd pages 93-03-20
The Word Office Productivity Pack (WOPR), a shareware collection, includes tools for 
printing odd and even pages.

As an alternative, the following macro to print odd and even pages is courtesy of Rob 
Ryan (rryan@panix.com).    Use at your own risk    and try it on a smallish document first!

Sub MAIN
        Dim dlg As DocumentStatistics
        ToolsRepaginateNow
        GetCurValues dlg
        n = Val(dlg.Pages)
        If n < 1 Then End
        For i = 1 To n Step 2
                FilePrint .Range = 3, .From = Str$(i), .To = Str$(i)
        Next
        If(n Mod 2 = 1) Then
                msg$ = "Put all the pages except the last one"
        Else
                msg$ = "Put all the pages"
        End If
        msg$ = msg$ + " back into the printer and press Ok when ready to print."
        If(MsgBox(msg$, "Printing Even Pages", 49) = - 1) Then
                For i = 2 To n Step 2
                        FilePrint .Range = 3, .From = Str$(i), .To = Str$(i)
                Next
        End If
End Sub

And another alternative, from James Rudnicki and Richard Page (page@vm.usc.edu):

Sub MAIN
    Begin Dialog UserDialog 300, 154, "Odd/Even Printing"
        Text 48, 8, 234, 48, "Print odd or even numbered pages. The document may be 
repaginated
                                                                      and saved before printing."
        GroupBox 11, 62, 143, 59, "Select Pages"
        OptionGroup    .OddEven
                OptionButton 21, 78, 112, 16, "Odd Pages"
                OptionButton 21, 95, 120, 16, "Even Pages"
        CheckBox 173, 79, 116, 16, "Repaginate", .RePage
        CheckBox 173, 96, 100, 16, "Save File", .SaveFile
        OKButton 10, 127, 88, 21
        CancelButton 110, 127, 88, 21
    End Dialog

    Dim dlg As DocumentStatistics
    GetCurValues dlg
    NUM = Val(dlg.Pages)                        'Get number of pages

    Dim NewDlg As UserDialog                'Declare dialog array
    Choice = Dialog(NewDlg)

    Select Case Choice



        Case - 1                                            'OK Button
            If NewDlg.RePage = 1 Then
                ToolsRepaginateNow                'Make sure pagination is correct
            End If
            If NewDlg.SaveFile = 1 Then
                FileSave                                    'Save before printing
            End If
            If NewDlg.OddEven = 0 Then
                For cnt = 1 To NUM Step 2
                    FilePrint .Range = 3, .From = Str$(cnt), .To = Str$(cnt)
                Next
            Else
                For cnt = 2 To NUM Step 2
                    FilePrint .Range = 3, .From = Str$(cnt), .To = Str$(cnt)
                Next
            End If
        Case Else
    End Select

End Sub



Word for Windows: removing hard returns on downloaded text 93-01-20
You can easily do this by selecting the text, and running a macro similar to the one 
below.    Note that this will mess up any tables in your input text!

Sub MAIN
        EditReplace .Find = "^p^p", .Replace = "#~@", .WholeWord = 0, .MatchCase = 
0, .Format = 0, \
                                                  .ReplaceAll = 1
        EditReplace .Find = "^p", .Replace = " ", .WholeWord = 0, .MatchCase = 0, .Format =
0, \
                                                .ReplaceAll = 1
        EditReplace .Find = "#~@", .Replace = "^p^p", .WholeWord = 0, .MatchCase = 
0, .Format = 0, \
                                                .ReplaceAll = 1
End Sub



Word for Windows: setting the find file default directory 92-09-19
Select Tools » Macro and edit FileFind; it will look something like this:

Sub MAIN
        ToolsMacro "FileFind", .Run
End Sub

Change it to look like this:

Sub MAIN
        On Error Goto STOPHERE  'Needed if user chooses Close 

        Dim myfilefind As FileFind 'Define a dialog (same as FileFind dialog)
        GetCurValues myfilefind        'Get any values you may have already set

        myfilefind.SearchPath = "c:\windows"      'Use this type of line to set all the
        myfilefind.Name = "*.*"                                'defaults things your little heart 
desires

        Dialog myfilefind        'Display the dialog box on the screen

        STOPHERE:                'Just a label
End Sub

For information on the various things you can tag on to "myfilefind", such as .SearchPath,
.Name, etc..., check the on-line help under Word Basic Commands -- FileFind.

Thanks to Paul Brown for the solution!



Word for Windows: turning echo off in a macro 93-01-20
To turn off echo in a Word for Windows macro (making for a cleaner display and faster 
running), you need to implement two macros, EchoOn and EchoOff.    These macros are 
fully described in Microsoft's tech note 13-5 (they were based on ones written by Steven 
Wexler of WexTech Systems), available on ftp.uu.net and Compuserve.    Beware, though, 
that if your macro crashes before turning echo back on, you will thoroughly confuse the 
user!

If you just want to implement the macros, they are included below.    Before you jump 
into it, though, here is Microsoft's warning from the Tech Note:

Use the Echo macro at your own risk. It has performed admirably for us so far 
with one exception: When you execute a macro defining a bookmark that isn't 
only an insertion point, the bookmark is not always defined correctly. To 
remedy the situation, turn echo on just before you issue the bookmark 
command, and turn it off immediately afterward.    We leave it up to the user to
explore and find all the ways Echo can be useful or harmful in your macro 
writing.

To turning echo off, use the following WordBasic line:

Echo.EchoOff IniKey$

where IniKey$ is the name of the win.ini key used to store a value for turning echo on. 
This subroutine turns off redraw and saves the position of the scroll box in the vertical 
scroll bar of the 
active window to the win.ini file. The information is stored in the [Microsoft Word Echo] 
section of win.ini, under the IniKey$ key string.    To turn echo back on, use:

Echo.EchoOff IniKey$

where Inikey$ is the same key you used to turn echo off.

The Echo macro contains the following lines:

Declare Function SendMessage Lib "user"(hWnd As Integer, \
          wMsg As Integer,wParam As Integer, lParam As Long) As Long
Declare Function GetFocus Lib "user" As Integer
Declare Sub InvalidateRect Lib "user"(hWnd As Integer, \
          lpRect As Long, Bool As Integer)
Declare Sub UpdateWindow Lib "user"(hWnd As Integer)

Sub MAIN
      Echo 1, ""
End Sub

Sub Echo(fOn, IniKey$)
      WM_SETREDRAW = 11
      IniSection$ = "Microsoft Word Echo"
      FocusHandle = GetFocus
      If fOn = 0 Then 

            SetProfileString(IniSection$, IniKey$, Str$(VScroll()))
      End If
      dummy = SendMessage(FocusHandle, WM_SETREDRAW, fOn, 0)



      If fOn Then
            InvalidateRect(FocusHandle, 0, 1)
            UpdateWindow(FocusHandle)
            VScroll Val(GetProfileString$(IniSection$, IniKey$))
      End If
End Sub

Sub EchoOff(IniKey$)
      Echo 0, IniKey$
End Sub

Sub EchoOn(IniKey$)
      Echo 1, IniKey$
End Sub



Word for Windows 2.0: using a watermark 93-12-20
To place a watermark (usually a large a light gray text at an angle behind your normal 
text), you will need a PostScript printer.    If you have such a printer, you can either use 
the Watermark macro from newmacro.doc.    Alternately, insert a Print field into the 
header, containing the following PostScript code:

\p page "/Fn {findfont exch scalefont setfont} bind def
0.98 setgray
50 600 moveto
-45 rotate
180 /Helvetica Fn
(DRAFT) show"

This puts the word "DRAFT" at a 45 degree angle across the page in very light grey large 
letters.

Word for Windows supports watermarks for all types of printers autmatically.



Word for Windows: using date formats from [Intl] section in WIN.INI 93-12-11
If you want to make a generalized WordBasic macro which will use the users current date
format settings, you should access the [Intl]    section in the win.ini file.    The following 
code fragment (by Sterling Bjorndahl <bjorndahl@Augustana.ab.ca>  demonstrates this 
technique.

Declare Function GetProfileString Lib "Kernel"(Section$, Key$, Def$, Ret$,\
MaxSize As Integer) As Integer

Sub MAIN
'
Section$ = "Intl"
Def$ = ""
Ret$ = String$(255," ")
MaxSize = 256
'
Key$ = "sLongDate"
ResultLength = GetProfileString(Section$, Key$, Def$, Ret$, MaxSize)
MsgBox Ret$, "Long Date"
'
Key$ = "sShortDate"
ResultLength = GetProfileString(Section$, Key$, Def$, Ret$, MaxSize)
MsgBox Ret$, "Short Date"
'
End Sub



WordPerfect for Windows 1.0: changing the background color 92-12-16
WordPerfect does not allow you to set the colors directly (except in Draft mode); to 
change background color, you will need to change the systemwide default colors in the 
Control Panel.



WordPerfect for Windows 5.2: changing the button bar 92-07-15
To get a list of available button bars, click on the current button bar with the right mouse 
button.



WordPerfect for Windows: decrypting a password-protected file 93-10-11
While WordPerfect Corp. claims that it is not possible to recover password-protected files 
for which you have forgotten the password, this is in fact quite simple.    Obtain the 
program wpcrack, either by searching for it on the Internet (using archie) or from your 
local BBS.



WordPerfect for Windows 5.2: using smart quotes 92-07-15
To enable ``smart quotes'', run the included macro smquote.wcm.



WordPerfect for Windows 5.2: using bullets 92-07-15
To use bullets, run the included macro bullet.wcm; you can change the bullet character 
by running the macro bulletdf.wcm.



Gang screens ("Easter Eggs")
This section describes the ways to display the secret or gang screens, showing the 
authors of various packages, often with associated fireworks and/or other animation.



Windows 3.0
· Make Program Manager active
· While holding down F3, press  W I N 3.    Release F3.



Windows 3.1
· Make Program Manager or any desk accessory active
· Select Help » About, hold down Shift+Ctrl+Alt, double-click on icon, press OK
· Repeat
· Repeat to get the first "gang screen"
· Repeat to get the second "gang screen"
· Repeat to get the third "gang screen"



Ami Pro 2.0
· Select Help » About
· Hold down Shift, Ctrl and Alt
· Press F7.    Type  S P A M.    
· Enter the last and third from last digits from the Available memory display.
· Release Shift, Ctrl and Alt

Thanks to Avinoam Shmueli.



Borland (all Windows products) 93-05-10
· Select Help » About
· Hold down    Alt
· Press I.

Thanks to Tim Tschirmer.



Corel Draw! 3.0
· Hold down Shift and Ctrl
· Select Help » About
· Continue to hold down Shift and Ctrl
· Double-click on the balloon at the left side of the dialog.
· Hold down the left (or maybe right?) mouse button to light the burner for the 

balloon, and make it rise, pulling a banner of developers' names.

Thanks to J.D. Mathew.



Excel 3.0
· Select Formula » Goto, enter iv16384.
· Use the scroll bars to make this the only cell visible.
· Reduce the row and column widths to zero.    
· Double-click on the single remaining button at the top left corner.

Thanks to Aaron Wallace.



Norton Desktop for Windows 2.0
· Select Help » About
· Hold down N, D and W
· Double-click on the icon.

Thanks to Mark Scase.



PageMaker for Windows 4.0 92-12-30
· Hold down    Shift and Ctrl
· Select Help » About PageMaker



Procomm Plus for Windows 1.0 92-12-05
· Select Window » Monitor
· Keep focus on the Monitor window
· Type GO DATASTORM!
· Select Help » About » Credits

Thanks to Joseph Malloy.



Word for Windows 1.x
· Turn CapsLock on
· Select Format » Define » Styles » Options
· Select Normal for Based On
· Press OK
· Press Cancel
· Select Help » About
· Move cursor to inside dialog box, then hold down O, P, U and S at the same time. 

Thanks to Todd Lutz.



Word for Windows 2.0
· Select Tools » Macro
· Enter spiff, press Edit
· Delete all lines except for the middle blank line
· Select File » Close, press Yes
· Select Help » About, double-click on icon



Applications



Windows 2.x Applications
If you run in real mode of Windows 3.0, the old applications behave just like in 2.x, but 
have somewhat less memory available to them.    If the applications are "well-behaved", 
they may also run in standard and 386 enhanced modes, but Windows will first warn you 
with a "nag" message that the application wasn't written for Windows 3.x.    If you run a 
ill-behaved application in standard or 386 enhanced mode, the application will likely 
crash.

If you have a 2.x application that runs well in all modes, you can mark it Windows 3.0-
compatible using either the mark3.exe or the nonag.exe utility.    Both are available from 
cica.

Basically, Windows 3.1 will no longer run Windows 2.0 applications.



Troubleshooting



Access: version 1.1 upgrade 93-07-15
The upgrade from Access 1.0 to 1.1 is free to all registered users (except for shipping 
costs).    The upgrade packages (accp.zip) is also available on Windows FTP sites such as 
cica and on Compuserve.



AllType: converted TrueType fonts not in same family 92-09-15
When AllType converts a, say, PostScript Type 1 font into TrueType, it does not maintain 
the connection between the Regular, Bold, Italic and Bold Italic fonts in the same family.   
Thus, if you have a font called Franciano and select bold in your word processor, you will 
get a synthesized bold version, not Franciano Bold.

To correct this, you might try a shareware utility called renamett, which allows you to 
specify the family of the font.



Ami Pro 3.0: can't read Word 2.0 or WordPerfect 5.2 files 93-08-12
Ami Pro 3.0 has some problems reading some Word for Windows 2.0 and WordPerfect for 
Windows 5.2 files.    This is corrected in version 3.01, which is available free by ftp, or for 
the cost of shipping and handling from Lotus.



Ami Pro: mixed landscape/portrait document eats system resources 93-04-30
You may experience problems with a mixed landscape/portrait-mode document 
consuming all available system resources.    This is caused by a bug in an early version of
the pscript.drv PostScript driver.    This problem is corrected by getting a new copy of 
the PostScript driver, with version 3.53 or later.



Ami Pro: table of contents
If your page numbers in the Table of Contents are all 1, you have likely generated the 
TOC twice without making any changes.    To work around this bug, make a trivial change 
to your document, and regenerate the table of contents.



Ami Pro 2.0: divide by zero error
If Ami Pro crashes with a Divide by Zero error in Windows 3.1, check the version number 
in the About... box.    If your version is earlier than 306, contact Lotus for a free upgrade 
to 306, which is fully compatible with Windows 3.1. 



Ami Pro 3.0: equation handling problems 93-04-30
The Ami Pro equation handling may occasionally cause your equation to disappear 
beyond the end of the line after aligning the equation with tabs.    In addition, trying to 
delete an equation that has "disappeared" may caused a corrupted document and/or a 
throrough crash in Ami Pro.    The only known workaround is to use only spaces, not tabs, 
to align equations if there is any chance that the equation might extend beyond the right
margin..



Ami Pro 3.0: overlapped screen text
On some configurations, selecting a block of text and then starting to type over it will not
erase the existing text first before placing the new characters on it, resulting in a 
corrupted screen display.

As a workaround, you may choose to either use draft mode or to turn off full justification.

A fix diskette for this problem is available by calling Lotus technical support.



Ami Pro 2.0: printing with incorrect fonts 93-04-30
If you are getting incorrect fonts when printing from Ami Pro, the most likely cause is the 
font substitution table contained within the Ami Pro .ini file.    You should inspect this 
table and remove entries that are not required.



Ami Pro 3.0: slow printing
If you are suffering from slow printing with Ami Pro 3.0, try the following steps to improve
the printing speed: 

· Disable Print manager in the Windows Control Panel
· Disable Background Printing in Ami Pro's Tools: User Setup: Options.



Ami Pro 3.0: unable to load Word or WordPerfect files 93-10-12
If your version of Ami Pro is unable to load files produced by recent versions of Word for 
Windows (2.0c) or WordPerfect (5.2), you need to obtain an upgrade to 3.0.1, available 
fro Lotus at nominal cost.



Corel Draw! 3.0: can't rotate bitmaps 92-12-30
If you attempt to rotate a bitmap (such as a .bmp, .gif ot .tif file), Corel Draw! will only 
display a gray rectangle.    This affects only the display, however, and the rotated 
graphics should print correctly.



Corel Draw! 4.0: can't install from CD-ROM 93-07-15
If you have a CD-ROM drive as your drive D:, Corel Draw! 4.0 may refuse to install 
because it needs 60K of free space on drive D:.    If you get this problem, make sure you 
have your TMP and TEMP environment variables set and correctly pointing to your 
temporary directory.    If you still can't install, create a small (<256K) RAMdisk in your 
config.sys as D: for the installation process; you can remove it once the installation is 
complete.



Excel 4.0: out of memory loading a workbook 93-12-05
Excel has a problem loading in large workbooks; to avoid this problem, limit your 
workbooks to about 15 worksheets and/or graphs.    This limitation is reputed to be 
corrected in Excel 5.0.



FrameMaker: scrambled dot-matrix output 92-09-14
FrameMaker will produce correct output only if the output device has square pixels; that 
is, your printer must have the same horizontal and vertical resolution.    A 144 horizontal 
by 192 vertical resolution will produce scrambled output.    Unfortunately, the only 
choices are to use your printer in a "square-pixel" resolution, or to switch to a printer 
with such a resolution (most laser printers have square pixels). 



KA9Q: dropped packets 92-09-14
In order to run properly within Windows 3.x and not drop packets, you need to do two 
things: 

· Start KA9Q with the -w option
· After starting KA9Q, start winpkt



Norton Desktop for Windows: can't format in the background
While Windows is limited by DOS in some of its multitasking capabilities (such as disk 
i/o), it can format floppies in the background (File Manager does it!).    NDW arbitrarily 
refuses to let you do anything else while formatting    it's a design feature!

Personally, I only buy preformatted diskettes!



Norton Desktop for Windows: crashes from selecting files 92-12-16
Norton Desktop, both versions 1.0 and 2.0, tends to crash if you select multiple files and 
try to drag them to several places on the screen.    No fix is currently available.



Mathematica 2.0 for Windows: problems with Windows 3.1, other problems
Mathematica 2.0 does not work well with Windows 3.1.    It also has a host of other 
problems which exhibit themselves even under Windows 3.0.

The cure is to upgrade to Mathematica 2.1; the upgrade cost is US$ 50.



Mathematica 2.1 for Windows: crashing problems 93-07-15
Mathematica 2.1 still suffers from a variety of problems, most of them memory-related.    
Most problems become infrequent if you upgrade your system to 16 MB or 32 MB.

No fix is currently available.



NCSA Telnet [in DOS session]: crashes in a window 92-12-30
The standard Telnet does not work well in a DOS session inside Windows 3.1's 386 
Enhanced mode.    There are three possible workarounds:

· Load the packet driver inside the DOS session, not before entering Windows
· Use WinPkt (available free by ftp) instead of the standard packet driver
· Use PktMux 1.1 (available free by ftp) instead of the standard packet driver



PageMaker 4.0: font selection box won't scroll 92-09-21
This is a known problem.    The workaround to use, if you have more fonts than will fit in 
the selection box, is to press Ctrl+T to change the text attributes (and thus the font).



PageMaker 4.0: text color changes to almost invisible 92-09-26
this problems stems from an incompatability between PageMaker and Windows 3.1 video
drivers.    Although no fix is currently available, you can work around the problem by 
switching between PageMaker and the other "color intensive" application (which changes
the colors) with Alt+Tab instead of minimizing one and then restoring PageMaker.    If the
colors have already been munged, start up command.com full-screen, exit it, and then 
maximize PageMaker again to restore the colors.



PageMaker 4.0: WordPerfect and Word for Windows import
As shipped, PageMaker 4.0's import filters do not support WordPerfect 5.1 for Windows 
(although WordPerfect 5.1 for DOS is OK), or Word for Windows 2.0.    If you cannot locate
the import filters at an ftp site or CompuServe, contact Aldus for free updates.



Paradox for Windows: dialog boxes can't be killed 93-04-30
The initial release of Paradox for Windows does not provide any method for 
unconditionally dismissing a modal dialog box.    If your dialog box code has a bug (not 
allowing you to close the dialog) you will need to reboot your system in order to close 
Paradox. No workaround (other than avoiding modal forms completely) is currently 
available.



Pathway Access 1.x: terminal font
If in your 10x16 terminal font the uppercase 'K' and lowercase 'k' appear identical, 
contact Wollongong for an update to a corrected terminal font.



PC Tools 7.1: restore problems
PC Tools 7.1 does not check backups for data integrity while restoring, thus possibly 
restoring corrupt data due to media errors on the disks.    This is not a bug, but a 
deficiency in PC Tools, and is unlikely to be corrected prior to the release of the next 
version.

PC Tools also sometimes corrupts the last disk while doing a restore.    Once the last disk 
has been read, you should immediately remove it from the drive.



Procomm Plus for Windows: Pasted text has extra CR/LFs 93-04-25
Prcomm assumes that it needs to add a return/linefeed to the end of every pasted line.    
If you are pasting from an unformatted text file, this is probably not the case.    As a 
workaround, you can use the macro below:

; VIPASTE.WAS v 1.00    Paste function for Unix hosts
;*********************************************************************
;*                                                                                                                                      *
;* VIPASTE.WAS                                                                                                              *
;* Copyright (C) 1992 Datastorm Technologies, Inc.                                      *
;* All rights reserved.                                                                                            *
;*                                                                                                                                      *
;* Purpose:    Pastes the current contents of the Windows Clipboard        *
;*                      to the terminal screen, stripping Line Feed characters. *
;*                      This is especially useful on Unix system.                              *
;*                                                                                                                                      *
;* This ASPECT SCRIPT is intended only as a sample of ASPECT                  *
;* programming.    DATASTORM makes no warranty of any kind, express or *
;* implied, including without limitation, any warranties of mer-          *
;* chantability and/or fitness for a particular purpose.    Use of          *
;* this program is at your own risk.                                                                  *
;*                                                                                                                                      *
;* Author:    Chuck Spohr                                                                                            *
;*                                                                                                                                      *
;*********************************************************************
 
proc main
      integer LFSetting
 
      cliptofile TEXT "\CLIPBRD.TMP"      ; Capture clipboard text to a file
      fetch ascii upld_lf LFSetting        ; Store current value before change
      set ascii upld_lf STRIP                    ; Set Linefeed Strip option
      sendfile ascii "\CLIPBRD.TMP"        ; ASCII upload the file
 
      delfile "\CLIPBRD.TMP"                      ; Clean up
 
      switch LFSetting                                  ; Reset Line Feed traslation based 
            case 0                                                ; on previously stored value
                  set ascii upld_lf STRIP
            endcase
            case 1
                  set ascii upld_lf CR_LF
            endcase
            case 2
                  set ascii upld_lf LF
            endcase
      endswitch
endproc



Procomm Plus for Windows: Zmodem transfer startup
If you initiate a Zmodem transfer from Procomm, the other end of the link may or may 
not automatically detect the start of a transfer, depending on the software at that end; 
it's not dependent on Procomm.    Specifically, the sz/rz software on Unix does not start 
Zmodem transfers automatically.



Quattro Pro for Windows 1.0: Accessing drive D: 93-10-11
The initial version of QPW insists on accessing all your drives (including CD-ROMs) when 
it starts up.    This problem is corrected in the newer version 5.0.



Quattro Pro for Windows 1.0: Cut and paste to other applications 93-04-25
The intitial release of Quattro Pro only supports a few graphics formats for clipboard cut 
and paste, and does not include WPG (WordPerfect Graphics) or WMF (Windows MetaFile)
support.    Thus WordPerfect for Windows 1.0 will not be able to paste Quattro's graphics.



Quattro Pro for Windows: High resource requirements 92-12-16
Quattro Pro always uses a large amount of Windows' available system resources, and if 
you do heavy graphics, you can exhaust all available resources, making it necessary to 
restart Windows.

This is apparently due to Borland's use of the OWL libraries, and no fix is yet available.



Quattro Pro for Windows: Numeric format alignment 93-04-25
Quattro Pro does not correctly align non-decimal numbers formatted with the Comma or 
Decimal formats, leaving a space for the non-existent decimal point.    No fix is yet 
available.



Quattro Pro for Windows: OLE and DDE problems 92-12-21
Quattro Pro's OLE and DDE functionality is acknowledged to be buggy; however, no fix is 
yet available.



Quattro Pro for Windows: Saving over foreign formats 92-12-30
If you open a foreign format (such as Excel or 1-2-3) spreadsheet, make some changes, 
and select File » Save, Quattro Pro' will delete the original document prior to telling you 
it can't save it.

No fix is yet available.



Quicken for Windows: conflicts with communications software
If Quicken produces a General Protection Fault on startup when you have a 
communications package already running, it is likely trying to get at the serial port 
(which is already in use).

To correct this problem, select Edit » Preferences » Electronic Payment, and disable 
all the bank accounts.    Click OK, and exit Quicken.    If this does not cure the problem, 
select Edit » Preferences » Modem Settings, and set Quicken to use a different serial
port than your communications package.

If you actually want to use the electronic payment feature of Quicken, you will not be 
able to run it at the same time as a communications package.



Ventura Publisher 3.0: divide by zero errors 92-09-19
Ventura Publisher 3.0 may get frequent divide by zero errors when used with Windows 
3.1.    These appear to be related to non-Microsoft TrueType fonts, which Ventura is 
unable to use reliably (the TrueType fonts from CorelDraw also cause problems).    You 
may wish to remove either all or selected non-Microsoft TrueType fonts from your system 
to prevent the Ventura errors.

Ventura Publisher will also refuse to run with a display driver which uses more than 256 
colors.



WinFax Pro 2.0 92-09-19
If you are having difficulty sending faxes with WinFax Pro, check the date of the file 
mod.exe; if it is 1-16-92 16:51, 62,976 bytes , you should get a replacement from 
Delrina (call cuatomer support at (800) 268-6082).



Word for Windows: accessing fonts
Word for Windows shows in its font menu the fonts currently available for the selected 
output device, not the display device.    You can still use, say, vector fonts that you 
installed, by typing the name of the font in the edit box.    Windows will draw vector fonts 
on the output device without problems    you may or may not like the results. Screen 
fonts are also useable for printing on dot-matrix printers.    These problems do not occur 
with TrueType fonts in Windows 3.1, as they are available both on the printer and on the 
display.

After you have installed new fonts (TrueType, ATM or any others), you need to force Word 
for Windows to refresh its output device font list.    The easiest way to do this is to do File
» Printer » Setup, click Setup, then click OK, and finally OK again.



Word for Windows 2.0: can't install additional components
If Word for Windows won't install additional components (such as the thesaurus or 
spellchecker) because it claims Word is not yet installed, check your win.ini file, and 
make sure that under [Microsoft Word 2.0], you have the line ProgramDir=C:\WINWORD 
(or whatever your Word for Windows directory name is).



Word for Windows 2.0: can't print envelopes 93-08-06
Word for Windows has a bug which prevents you from printing envelopes if Tools » 
Options » Print » Reverse Order Printing is turned on.    One workaround is to insert 
the envelope into your document (instead of printing directly) and then print just the 
single page from the document.    You can also automate the turning off of reverse 
printing by using this macro written by John Steele, jcs@ibmpcug.co.uk:

Sub MAIN
Dim dlg As ToolsOptionsPrint
GetCurValues dlg
Rev = dlg.Reverse
ToolsOptionsPrint .Reverse = 0
Redim dlg As ToolsCreateEnvelope
GetCurValues dlg
Dialog dlg
Super ToolsCreateEnvelope dlg
ToolsOptionsPrint .Reverse = Rev
End Sub                                                                                                                                                  



Word for Windows 2.0: equation editor fonts
If Word for Windows complains about missing MT Extra or MT Fences fonts, but they are 
installed in the control panel, you will need to reinstall them (this most commonly 
happens if you upgrade to Windows 3.1 after installing Word for Windows).    This is 
easiest done by using Word's Setup program to remove Equation Editor, removing the MT
Extra and MT Fences fonts with Control Panel, and then reinstalling the Equation Editor.

This bug most frequently occurs if your printer port is set to FILE: when installing Word 
for Windows.



Word for Windows 2.0: equations have too much white space 92-09-27
If you're using superscipts or subscripts in your equation, there will likely be too much 
whitespace above the equation.    If you check the character format, the equation will be 
subscripted by a large number, such as 40 points.    You can manually reset the subscript 
amount; however, the subscript will be set again when you print, if you have Update 
Fields checked under File » Print » Options.

You can also use the following macro (written by Harvey Cohen, hsc@honet6.attcom) to 
correct the spacing of all the equations in your document:

Sub MAIN
StartOfDocument
ViewFieldCodes 1
EditFindClearFormatting
EditReplaceChar .Font = "", .Points = "", .Bold = - 1, .Italic = - 1,

.Strikeout = - 1, .Hidden = - 1, .SmallCaps = - 1, 

.AllCaps = - 1, .Underline = - 1, .Color = - 1,

.Position = "0pt", .Spacing = ""
EditReplace .Find = "^19EMBED EQUATION ", .Replace = "^m", 

.WholeWord = 1, .MatchCase = 1, .Format = 1, .ReplaceAll = 1
ViewFieldCodes 0
End Sub

This problem is corrected in Word for Windows 2.0b.



Word for Windows 2.0: file too big to save 92-11-09
This appears to be an oocasional problem with versions 2.0 and 2.0a, although most 
users never experience it, even when working with large documents.

Some of the workarounds that have been reported to work for some users are:
Select the entire document and paste it into another document
Select a non-PostScript printer and save
Save the document as RTF
Turn off Fast Save



Word for Windows 2.0: headers and graphics
If you have problems with disappearing headers or footers, or with displayable graphics 
not printing, call Microsoft customer support for an upgrade to version 2.0a.



Word for Windows 2.0: mixed landscape/portrait document eats system resources
93-04-30

You may experience problems with a mixed landscape/portrait-mode document 
consuming all available system resources.    This is caused by a bug in an early version of
the pscript.drv PostScript driver.    This problem is corrected by getting a new copy of 
the PostScript driver, with version 3.53 or later.



Word for Windows 2.0b: printing from Print Preview
If you install the macros in pss.doc (included with Word 2.0b), you will no longer be able 
to print from the Print Preview window.    The following are two workarounds provided by 
Ron Apland <apland@mala.bc.ca>:

Select Tools » Macro » Edit FilePrint, erase the existing macro and insert the 
following:

      Sub MAIN
              Dim dlg As FilePrint
              GetCurValues dlg
              Dialog dlg
              Super FilePrint dlg
      EndSub

                    This will get you back to the original print macro.
                                                                                                                                                                

Select Tools » Macro » Edit FilePrint, and insert the following immediately after 
Sub MAIN:

          chkpv = FilePrintPreview()
          If chkpv <> 0 Then
              Dim dlg As FilePrint
              GetCurValues dlg
              Dialog dlg
              Super FilePrint dlg
              Goto Bye
          EndIf

                      This will run the original print macro if and only if you are using Print Preview.



WordPerfect for Windows: mixed landscape/portrait document eats resources
93-04-30

You may experience problems with a mixed landscape/portrait-mode document 
consuming all available system resources.    This is caused by a bug in an early version of
the pscript.drv PostScript driver.    This problem is corrected by getting a new copy of 
the PostScript driver, with version 3.53 or later.



WordPerfect for Windows 1.0: floppy access
If    WordPerfect for Windows refuses to access your A: drive, add the line

HighFloppyReads=0
in the [386Enhanced] section of your system.ini file.



WordPerfect for Windows 1.0: button bar won't display
If    WordPerfect for Windows won't display your button bar despite selecting it from the 
menus, make sure it is looking in the right directory.    Select Macros » Keyboards » 
Button Bars, and make sure the directory is set to your macros subdirectory.



WordPerfect for Windows 1.0: crashes with 256-color display driver 92-09-21
WordPerfect for Windows may crash (with a UAE or GPF) when used with a display driver 
capable of using more than 16 colors, or when used with ATI's Crystal Fonts driver.    To 
correct this problem, contact WordPerfect technical support, and request a copy of the 
interim release.    Once you have the interim release, start it with the /fl option to avoid 
crashes.



WordPerfect for Windows 5.2: incorrect table of contents 93-04-30
WordPerfect for Windows 5.2 (and possibly also 1.0) may produce an incorrect table of 
contents for your document.    If this happens, try removing any conditional end-of-pages 
and block protects.    This problem will apparently not be corrected until version 6.0.



WordPerfect for Windows 1.0: mixing landscape and portrait pages
WordPerfect for Windows will not allow you to mix landscape and portrait pages in a 
single document if you are using a Windows printer driver.    This is a known limitation 
and not classified as a bug.



WordPerfect for Windows 1.0: printing with TrueType
WordPerfect for Windows will correctly print documents containing TrueType fonts only if 
one of the following is true:

· You are using a Windows-based printer driver, not a WordPerfect one.
· You are using a TrueImage printer, with a WordPerfect driver which supports 

TrueType.



Available Windows 3.x applications
The following sections list some of the applications available for Windows 3.x    While it 
does not attempt to be a comprehensive list, it does attempt to list the most popular 
commercial software packages and some selected shareware.    This is not intended to be
a review, but, rather, an overview of available titles.    You should perform your own 
evaluation to determine the software best suited to your needs.

All prices listed are U.S. list prices at time of compilation, and cannot guaranteed to be 
correct.

If the application is available on another platform at better or at least substantially the 
same level of development, a code indicating that is shown in the header.

[Mac] Macintosh
[Sun] Sun OpenLook
[Motif] Motif
[NeXT] NeXTSTEP
[PM] OS/2 Presentation Manager

See the Windows Programming Tools FAQ for a description of available development 
tools.



Mainstream productivity applications



Desktop publishing 93-07-15

· ArcheType Designer
Archetype.    A full-featured package for relatively short commercial material such as ads 
and brochures.    List $ 795.

· Express Page
Carberry Technology.    An front end for PageMaker for doing quick layout designs and 
draft versions.    List $ 195.

· FrameMaker for Windows    [Sun] [Motif] [Mac] [NeXT]
Frame.    A high-end integrated word processing and desktop publishing package.    List $ 
795.

· FrameView
Myoung-Jun Kim.    An alpha version of a frame-base DTP package with drawing 
capabilities.    Free.

· Microsoft Publisher
Microsoft.    An easy-to-use package with an extensive feature set but missing high-end 
capabilties.    List $ 199.

· PageMaker for Windows    [Mac]
Aldus.    A full-featured high-end package; with the recent update, the user interface once
again seems fairly modern.    List $ 795.

· PagePlus for Windows
Serif.    A low-price packaged with a wide variety of high-end features, such as OLE and 
irregular word wrap.    No color separation capability.    List $ 59 (PagePlus), $ 99 
(PagePlus and 100+ TrueType fonts).

· Publish It!
Timeworks.    A feature-rich basic package.    List $ 199.

· QuarkXPress for Windows [Mac]
Quark.    A high-end package with precise layout and positioning and powerful color 
handling.    List $ 895.

· Ventura Publisher, Windows Edition
Xerox.    A full-featured high-end package, ported from the original GEM-based version.    
List $ 795.



Integrated sofware 92-10-03

· CA-Simply Business
Computer Associates.    Accounting, word processing, 3-D spreadsheet, project scheduling
and graphics.    List $ 567.

· Eight-In-One for Windows
Spinnaker.    Word processor, spreadsheet, database, communications and graphics.    List
$ 59.

· PFS: WindowWorks
Spinnaker.    Word processor, spreadsheet, database, communications and graphics.    List
$ 149.

· Microsoft Works for Windows    [Mac]
Microsoft.    Word processor, spreadsheet, database, communications and graphics.    List 
$ 199.

· Microsoft Works for Windows, Multimedia Edition
Microsoft.    Word processor, spreadsheet, database, communications and graphics.    
Multimedia tutorial; available on CD-ROM only.    List $ 199.

Three other available packages, Microsoft Office, Lotus SmartSuite and Borland/WordPerfect 
Office, consist of bundled individual applications from the respective vendors, and are not 
integrated systems in the traditional sense.



Spreadsheets 93-09-30

· CA-Compete!
Computer Associates.    A multidimensional spreadsheet, aimed at financial analysis,    
with an Excel 4.0-based user interface.    More conventional than Improv, but still an 
excellent data analysis tool.    List $ 495.

· Excel for Windows 5.0    [Mac] [Sun]
Microsoft.    A full-featured high-end spreadsheet with OLE2 support, strong analysis and 
macro language features.    List $ 495.

· I Hate Algebra
T/Maker.    A basic spreadsheet intended for rudimentary financial activities such as 
tracking accounts, cash flow and expenses.    List $ 39.

· Improv for Windows    [NeXT]
Lotus.    An unconventional (maybe even revolutionary) spreadsheet designed for 
multidimensional models using English-like formulas.    List $ 495.

· Lotus 1-2-3 for Windows    [Mac] [PM]
Lotus.    A high-end spreadsheet with extensive 3D and full 1-2-3 Classic compatability.    
Suffers from poor performance compared to Excel and Quattro Pro.    List $ 495.

· Quattro Pro for Windows 
Borland.    A high-end spreadsheet with a low-end price.    Has a notebook 3D idiom, and 
features and performance rival Excel.    List $ 99.

· Quattro Pro for Windows, Workgroup Edition
Borland.    A version of Quattro Pro with advanced workgrouping features.    List $ 495.

· Thinx
Bell Atlantic.    Not really a spreadsheet, but an application allowing you to build data and 
links between objects.    List $ 495.

· WingZ    [Mac] [PM]
Informix.    Originally an innovative and highly graphical midrange spreadsheet, now 
somewhat out of date.    List $ 499.



Word processing 94-02-22

· Amí Pro 3.0
Lotus.    A full-featured high-end package with desktop publishing features.    Ami Pro 3.0 
matches Word for Windows 2.0 in power and features, but the current version is a bit 
outdated compared to Word 6.    List $ 495.

· CA-Textor
Computer Associates.    A low-end word processor with OLE, tables and English/French 
spell checker.    List $ 99.

· DeScribe    [PM]
DeScribe.    A midrange word processor strong on page layout, but overall not in the class
of Ami Pro and Word for Windows.    List $ 495.

· Easy Working
Spinnaker.    An easy-to-use package intended for light use such as memos, letters, faxes 
and to-do lists.    Includes mail-merge.    List $ 50.

· FrameMaker for Windows    [Mac] [Motif] [Sun] [NeXT]
Frame.    A high-end integrated word processing and desktop publishing package.    List $ 
795.

· JPW
?.    A Japanese-language word processor.    Free.

· JustWrite    [Mac]
Symantec.    An easy-to-use midrange package.    No OLE support.    List $ 249.

· Legacy
WordStar.    A frame-oriented high-end package.    Catching up (including a BASIC-like 
macro language), but not yet a match for Ami Pro or Word.    List $ 495.

· Lotus Write
Lotus.    A low-end easy-to-use package, previously sold as Samna Ami and then Lotus 
Ami.    Has SmartIcons and OLE, and includes ATM.    List $ 199.

· Professional Write Plus
SPC.    A mid-range package with an E-mail interface.    List $ 249.

· Scientific Word
TCI.    A Windows front end to TeX/LaTeX.    While this is an admirable attempt to combine 
the user-friendliness of Windows with the capabilities of TeX, the GUI front end falls far 
short of making it easy to take advantage of the power of TeX.    List $ 395.

· Signature
XYQuest.    The Windows-based successor to XYWrite (which was commonly used by 
numerous magazine professionals).    Fully featured with a customizable toolbar.    List $ 
495.

· WinText
Palsoft.    A lightweight executive word processor.    List $ 195.

· WiziWord
Microsystems Engineering.    A heavy-duty word processor aimed at technical 



documentation.    Includes a technical drawing editor and supports HPGL and Tektronix 
graphics.    List $ 595.

· Word for Windows    [Mac] [Sun]
Microsoft.    A full-featured high-end package aimed more at writing than at desktop 
publishing.    Includes OLE2 support and WordPerfect command emulation.    List $ 495.

· WordPerfect for Windows [Mac] [Sun] [Motif] [PM]
WordPerfect.    A full-featured high-end package.    Includes all WordPerfect printer drivers 
and a choice of CUA or WordPerfect user interface.    Latest version is feature-laden but 
has some performance problems.    List $ 495.

· WordStar for Windows
WordStar.    A midrange package originally based on Ami (unlike the NBI Legend-based 
Wordstar Legacy), with strong graphics and frame manipulation.    Has OLE and DDE 
support but no macros.    List $ 119.



Word processing utilities 93-10-17

· Correct Grammar
Writing Tools Group.    Corrects grammar and analyzes writing styles from any Windows 
application. List $ 119.

· Dorland's Medical Dictionary
Dorland.    A specialized medical dictionary for most Windows-based word processors. List
$ 99.

· DVIWindo
Y&Y.    A TeX previewer for Windows.    List $ 175.

· Funk and Wagnalls Standard Desk Dictionary
Inductel.    A dictionary with secretarial handbook, gazette and abbreviation directory.    
List $ 79.

· Ghostview for Windows
Russell Lang.    A full-featured document viewer using Ghostscript.    Free.

· Grammatik Windows
Reference Software.    Grammar and style checker and analyzer for Word, WordPerfect 
and Ami Pro. List $ 99.

· MathType
Design Science.    An excellent equation editor for Windows. List $ 249.

· OmniSpell
Caere.    An extended spell checker with a 100,000 word main dictionary and specialized 
medical and legal dictionaries. List $ 100.

· QuoteMaster Plus
Que.    A quote database oriented towards speeches and business documents. List $ 99.

· Refs
Tim Cutts.    An academic reference database manager with a friendly face. Registration £
30 (approx. $ 45).

· RightWriter
Que.    A grammar and style checker for Windows. List $ 99.

· Spell checker & thesaurus
Alki.    Foreign language spell checkers and thesauri for Word for Windows: Danish, Dutch,
Finnish, German, Italian, Portuguese, Swedish and Spanish. List $ ? each.

· WinRefer
Simon Dobson.    A reference management and searching utility, including refer, Medline 
and ISI format compatability. Free.

· WOPR
Pinecliffe International.    An extensive set of utilities for Word for Windows, including a 
toolbar bitmap editor. Registration $ 49.

· WParse
Willem Bison.    A WordPerfect file parser/decoder/disassembler. Free.



· Word for Windows Cross-Reference Assistance
John Steele.    Automates and eases cross-referencing in Word for Windows.    Registration 
$ 10.

· Word for Windows UK spelling dictionary and thesaurus
Microsoft.    A British spelling dictionary and thesaurus is available from Microsoft for 
Canadian Word for Windows users.    Free.



Information management



Databases, non-programmable 93-09-20

· AceFile for Windows
Ace.    An easy-to-use database with a very good user interface and excellent reporting 
capabilities but mediocre database functionality.    List $ 199.

· Approach for Windows
Lotus.    A simple database with strong database functions but serious limitations for 
programming.    List $ 399.

· DataEase for Windows
DataEase.    A capable low-end database with a flashy user interface, suffering from bugs 
and a lack of comprehensive import facilities.    List $ 395.

· FileMaker Pro [Mac]
Claris.    A well-designed port of the Macintosh FileMaker, offering good scripting and 
layout capabilities, but weak multifile features.    List $ 399.

· Instant Database
Asymetrix.    A clever but fairly limited database based on the Toolbook.    List $ 95.

· Key Database Plus
SoftKey.    A template-based database manager with extensive graphics support.    List $ 
59.

· PrimaBase
SPCS.    A low-end database with sophisticated multifile handling an reporting, but 
character-oriented user interface.    List $ 349.

· Q+E Database Editor
Q+E.    An innovative interface for accessing xBASE, DB2, Btrieve, Microsoft SQL and 
other databases.    List $ 299.

· Windows Filer
Palsoft.    A fairly basic package; includes xBASE file compatability.    List $ 195.

· Wyndfields for Windows
Wyndware.    A basic database with menu-based quick record access.    List $ 99.



Databases, programmable 94-02-22

· Access
Microsoft.    A highly visually oriented full-featured database with strong GUI features, 
including OLE fields, Visual Basic-like programming and visual database construction.    
SQL and ODBC support.    List $ 695.

· CA-dBFast for Windows 
Computer Associates.    A fast and powerful xBase compatible database; allows for either 
quick-and-dirty xBase ports or full-blown Windows applications.    List $ 550.

· DB Vista III
Raima.    A network (not relational) database.

· dBase for Windows
Borland.    Announced, but not expected to be shipping until 1Q94.    Feature set not well 
known.

· FoxPro for Windows    [Mac] [Unix]
Microsoft.    A Windows rewrite of FoxPro, with many Windows-specific features.    Fast and
powerful, using the xBase programming language.    List $ 495.

· Paradox for Windows
Borland.    Announced, but not shipping.    A new Windows version of the venerable 
Paradox for DOS.    Many GUI features and an object-based programming language, but 
programs are not compatible with the DOS version.    List $ 795.

· Personal Access
Spinnaker.    An easy-to-use programmable database using a HyperCard-like metaphor.    
Includes access to dBase, Paradox, Btrieve and Oracle databases,    List $ 695.

· Progress    [Sun] [Motif] [PM]
Progress Software.    A Windows version of the powerful Progress 4GL, which runs on DOS,
OS/2, VMS, AS/400, and dozens of different Unix versions.    Version 6.3 provides limited 
access to Windows interface; version 7.0, due in early 1994, will access a fuller feature 
set.    List $ 1175.    Runtime licence $ 225.

· Quadbase-SQL/Win
Quadbase.    A multiuser ANSI SQL Level 2-based database.    Includes a DLL for Visual 
Basic integration.    List $ 795.

· Superbase
SPC.    A graphical database package with some user interface oddities and problems, but
with solid programming and graphics support.    List $ 795.

· WindowBase
SPI.    A fairly easy-to-use package with midrange features and application development 
tools.    List $ 299.



Form processing and management 93-09-20

· BeyondMail Forms Designer
Beyond.    A BeyondMail-based forms package for designing and routing forms data 
through email.    List $ 395.

· Business Forms
Wizardworks.    A standalone printed form designer.    List $ 39.

· EZ-Form Master
EZX.    An extensible midrange forms processing system.    List $ 189.

· FormFlow
Delrina.    An email-based forms package designed to route form data through 
workgroups.    List $ 399 (Manager), $ 150 (User).

· FormMaster
Information Integration.    A printed form design and production package.    List $ 119.

· Forms
Prisma.    A forms processing package with 150 templates included.    List $ 89.

· FormsWorx for Windows
Spinnaker.    Forms design, entry and processing with xBASE compatability.    List $ 150.

· InForms
WordPerfect.    A forms management package with links to a variety of databases, such 
as dBase, FoxPro and Paradox.    List $ 495.

· JetForm-Design
JetForm.    Online forms design and processing with customizable toolbar, OLE, xBASE and
Paradox support.    Optional email capability.    List $ 495.    Runtime (JetForm-Filler) $ 129.

· Key FormDesigner Plus
SoftKey Software Products.    Forms design and processing with graphics and barcode 
support.    List $ 39.

· PerForm Pro Plus
Delrina.    A leading forms management package with multiple database and OO 
programming capability.    List $ 399.

· WindForm
Ibis.    Form design and processing application with scanner support.    List $ 99.

· Windows Form Maker
Cosmi.    A basic forms processing package with the essentials included.    List $ 39.



Project management 93-09-20

· Artemis Prestige for Windows
Lucas Management Systems.    A high-end project management package with 
minicomputer database connectivity.    List $ 4,995.

· CA-SuperProject for Windows 
Computer Associates.    A midrange rewrite of the venerable DOS-based package.    
Includes access capability for C and Visual Basic.    List $ 895.

· CADENCE ProjectMaster
CADENCE.    A low-end package with task/responsibility linking.    List $ 295.

· ManagePro for WIndows
Avantos Performance Systems.    A crossover between a PIM and a project manager, with 
strength in group goal tracking.    List $ 395.

· Micro Planner for Windows
Micro Planning International.    A middle-of-the-pack system with good multiple project 
handling.    List $ 595.

· Microsoft Project for Windows    [Mac]
Microsoft.    A midrange package with excellent user interfce but less emphasis on 
advanced scheduling.    List $ 695.

· Milestones, Etc.
KIDASA.    A low-end package oriented toward graphical scheduling.    List $ 189.

· OnTarget
Symantec.    A low-end package aimed at non-technical project managers.    List $ 129.

· PARISS Enterprise
Computer Aided Management.    A midrange package with excellent user interfce but less
emphasis on advanced scheduling.    $ 695.

· Project Director
AdRem.    List $ ?.

· Scitor Project Scheduler 
Scitor.    List $ ?.

· Texim Project for Windows
Welcom Software Technology.    A high-end project management package with high ease-
of-use and risk, cost and resource management capabilities.    List $ 1,295 (single user), $
4,775 (5 user).



Graphics and illustration



Databases, image

· MultimediaBase
Harley.    List $ ?.

· MediaOrganizer
Lenel.    List $ ?.

· ProFile for Windows
IEV.    List $ 295.

· ShoeBox for Windows
Kodak.    Announced, due to ship 4Q92.    List $ 295.



Charting (flow and organizational) 93-01-02

· ABC Flowcharter
Roykore.    A dedicated flowcharting package.    List $ 295.

· Chartist
Novagraph.    A diagramming and flowcharting package.    Registration $ ?.

· Instant ORGcharting!
Roykore.    A dedicated organizational charting package.    List $ 295.

· Org Plus for Windows
Banner Blue Software.    A specialized package for creating organizational charts.    List 
$ ?.

· RFFlow
RFF Electronics.    A drawing package for flowcharts, organizational charts, and data flow 
diagrams.    List $ 129.

· Visio
ShapeWare.    A drawing package specialized in diagrams and flowcharts, with OLE2 
support and user-modifiable master patterns.    List $ 299.



Drawing and illustration 93-01-02

· Arts & Letters Graphics Editor
Computer Support.    A fairly easy-to-use high-end package.    List $ 695.

· Arts & Letters Apprentice
Computer Support.    A stripped-down version of A&L.    List $ 125.

· Autodesk 3D Concepts
Autodesk.    A 3D surface modeling package.    Reads Generic CADD and DXF files.    List $ 
249.

· CorelDRAW!
Corel.    The market leader in high-end drawing and illustration software, with extensive 
set of graphics and image manipulation tools.    Available on CD-ROM.    List $ 595.

· Freehand
Aldus.    A high-end drawing and illustration package.    List $ 595.

· Graphics Works
Micrografx.    A semi-integrated package containing Windows Draw, PhotoMagic, OrgChart
and clip art and photo collections.    List $ 199.

· Harvard Draw for Windows 
SPC.    A high-end drawing package.    List $ 595.

· Micrografx Designer 
Micrografx.    A high-end package oriented towards technical illustration.    List $ 695.

· Microsoft Draw 
Microsoft.    A very basic package with OLE.    Included with Word for Windows.

· Professional Draw
Gold Disk.    A powerful high-end drawing package.    List $ 595.

· Smart Draw for Windows
The Other Operation.    A 2-D CAD package for Windows.    List $ 99.

· VentanaDraw 
Micrografx.    A low-end drawing package.    List $ 149.

· Visio
ShapeWare.    A drawing package specialized in diagrams and flowcharts, with OLE2 
support and user-modifiable master patterns.    List $ 299.

· Windows Draw 
Micrografx.    A low-end package with many high-end features, OLE and TrueType fonts.    
List $ 149.

· XVT Draw    [Mac] [Sun] [Motif] [PM]
XVT.    A shareware package with very basic features.    Registration $ ?.



Graphics conversion 93-04-12

· DoDOT
Halcyon.    Extensive file conversions and full-color editing.    List $ 189..

· Graphics Workshop for Windows
Alchemy Mindworks.    An image conversion and manipulation utility with an extensive 
feature set.    Registration $ 40.

· HiJaak for Windows
Inset.    A screen capture (for Windows and DOS) and conversion utility.    List $ 199.

· Image-In Paint and Scan
Image-In.    A grayscale painting and image processing package.    List $ 99.

· PaintShop Pro
JASC.    A shareware package with extensive capture, file conversion and color 
manipulation features.    Registration $ 49.

· pixFolio
?.    A shareware image converter and cataloger.    Registration $ ?.



Image viewers 94-02-12

· ColorView, ColorView/386
Millenium Technologies.    A shareware package with both GIF and JPEG support.    Version 
0.97 is quite fast but somewhat buggy.    Registration $ 30.

· Ghostscript for Windows
L. Peter Deutsch.    EPS (Encapsulated PostScript) viewer with a minimal user interface.    
Free.

· Ghostview for Windows
Russell Lang.    A full-featured document viewer using Ghostscript.    Free.

· JView, JView/386
David Holliday.    A fairly fast JPEG-only viewer.    Free.

· PaintShop Pro
JASC.    A shareware package with 24-bit color and good dithering; now including JPEG 
support and considerable image manipulation capabilities.    Registration $ 49.

· pixFolio
?.    A shareware image converter and cataloger.    Registration $ ?.

· ThumbsUp
Cerious.    Graphic image viewer and manager with wide format support.    Registration $ 
50.

· WinGIF
A GIF viewer, but with no JPEG support.    Registration $ ?.

· WinJPEG
A Windows JPEG viewer.    Registration $ ?.



Painting and image editing 94-02-12

· CA-Cricket Image
Computer Associates.    A 24-bit image processing and conversion package.    List $ 92 
until 93-01-31, regularly $ 295.

· CA-Cricket Paint
Computer Associates.    A 24-bit painting and image editing package.    List $ 92 until 93-
01-31, regularly $ 595.

· CorelDRAW!
Corel.    The market leader in high-end drawing and illustration software, with extensive 
set of graphics and image manipulation tools.    Available on CD-ROM.    List $ 595.

· DoDOT
Halcyon.    Extensive file conversions and full-color editing.    List $ 189..

· Fractal Design Painter
Fractal Design.    Fully-featured package oriented towards original image creation.    List $ 
399.

· Graphics Works
Micrografx.    A semi-integrated package containing Windows Draw, PhotoMagic, OrgChart
and clip art and photo collections.    List $ 199.

· Image-In Color
Image-In.    A 24-bit image processing and retouching package.    List $ 495.

· Image-In Paint and Scan
Image-In.    A grayscale painting and image processing package.    List $ 99.

· Image Pals
Image-In.    A 24-bit image processing    and management package, with JPEG support.    
List $ 249.

· PhotoFinish
ZSoft.    A low-end image manipulation package, with good MDI interface, 24-bit color and
JPEG support.    List $ 199.

· PhotoMagic
Micrografx.    A low-end 24-bit color image manipulation package, with JPEG support.    List
$ 149.

· PaintShop Pro
JASC.    A shareware package with 24-bit color and good dithering; now including JPEG 
support and considerable image manipulation capabilities.    Registration $ 49.

· Picture Publisher
Micrografx.    A powerful image manipulation package.    List $ 795.

· Publishers' Paintbrush
Zsoft.    Extensive 24-bit painting and image manipulation capabilities.    List $ 495.



Presentation and business graphics 93-04-12

· 3-D Charts To Go!
BLOC.    An easy-to-use (but fairly basic) charting package.    List $ 99.

· Action!
Macromedia.    A top quality presentation package with excellent tools and output quality,
but no 24-bit color support.    List $ 495.

· Arts & Letters Graphic Composer 
Computer Support Corp.    A full-featured presentation package with 24-bit support.    List 
$ 395.

· Charisma
Micrografx.    A high-end charting and business graphics package.    List $ 495.    

· DeltaGraph Professional
Deltapoint.    A scientific/business graphics package    List $ ?.

· Freelance for Windows
Lotus.    A fully featured charting and business graphics package.    List $ 495.

· Harvard Graphics for Windows 
SPC.    A full-featured Windows-based rewrite of the venerable Harvard Graphics for DOS.  
List $ ?.

· Hollywood
Claris.    A high-end presentation package, previously marketed by IBM.    List $ 499.    

· Origin
MicroCal.    A technically oriented presentation package with graph layers.    Suitable for 
scientific graphics.    List $ 495.    

· Persuasion
Aldus.    A high-end package capable of output to 35mm slides and other transparencies.  
List $ 495.

· Pixie
Zenographics.    A midrange business graphics package.    List $ 295.

· Powerpoint    [Mac]
Microsoft.    A full-featured presentation software package.    List $ 495.

· Stanford Graphics for Windows
3-D Visions.    A presentation software package with many technical features, but not 
enough for serious scientic graphs.    With extensive 3D graphics and other powerful 
features, but will make a 486/33 seem slow.    List $ 495.



Technical and Scientific Plotting 94-02-12

· DeltaGraph Professional
Deltapoint.    A scientific/business graphics package    List $ ?.

· FGraph
Marc Felisky.    A fairly basic (but high performance) scientific plotting package.    
Registration $ ?.

· GNUplot for Windows
The GNU Project.    A command-line driven plotting package, also available on a wide 
variety of other platforms.    Free.

· Graphicon
Cygron.    A function visualizer with numerical calculus and optimization capabilities.    
Limited version available free via ftp.    List $ 300.    

· Origin
MicroCal.    A technically oriented presentation package with graph layers.    Suitable for 
scientific graphics.    List $ 495.    

· SigmaPlot
?.    A scientific plotting package.    List $ ?.

· Spyglass Slicer and Spyglass Transform
Spyglass.    Two high-end data analysis tools for Windows NT, with extensive graphics and
transformation capabilities.    List $ 595 (Transform) and $ 695 (Slicer).



Personal information and finance management



Financial Management

· Balance Point
Moon Valley.    A personal finance manager with portfolio management, but a poor user 
interface design.    List $ 59.

· Microsoft Money 
Microsoft.    An easy-to-use personal financial management package, fairly comparable to
Quicken but missing portfolio management.    List $ 69.

· Quicken for Windows    [Mac]
Intuit.    The benchmark for personal finance manager software.    Compatible with the 
ubiquitous Quicken for DOS.    List $ 69.

· WinCheck
Wilson WindowWare.    A nicely designed shareware package, but without portfolio 
management.    Registration $ 69.



Personal Information Managers 94-02-12

· Active Life
1Soft.    A PIM aimed at scheduling and to-do lists.    Evaluation copies are available from 
cica and other sites.    List $ 149.

· Address
GIR Software.    An easy-to-use WYSIWYG PIM with address management, dialing, rolodex 
and more.    Registration $ 25.

· Ascend
NewQuest Technologies.    A high-end PIM with to-do lists, dialer, scheduling and 
information management.    List $ 299.

· BusinessCards for Windows
Michael Dvorkin.    A simple Cardfile-like information manager.    Registration $ ?.

· Commence
Jensen-Jones.    A high-end forms-based personal information manager, from the 
developers of IBM Current.    Has a very flexible network-type database, but requires 
substantial initial effort to set up.    Includes DDE and agents (macro trigger events). List 
$ 295 (single user), $ 695 (3 user workgroup).

· Desktop Set
Okna.    Calendar, rolodex, dialer, to-do list, etc.    List $ 89.

· Desktop Set Jr.
Okna.    A freely distributable older version of the Desktop Set.    Free.

· Epoch
Raindrop Software.    Scheduler and to-do list.    List $ 129.

· KeepTrack
Prisma Software.    Easy-to use lightweight cardfile.    List $ 29.

· ManagePro for WIndows
Avantos Performance Systems.    A crossover between a PIM and a project manager, with 
strength in group goal tracking.    List $ 395.

· Lotus Organizer
Lotus.    A low-priced PIM with extensive features.    Uses Day-Timer paradigm for 
organizing information.    List $ 149.

· PackRat
Polaris.    A high-end PIM with agenda, phonebook, to-do list, financial management, 
project tracking, etc.    Network version available.    List $ 395.

· Pinboard
Raindrop Software.    Post-It notes for Windows.    List $ 129.

· Pin-Up
Post-It notes for Windows.    Registration $ 20..

· ShoeBox for Windows
R+R Associates.    A high-end PIM with group scheduling, project and expense tracking, 



calendar and to-do lists.    List $ 395.

· WinPost
Eastern Mountain Software.    An excellent shareware package for managing Post-It notes 
on the Windows desktop.    Registration $ 30.

· Xtimelog
George Fredericks.    Activity and time tracking for billing and project management.    
Registration $ 49.

· YourWay
Prisma Software.    Time and contact management.    List $ 199.



Communications and networking



Networking and groupware



Groupware 92-09-20

· 1Team
1Soft.    A networked PIM aimed at scheduling and to-do lists, with a very similar user 
interface to Active Life.    Evaluation copies are available from cica and other sites.    List $
295 (2-user), $ 99 (additional users).

· Network Scheduler 3.0
PowerCore.    Network-based group scheduler.    List $ 395 (5-user), $ 1,195 (25-user).

· Lotus Notes
Lotus.    Integrated information sharing using networks.    List $ 62,500 (200-user).

· NOTE-IT
Chord. A network-based system of using Post-It notes.    List $ 249 (unlimited).

· PackRat for Networks
Polaris.    A version of PackRat for networks, with group scheduling, and document and 
information sharing.    List $ 695 (3 users).

· Pinboard
Raindrop Software.    Post-It notes for Windows.    List $ 399 (unlimited).



Internet news and mail readers/utilities 94-02-15

· Cinetic Mail Manager
?.    A Windows-based mail reader for reading your Unix mailbox through NFS.    
Registration $ ?.

· CyberDesk
CyberCorp.    A Windows-based interface to mail, news and ftp.    Uses a modem and a 
standard Unix shell account to access Internet services without requiring you to have 
TCP/IP software on the Windows PC.    List $ 179.

· Helldiver
?.    A Windows newsreader based on Waffle.    Registration $ ?.

· Mail-It
UniPalm.    A Windows mail program.    List $ ?.

· NetMinder
IMI Research.    An Internet mail address manager and database.    Registration $ 45.

· Umail
Marcus Ranum. A Windows-based Unix mail manager; manages your mail files through 
NFS, FTP or serial line.    Available by ftp at decuac.dec.com in directory pub/dos.    Free.

· UniQWK
A mail reader capable of including .WAV and .BMP files, and with an extensive set of 
useability features.    Registration $ 30.

· WinBiff
Paul Steckler. A mail notification utility for use with UUPC, Waffle, FSUUCP, Pegasus and 
PC-NFS.    Suggested registration $ 10.

· WinQVTnet
QPC Software. NNTP and SLIP support.    Uses non-standard .newsrc files.    Registration 
$ ?.

· WinNews
?.    A WinSock-based newsreader for Windows NT.    Registration ?.

· WinVN
Mark Riordan.    Available at ftp.cica.indiana.edu.    NNTP, SLIP and serial support.    Free.

· WRN
Frank van der Hulst.    NNTP-based newsreader, inspired by xrn.    Free.



Internet access utilities 94-02-12

· HGopher
Martyn Hampson.    A WinSock-based gopher client.    Free.

· HTTPS
EMWAC.    Multithreaded World Wide Web (WWW) server for Windows NT.    Free.

· NCSA Mosaic
Chris Wilson and Neil Mittelhauser.    A WinSock-based Mosaic implementation (WWW 
client).    Free.



TCP/IP Networking 92-12-01

· Chameleon TCP/IP
NetManage.    Telnet, FTP, printing and email.    List $ 400.

· Distinct TCP/IP
Distinct.    VT100-based Telnet, a TCP/IP file manager and a TCP/IP backup utility.    List $ 
395.

· Pathway Access
Wollongong.    Telnet, FTP, printing and optional NFS.    List $ 495 (?).

· Super-TCP
Frontier Technologies.    Telnet, FTP, printing and email.    List $ 495.



X Window servers 93-08-06

· eXcursion
DEC.    List $ ?.

· FrameworX
IDE.    Includes TCP/IP.    List $ 545.

· eXodus for Windows

· HCL-eXceed/W
Hummingbird Communications.    X11R4 support; does not include TCP/IP.    List $ 595.

· PC-Xvision for Windows
Spectragraphics.    X11R4 support; does not include TCP/IP.    List $ 449.

· Unipal X Server
UniPalm.    X11R3 support; does not include TCP/IP.    List $ 495.

· XVision
UniPress Software.    X11R4 support.    List $ 449.



Communications and terminal emulation



Communications (ASCII)

· Crosstalk for Windows
DCA.    A totally revised high-end package with VT320, Zmodem and LAN support.    List $ 
195.

· Dynacomm
FutureSoft.    VT340 and Zmodem support.    List $ 249.

· EM320 Windows
Diversified Computer Systems.    VT320 emulation, Kermit.    List $ 229.

· KEAterm 420
KEA Systems.    VT420 and SuperKermit over TCP/IP, Pathworks, LAT and Int14.    List $ 
245.

· MasterComm
MicroPlot Systems.    VT220, Tek4010, Tek4014, Kermit, XModem support.    Connect 
through modem, DECNET, Novell, 3Com or TCP/IP.    List $ 95.

· MicroCourier
Microcom.    List $ 99.

· MicroPhone II for Windows    [Mac]
Software Ventures.    VT102, Zmodem and Novell support.    List $ 195.

· Mirror
SoftKlone.    VT320 and Tektronix emulation with Zmodem, CIS-B and Kermit protocols.    
List $ 195.

· Procomm Plus for Windows 
Datastorm.    Numerous emulations (including VT320) and protocols (including Zmodem) 
and an advanced (if somewhat non-standard) user interface.    List $ 139.

· Reflection 1 for Windows 
Walker Richer & Quinn.    HP2392A and HP700/92 emulation.    List $ 399.

· Reflection 2 for Windows 
Walker Richer & Quinn.    VT320, Kermit, Xmodem.    List $ 299.

· Teemtalk 320W
Pericom Software.    VT320, HP2392A, DG200 emulation. Kermit, XModem, YModem 
protocols.    List $ 195.

· Terminal Plus
FutureSoft.    An advanced version of Windows Terminal, usign a similar user interface, 
with VT220 and Zmodem.    List $ 99.

· Unicom
Registration $ ?.

· WinQVT
Registration $ ?.

· WinTerm



Marketfield Software Development.    VT220 over TCP/IP, NetBIOS, LAT, Int14 and others.   
List $ 279.



Communications (IBM mainframe) 92-12-01

· Dynacomm Elite
FutureSoft.    3270 emulation through a variety of connections.    List $ 495.

· Extra!
Attachmate.    3270 emulation through coax, TIC or LAN.    List $ 425.

· IRMA WorkStation
DCA.    3270 emulation through a variety of connections, and also including asynchronous
terminal emulation.    List $ 495.

· LinkUp 3270 UniSession
Computer Logics.    3270 emulation and more.    List $ 295.

· Rumba
Wonderware.    3270 emulation with extensive GUI customization.    List $ 495.



Facsimile 94-03-15

· Bitfax for Windows
Bit Software.    List $ 79.

· Bitfax/OCR for Windows
Bit Software.    With OCR support for converting faxes into text.    List $ 199.

· Eclipse FAX
Eclipse.    A fax printer driver with thumbnails, OCR support and good speed.    List $ 129 
(with OCR), $ 99 (without OCR).

· EZ-FAX for Windows 
Calculus.    A fax printer driver.    List $ 499.

· FAXability
Intel.    A fax printer driver.    List $ 119.

· FAXability/OCR
Intel.    A fax printer driver with character recognition.    List $ 249.

· FaxFiler/FaxCapture
Extended Systems.    A network fax management system.    List $ 695 / $ 495.

· FAXit for Windows
SofNet.    A fax printer driver.    List $ 119.

· FaxMaster
Caere.    A fax printer driver with scanning and scheduling capabilities.    List $ 149.

· FaxMaster Server
Caere.    A network fax server for FaxMaster.    List $ 695.

· FaxView for Windows
Black Ice Software.    With color fax support.    List $ 179.

· FaxPress 3.0
Castelle.    Network fax service with a Windows client interface.    List $ 3,495.

· Imara Lite
Imara Research.    A hierarchical document manager and fax processor.    List $ 295.

· LanFax Redirector
Alcom.    Client/server based network fax.    List $ 995.

· ShareFax for Windows
SofNet.    Network fax for any Windows-compatible network.    List $149 (2-user).

· SuperFax for Windows
Pacific Image Communications.    List $ 99.

· WinFax Pro
Delrina.    An advanced version of WinFax Lite (supplied with many fax cards); the fax 
device appears to Windows as a printer.    Version 4.0 includes OCR and advanced fax 
management features.    List $ 119.





Remote Access 92-12-01

· Carbon Copy
Microcom.    Control the applications, files and peripherals of a Windows system remotely 
from another one.    List $ 199.



Fonts



Font packages 93-01-02

· Agfa Desktop Styles
Agfa.    39 TrueType text and display faces.    List $ 79.

· Agfa Type Jamboree
Agfa.    46 TrueType text and symbol faces.    List $ 99.

· Bitstream TrueType Font Pack 1
Bitstream.    40 TrueType text and display faces.    List $ 79.

· Bitstream TrueType Font Pack 2
Bitstream.    20 TrueType text and display faces.    List $ 39.

· Blue Sky Research Outline Fonts
Y&Y.    The full set of Computer Modern fonts in Type 1 format.    List $ 345.

· Fluent Laser Fonts Library
Casady & Greene.    120 text and display faces.    List $ 179.

· Font Value Pack
QualiType.    150 faces plus 1500 icons.    List $ 99.

· infiniType Plus
SoftMaker.    124 typefaces from URW and Graphitech font foundries, included in both 
TrueType and Type 1 formats.    List $ 99.

· Microsoft TrueType Font Pack
Microsoft.    Lucida Bright, Lucida Sans (? fonts total).    List $ 49.

· Monotype PostScript Value Pack
Monotype.    57 Type 1 text and display faces, including Baskerville, Book Antiqua, 
Bookman, Calisto, Century Gothic and Century Schoolbook.    List $ 89.

· Monotype Presentation FontPack
Monotype.    TrueType versions of    Albertus, Gill Sans Bold Extra Condensed and Swing 
Bold.    List $ 19.

· Monotype TrueType Value Pack
Monotype.    57 TrueType text and display faces, including Baskerville, Book Antiqua, 
Bookman, Calisto, Century Gothic and Century Schoolbook.    List $ 89.

· QualiType Fonts
QualiType.    135 TrueType fonts plus 1500 icons.    List $ 99.

· Optifonts
Castcraft Software.    400 TrueType text and display faces on CD-ROM.    List $ 996.

· SuperType Master Library
QualiType.    150 TrueType faces plus 1500 icons.    List $ 99.

· Top Fonts
EIQ Engineering.    93 TrueType text and display faces.    List $ 199.

· TrueType Font Pack for Windows



Upgrade Systems.    600 TrueType text and display faces.    List $ 129.

· TypeCase
SWFTE International.    131 TrueType text and display faces.    List $ 69.

Individual font packages are also available for varying prices from companies such as 
Adobe, Bitstream, Monotype and Image Club.    Some software, such as CorelDRAW! and 
Windows Draw also include bundled TrueType fonts.



Font managers 92-12-01

· Adobe Type Manager    [Mac]
Adobe.    A scalable font manager; supports Adobe Type 1.    List $ 99.

· Bitstream FaceLift
Bitstream.    A scalable font manager; supports Speedo, TrueType and Adobe Type 1.    List
$ 99.

· Incubator for Windows
Type Solutions.    A scalable font manager with special effects.    List $ 149.

· Publisher's Powerpak for Windows
Atech.    A scalable font manager.    List $ 79.

· WorldFont
Data-Cal.    A scalable font manager with international language support.    List $ 149.



Font utilities 93-01-02

· AllType
Atech.    Typeface conversion utility; supports Type 1, Type 3, TrueType and Speedo.    Has 
some problems in conversions, and no hinting    List $ 79.

· FontMinder
Ares.    Manages fonts by allowing you to activate and deactivate sets of fonts.    List $ 79.

· EZ Effects
Filmotype.    Slants, condenses and rotates TrueType fonts.    List $ 129.

· FontMonger for Windows    [Mac]
Ares.    Typeface editing and conversion utility; supports Type 1, Type 3 and TrueType.    
Has automatic hinting only.    List $ 129.

· Fontographer for Windows    [Mac]
Typeface editing utility; supports Type 1 and TrueType.    Has automatic hinting only.    List 
$ ?.

· MoreFonts
MicroLogic.    A font manipulation and modification package.    List $ 129.

· SoftType
ZSoft.    A scalable and printer font generation and manipulation package.    List $ 199.

· TrueType Font Installer
Kai Kaltenbach.    Preview, print samples and install TrueType fonts.    Registration: a 
science fiction book.



Utilities and fonts



Disk and file utilities



Archiving utilies 93-04-12

· CCI Zip
A Windows-based shell for PKZIP.    Registration $ ?.

· SHEZ
A Windows-based shell for PKZIP.    Registration $ ?.

· WinZip
Nico Mak.    An integrated Zip/Unzip utility; does not require PKUNZIP.    Also handles ARC 
and LZH archives.    Registration $ 29.

· WizUnzip
An integrated Unzip utility; does not require PKUNZIP.    Registration $ ?.

· WUNA
An integrated archiving utility, which handles .zip, .arj, .lzh and .arc formats.    
Registration $ ?.



Backup software 93-04-12

· Back-It
Gazelle.    Automatic and unattended backups to tape and floppies.    Supports a wide 
variety of tape drives, including QIC-02 and SCSI units.    List $ 149.

· Central Point Back-Up
Central Point Software.    A popular backup utility, albeit with limited tape drive support.    
List $ 99.

· Distinct Back-Up
Distinct.    Background backups using tool bars.    List $ 129.

· Norton Desktop for Windows
Symantec.    Program manager, file manager, file recovery, backup.    List $ 179.

· PC Tools
Central Point Software.    Some Windows tools and a Windows-based backup.    Supports 
some SCSI tape drives.    List $ 179.

· SitBack
AitBack Technologies. Automated backups (with LAN support) to any DOS storage device.
List $ 139.



Program launchers and desktops



Program Manager type 92-11-30

· Folders
Sloop Software.    Program Manager add-on providing nested folders.    Registration $ 20.

· hDC Windows Express
hDC.    An enhancement to the Program Manager. List $ 99.

· Plug-In
Plannet Crafters.    A Program Manager extension providing group management, custom 
group icons, QuickRun menu and other enhancements.    Registration $ 20.

· Program Manager Groups
Andreas Furrer.    A Program Manager add-on utility providing hierarchical groups.    Free.

· SloopMan
?.    A program manager replacement with groups-within-groups.    Registration $ ?.



File Manager type 94-02-15

· File Clip
Software Creations.    A streamlined but effective File Manager replacement.    Registration
$ 20.

· File Shuttle XPress
GetC Software.    File Manager features, networking and LapLink-like file transfer.    List $ 
140.

· Metz File F/X
Metz Software. File manager, file find, undelete, text search and task manager.    List $ 
129.

· Salvation
Vitesse.    Complete file management and viewing, with program launching and tool bars. 
List $ 125.

· X-Tree for Windows
X-Tree.    A Windows version of the venerable DOS-based XTree, with a good feature set 
but a rather slow implementation.    List $ 99.



Integrated desktops 94-02-22

· NewWave
Hewlett-Packard.    An excellent object-oriented environment that goes far beyond OLE 
and Norton Desktop.    List $ 195.

· Norton Desktop for Windows
Symantec.    Program manager, file manager, file recovery and backup in an integrated 
object-oriented environment.    List $ 179.

· PubTech File Organizer
Publishing Technologies.    An integrated environment with file and program 
management.    List $ 199.

· Sparta
Karl Thoroddsen.    A Macintosh-style file manager/shell with hierarchical folders, drag-
and-drop, file links, network support and a dustbin.    Shareware.

· WinTools
Tools Technology.    An object-oriented shell with file and program management.    List $ 
149.

· Workspace
ARK Interface.    Program manager, file manager, file recovery, backup.    List $ 179.



Icon docks/tool bars 93-10-17

· AppBar
Geert van Kempen.    NeXT-style button bar: with trash can.    Free.

· Application Pad
Cjin Lee.    A button bar with a clendar, clock, "eyes", screen saver.    Registration $ 15.

· hDC Power Launcher
hDC.    Floating icon bars and an enhanced command line.    List $ 99.

· Next
NeXT-style button bar.    Registration $ ?.

· QUICK
Mohammed Kabir.    A floating icon dock with task scheduling and macros.    Registration $
?.

· Route 1
D.A. Karp.    NeXT-style button bar: Visual Basic-based.    Registration $ 14.

· WinDock
Brian Capson.    The class of the NeXT-style button bars: clean and easy to use.    
Registration $ 15.



Commandline utilities 94-02-22

· 4win
A 4DOS-like shell for Windows; can start both DOS and Windows applications.    
Registration $ ?.

· PShell
A somewhat Unix-like shell for Windows.    Registration $ ?.

· TSH
Troy Rollo.    A command shell for Windows with a blend of Unix and DOS characteristics.   
Free.

· WCL
Abimbola Olowofoyeku.    A command shell for Windows with support for DOS internal 
commands, many extras and the ability to run both DOS and Windows applications.    Can
act as the Windows shell.    Registration $ ?.

· WCommand
A command shell for Windows.    Registration $ ?.



Other program launchers 93-08-13

· BackMenu
A minimalist approach to desktops: right-click on desktop to get a hierarchical pop-up 
menu.    Registration $ ?.

· Command Post
Wilson WindowWare.    A command-line oriented shell.    List $ 49.

· Dashboard
Hewlett-Packard.    Multiple views of application configurations.    List $ 99.

· DropDesk
Scott Bender.    Drag files from the File Manager to the desktop to run them.    Free.

· Dropper
Freely arrangeable buttons on the desktop.    Registration $ ?.

· Finder
A Macintosh Finder-type desktop.    Registration $ ?.

· GDesk
Right-click or left-clickon desktop to get configurable pop-up menus of available 
applications.    Minimalist along the lines of Usher.    Free.

· Rooms
Xerox.    Organize your applications into multiple desktops ("rooms"), and switch between
them while running.    List $ ?.

· Usher
Right-click on desktop to get a pop-up menu of available applications.    Definitely 
minimalist!    Registration $ ?.



Other utilities



Benchmarking utilities 92-04-10

· WinBench
PC Magazine.    Benchmarks performance with typical application usage.    Free.

· WinTach
Texas Instruments.    Benchmarks performance with typical application usage.    Free.



Clock utilities 93-04-12

· BarClock
Patrick Breen.    A flexible utility which places a digital clock, free memory or free 
resources on active window's title bar.    Free.

· TimeFrame
Places a digital clock on active window's title bar.    Free.

· WTime
Dials up an atomic clock to set the correct time on your system.    Free.



Desktop enhancers 92-11-30

· BigDesk
?.    A scrollable virtual Windows desktop.    Registration $ ?.

· More Windows
Aristosoft.    A virtual Windows desktop.    List $ 99.

· TopDesk
?.    A scrollable virtual Windows desktop.    Registration $ ?.

· WorkShift
?.    A virtual Windows workspace with separate desktops.    Registration $ ?.

· WorkSpaces
?.    A virtual Windows workspace with separate desktops.    Registration $ ?.



Miscellaneous 94-02-15

· ClipStac
PC Magazine.    A utility for managing a clipboard "stack" instead of justa a single item on 
the clipboard.    Free.

· CEnvi
Nombas.    An advanced macro language for Windows, MS-DOS and OS/2, based on C 
syntax.    Registration $ 38.

· Cloak
Lorry Back Software.    Hides undesired icons.    Charityware.

· FileClip
Ben Sprachman.    A file viewer for text, binary and (registered version only) graphics 
files.    Registration $ 20.

· GetSet
Set Inc.    A startup manager allowing the selection of a configuration from a list on 
Windows startup.    Free.

· GNU Toolbuster    [NT only\
Congruent.    The full set of GNU utilities for Windows NT.    List $ 199.

· Immunity
Unitrol.    Disk Mirroring for protection against hardware failure.    List $ 249.

· Print Manager
Saber.    Network printer management tool.    List $ 79 (single-user).

· PrintIt!
Text file viewing and printing utility.    Free.

· RightOn
Steve McCarthy.    Programs the behavior of the right mouse button.    Registration $15.

· Search City
A high-speed search tool for a variety of file formats.    List $ 200.

· TimeFrame
Places a digital clock on active window's title bar.    Free.

· WinMatch
Tom Crosley.    A side-by-side diff (comparison) of two files.    Registration $ 20 (source $ 
40).

· WinSleuth Gold
A windows analysis and diagnostic tool.    List $ 169.



Task schedulers 93-04-12
Norton Desktop and Central Point' PC Tools also include task schedulers.

· Clocker
Winnovation.    Schedules processes for unattended execution.    Includes a central 
network database facility.    Registration $ 25 (single copy).

· ClockMan
?.    Registration $ ?.

· E'vent Manager
Merasoft.    Builds complex macros that can be scheduled in advance.    List $ 179.

· RTimer
Robin Scher.    Runs applications at predetermined times.    Registration $ 10.



Task managers 93-07-15
· Metz File F/X

Metz Software. File manager, file find, undelete, text search and task manager.    List $ 
129.

· Task Manager
Guenter Schwaninger.    Registration $ 10.



Technical and engineering



CAD software 93-03-31

· AutoCAD R12 for Windows
Autodesk.    A mid-to-high-end CAD system oriented toward civil and architectural 
applications, with 3D capabilties.    A true Windows version of AutoCAD Rel. 12, not a 
front end as the earlier version; also to be available for Windows NT.    List $ 3,995.

· CADvance 5 for Windows 3.1
ISICAD.    A mid-to-high-end package with full AutoCAD file compatability and excellent 
Windows integration.    List $ 1,995 (competitive upgrade $ 395).

· Drafix Windows CAD
Foresight Resources.    A midrange 2-D CAD package.    List $ 595.

· MicroStation 4.03 Nexus
Intergraph.    A mid-to-high end CAD system with a Motif interface and minimal Windows 
features, but including DDE and OLE.    List $ ?.

· Smart Draw for Windows
The Other Operation.    A low-cost low-end 2-D CAD package.    List $ 99.

· TurboCAD Professional
Insi.    A low-cost 2D CAD package with parametric capabilities and bill of materials.    List 
$ 395.

· Ultimate CAD Windows
Automated Methods.    A midrange 2-D CAD package, with DDE.    List $ 695.



Engineering 93-03-31

· SODA
Acronym.    A structural steel design and analysis package.    List $ 495.

· Spice32    [NT]
Robert Zeff.    A Win32s version of Berkeley's Spice 3e2 circuit emulator.    Free.

· WoodWorks in Canada    [Mac]
Canadian Wood Council.    A structural wood design package, using the Canadian building
code only.    List $ 495.



Mathematical 93-04-30

· MathCAD
A mathematical workbench/typesetting package.    Version 4.0 uses the Win32s DLLs for 
32-bit performance.    List $ ?

· Mathematica
Wolfram.    A symbolic math package.    List $ ?

· Maple for Windows    [Mac] [Sun] [Motif]
Waterloo Maple.    A symbolic math package.    List $ ?.



Simulation and modeling 94-01-12

· WinSim
WinSim.    A simulation package with causal loops, parallel simulation and a full Windows 
interface.    List $ 595.



Statistics 94-02-12

· Astute
DDU Software.    A strong statistical add-on for Microsoft Excel 4.0 and 5.0.    A 
demonstration version is available by ftp.    List £ 80 (approximately $ 120).

· SAS for Windows [PM] [Sun]
SAS Institute.    The classic (and powerful) mainframe statistics package with a fresh face.
Announced but not yet shipping.    List $ 695 (base package), $395/year after 1st year.

· SPSS for Windows [PM]
SPSS.    A powerful statistics package with mainframe origins but with a well thought-out 
Windows interface.    List $ 2995 (full package).

· Systat for Windows
Systat.    Powerfful statistics and excellent graphics, but has some user interface quirks.    
List $ 895 (full package).

· WinFit
Yaron Danon.    A non-linear least-squares fitting package.    Registration $ ?.



Home, entertainment and multimedia



Multimedia



CD audio players 94-02-12

· CD
John Junod.    A fairly basic Windows audio CD player, with source.    Free.

· CD Audio
Noel Dillabough.    A CD player with a song database and do-it-once-and-forget CD 
programming.    Registration $ 20.

· CD Player
?.    A basic Windows audio CD player.    Registration $ 10.

· Media Player
Microsoft.    A very basic audio CD player.    Included with Windows 3.1.

· WinCD
BFM Software.    An audio CD player with shuffle play and programming (the little brother 
of WinCD Pro).    Registration $ 10.

· WinCD Pro
Apriori Software.    An audio CD player with all the features one could think of, and then 
some more.    List $ 49.

· WinCDP
Tony Wu.    Yet another fully-featured audio CD player.    Registration $ ?.



Multimedia authoring 93-01-02

· AuthorWare Professional
?.    A high-end multimedia authoring tool.    List $ 7,995.

· IconAuthor
?.    A high-end multimedia authoring tool.    List $ 4,995.

· HSC Interactive
HSC.    A fairly basic, easy-to-use, multimedia authoring package based on a subset of 
IconAuthor.    No OLE, DDE or TrueType support.    List $ 495.

· Video for Windows
Microsoft.    A video editor supporting OLE for embedding video clips into other 
applications.    List $ 195.



Multimedia playback 93-05-10

· AmandaStories
Voyager.    Animated stories for children age 3 and up.    List $ ?.

· Composer Quest
Dr. T's Music Software.    Various classical composers, with sound, text and pictures.    List 
$ 99.

· Multimedia Beethoven
Microsoft.    Experience Beethoven with sound, text and pictures.    List $ 69.

· MPEGPlay [NT]
Michael Simmons.    A MPEG player with hicolor capability.    Registration $ ?.

· The Wave Utilities
TASSoft.    Plays wave and MIDI files with features beyond those of standard WIndows 
applets.    Registration $ 10.

· WinTV
Hauppage.    View NTSC TV in a window.    Includes adapter card.    List $ 495.

· XING
XING.    A MPEG player for Windows.    Registration $ ?.



Sound editors 93-09-15

· Aleatoric Composer
Carl Christensen.    This package attempts to create music using random and conditional 
probabilities according to parameters you set.    Registration $ 1 (!).

· Encore
Passport Designs.    Music publishing package for composing and editing music.    List $ 
595.

· Music Sculptor
Alpha Omega.    A Windows-based MIDI sequencesr for recording, editing and playing 
music.    Registration $ ?.

· Sound Brush
MP Technologies.    Sound editor and player.    List $ 250.

· Transcribe for Windows
Raffi Krikorian.    Transcribes a .WAV file into alphabetic musical notes.    Free.

· Trax
Passport Designs.    MIDI editor and player.    List $ 595.

· Wave for Windows
Turtle Beach.    Sound editing package.    List $ 149.

· X-oR
Dr. T's Music Software.    MIDI editor and librarian.    List $ 129.



Video Editors 93-01-02

· CameraMan
Vision Software.    Capture Windows screens into .AVI format movies.    List $ 149.

· Video for Windows
Microsoft.    Capture video into .AVI files through a video capture board, and play them 
back or embed video clips into other applications.    List $ 199.



Entertainment



Games and entertainment 94-02-12

· 4 Play
Andrew Smith. An electronic version of Connect.    Registration £ 5 (approximately $7.50).

· AMAZEing
Stuart Swain. A 3-D maze game.    Postcardware.

· Blackjack Trainer
ConJelCo.    A professional blackjack training program.    List $ 75.

· Block-Logic
Michael Ahlers.    A pattern deduction game with alternate rulesets.    Free.

· ChessNet
Masque.    Chess against computer or via modem or network.    List $ 49.

· Euchre for Windows
J.J. Lehett.    A euchre card game.    Free.

· Kaleidokubes
Artworx.    Color domino cubes (1 or 2 player).    List $ 49.

· Microsoft Golf
Microsoft.    A Windows-based version of Links 386, with excellent control and high-quality
scenery.    List $ 65.

· MicroMan 1
Brian Goble.    An arcade-style adventure game.    Registration $ 25 (includes MicroMan 
2).

· Microsoft Arcade
Microsoft.    Old arcade favorites for Windows, including BattleZone, Centipede, Tempest, 
Asteroids and Missile Command.    List $ 39.

· Modem Chess for Windows
Noel Dillabough.    A twoplayer chess game over a modem connection.    Registration $ 
10.

· New York Times Crossword Puzzle
SWFTE.    200 daily and 50 Sunday crossword puzzles.    List $ 49.

· SimCity for Windows
Maxis.    A sophisticated simulation of a city.    List $ ?.

· Squirmer
Christopher Cifra.    A centipede-like arcade game.    Registration $ 2 (!).

· Symantec Game Pack for Windows
Symantec.    Six Windows games.    List $ 39.

· Windows Entertainment Pack Vol. 1
Microsoft.    Tetris, Minesweeper, Golf solitaire, Cruel solitaire, and more.    List $ 39.

· Windows Entertainment Pack Vol. 2



Microsoft.    Tut's Tomb solitaire, FreeCell solitaire, Pipe Dream, and more.    List $ 39.

· Windows Entertainment Pack Vol. 3
Microsoft.    Fuji Golf, TriPeaks solitaire, WordZap, SkiFree and more.    List $ 39.

· Windows Entertainment Pack Vol. 4
Microsoft.    List $ 39.

· WinGames
WinSoft.    WinCommand, Chopper Attack, Yacht and more.    List $ 39.

· WinGames II
WinSoft.    MrMind, Lander, Adventure and more.    List $ 49.

Sorry, the shareware and freeware games are just too numerous to mention them 
all!    Check your favorite FTP site or BBS for availability.



Home



Cooking 93-10-17

· Cookbook Manager for Windows
Andy Brown.    A cookbook manager with multiple cookbook capability and 
metric/imperial units.    Includes the Usenet Cookbook.    Free.



Fitness and Sports 93-09-15

· RunTrak
Joel Kulesa.    A Windows-based runner's logbook.    Registration $ 15.



Technical Support Contacts
This section attempts to list various avenues for technical support for Windows and 
Windows applications.    Further information is always welcome!



Microsoft



Telephone 93-03-01

· Installation Support
Visual Basic (206) 646-5105
Visual Basic Pro Toolkit (206) 646-5105
Windows Entertainment Pack (206) 637-9308

· Toll Telephone Support
Access (206) 635-7050
Excel (206) 635-7070
FoxPro (419) 872-0043
Mail (206) 637-9307
Money (206) 635-7131
PowerPoint (206) 635-7145
Project (206) 635-7155
Publisher (206) 635-7140
Windows (206) 637-7098
Windows for Workgroups (206) 637-7098
Word (206) 462-9673
Works (206) 635-7130
Other products (206) 454-2030



Internet 93-08-05

FTP archive ftp.microsoft.com
Directories:

LAN Manager /lanman
Microsoft Mail /mail
SQL Server /sqlsrvr
Windows NT /winnt
Microsoft Developer Network /msdn

Bug reports
Windows NT y-winntb@microsoft.com

Suggestions
Windows NT ntidea@microsoft.com

Requests
VxD IDs vxdid@microsoft.com

Beta programs
Chicago winbeta@microsoft.com
Win32s w32sbeta@microsoft.com

Developer addresses
3D DDK issues 3d-ihv@microsoft.com
DCI issues dci-ihv@microsoft.com
IHV issues ihv@microsoft.com
Internationalization issues global@microsoft.com
MAPI issues mapi@microsoft.com
Microsoft Developer Network devnetwk@microsoft.com
Multimedia issues mmdinfo@microsoft.com
Porting Lab communications portlab@microsoft.com
TAPI issues telephon@microsoft.com
Windows for Workgroups 3.11 DDK ndis@microsoft.com
WOSA/XRT issues wosaxrt@microsoft.com

Microsoft does not currently offer official email support.



Compuserve 94-03-15

Windows GO MSWIN
Windows for Workgroups GO WRKGRP
Windows NT GO WINNT

Access GO MSACCESS
Excel GO MSEXCEL
FoxPro GO FOXFORUM
Visual Basic GO MSBASIC
Word GO MSWORD
Applications, general GO MSAPP

Software Library GO MSL



Microsoft Download Service 93-07-15

Download-only BBS (206) 936-6735



Wolfram Research



Internet 93-07-15

Sales info@wri.com
Technical support support@wri.com



WordPerfect



Telephone 93-07-15

· Installation Support
Visual Basic (206) 646-5105
Visual Basic Pro Toolkit (206) 646-5105
Windows Entertainment Pack (206) 637-9308

· Toll-free Telephone Support
WordPerfect for Windows: features (800) 228-1029
WordPerfect for Windows: installation (800) 228-6076
WordPerfect for Windows: graphics/tables/eqns (800) 228-6013
WordPerfect for Windows: macros/merge/labels (800) 228-1032
WordPerfect for Windows: networks (800) 228-6066
WordPerfect for Windows: laser printers (800) 228-1017
WordPerfect for Windows: other printers (800) 228-1023

· Toll Telephone Support
WordPerfect for Windows (801) 228-9907
WordPerfect for Windows, after hours (801) 228-9908

Grammatik (801) 228-9919
InForms (801) 228-9916



Bulletin Board Service 93-07-15

BBS, 1200/2400 bps (801) 225-4414
BBS, 9600 bps (801) 225-4444




